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About This Guide

The Novell Vibe OnPrem 3 Installation Guide covers the installation and configuration of the Novell
Vibe OnPrem software. The guide is divided into the following sections:

* Part |, “Product Overview,” on page 11

+ Partll, “Basic Installation,” on page 23

+ Part I, “Advanced Installation and Reconfiguration,” on page 79
* Part IV, “Multi-Server Configurations and Clustering,” on page 115
+ PartV, “Update,” on page 151

+ Part VI, “Appendixes,” on page 181

Audience

This guideisintended for Novell Vibe OnPrem administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation, or go to www.novell.com/documentati on/feedback.html and enter your
comments there.

Documentation Updates

For the most recent version of this manual, visit the Novell Vibe OnPrem 3 Documentation Web site
(http://www.novell.com/documentation/vibe_onprem3).

Additional Documentation

You can find more information in the Novell Vibe documentation, which is accessible from the
Novell Vibe OnPrem 3 Documentation Web site (http://www.novell.com/documentation/
vibe_onprem3).

To access the Novell Vibe OnPrem User Guide from within Vibe, click the Help icon (question
mark).

About This Guide


http://www.novell.com/documentation/vibe_onprem3
http://www.novell.com/documentation/vibe_onprem3
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Product Overview

+ Chapter 1, “What Is Novell Vibe OnPrem?,” on page 13
+ Chapter 2, “Vibe OnPrem System Requirements,” on page 17
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What Is Novell Vibe OnPrem?

Novell Vibe OnPrem is an enterprise collaboration tool designed to increase individual productivity,
team effectiveness, and organizational success by providing the right set of toolsto the right people.
* Section 1.1, “Vibe Capabilities,” on page 13
+ Section 1.2, “Vibe Components,” on page 14
+ Section 1.3, “Vibe Configurations,” on page 15

1.1 Vibe Capabilities

Novell Vibe usersfall into three basic groups:

+ Section 1.1.1, “Content Consumers,” on page 13
+ Section 1.1.2, “Content Providers,” on page 13
¢ Section 1.1.3, “Administrators,” on page 14

1.1.1 Content Consumers

Content consumers use Novell Vibe to work with important information that pertains to them.
Content consumers:

+ Maintain their personal workspaces, including setting up a personal Blog, Caendar, Files,
Guestbook, Photo Album, and Tasks folder

+ Participate in team workspaces set up for content providers, in order to better collaborate with
colleagues and facilitate their work assignments

+ Search the Vibe site for people, places, and other information that pertains to their personal
work assignments

+ |dentify subject-matter expertsto assist them in their personal work assignments

The typica tasks performed by content consumers are covered in the Novell Vibe OnPrem 3 User
Guide.

In many cases, content consumers quickly become content providers as well.

1.1.2 Content Providers

Content providers use Novell Vibe to create and manage teams, customize the Vibe environment,
and import datainto the Vibe site for use by other Vibe users. Content providers:

+ Create and manage team workspaces and folders

+ Control user access to their team workspaces

+ Establish unique branding for workspaces and foldersto clearly differentiate them from other
places on the Vibe site

+ Create landing pages for workspaces that consolidate the most necessary workspace
information into asingle page

What Is Novell Vibe OnPrem? 13



+ Customize data entry forms for gathering information from users
+ Create workflows to automate otherwise time-consuming manual processes

The typical tasks performed by content providers are covered in the Novell Vibe OnPrem 3 User
Guide.

1.1.3 Administrators

A Novell Vibe administrator is responsible for installing the Vibe software and setting up the Vibe
site. This Novell Vibe OnPrem 3 Installation Guide provides instructions for Vibe software
installation. After installation, the Vibe site administrator can:

+ Set up user access to the Vibe site

+ Createinitial workspaces and populate them with information that is of interest to Vibe users

+ Control user access to workspaces and folders

+ Configure e-mail integration, so that Vibe users can receive notifications of updated
information on the Vibe site and post to the Vibe site using e-mail messages

+ Set up mirrored folders to make large sets of datathat are already available on disk more easily
available through the Vibe site

+ Set up software extensions (add-ons) that enhance the power and usefulness of the Vibe site

+ Set up remote applications that deliver data from a remote location, such as a remote database,
for easy access on your Vibe site

+ Manage users, workspaces, and folders as the Vibe site grows and evolves
+ Perform regular backups to safeguard the data stored in the Vibe site

The typical tasks performed by Vibe site administrators are covered in the Novell Vibe OnPrem 3
Administration Guide.

1.2 Vibe Components

A Novell Vibe site consists of four major components:

+ Section 1.2.1, “Vibe Software,” on page 14

+ Section 1.2.2, “Vibe Database,” on page 14

+ Section 1.2.3, “Vibe File Repository,” on page 15
+ Section 1.2.4, “Lucene Index,” on page 15

1.2.1 Vibe Software

The Vibe software is a customized version of Apache Tomcat. This software provides all the Web-
based functionality you use as you access the Vibe site through your Web browser.

1.2.2 Vibe Database

The Vibe database is used for storing information about the Vibe site and its users:

+ Structural information about workspaces, folders, and entries (for example, their location in the
workspace tree)

14 Novell Vibe OnPrem 3 Installation Guide



+ Identification information about workspaces, folders, and entries (for example, titles,
descriptions, dates of creation/modification, and users associated with creation/modification)

+ User profile information (for example, full name, phone number, and e-mail address)

The Vibe database disk space requirements are relatively modest, because it is not used for storing
files.

1.2.3 Vibe File Repository

The Vibefile repository holds al files that are imported into Vibe, information related to the
imported files, such as thumbnails and HTML renderings, and the search engine index.

The Vibefile repository disk space requirements depend on the size of the Vibe site. For alarge Vibe
site, disk space requirements can be substantial.

1.2.4 Lucene Index

The Lucene Index Server is a high-performance Java search engine. The Lucene index contains
pointers to the actual data stored in the Vibe file repository. The index enables the L ucene search
engine to perform very fast searches through large quantities of Vibe data.

1.3 Vibe Configurations

You can configure Novell Vibe to run on asingle server or multiple servers, depending on the size
and needs of your Vibe site.

Configuration Description
Single Server By default, the Vibe Installation program installs all Vibe components on the same
server.

Remote Database For better performance and scalability, you can install the Vibe database on a
Server remote server.

Remote Lucene For better performance and scalability, you can install the Lucene index on a
Index Server remote server.

Multiple Vibe Servers By running Novell Vibe on multiple servers, you can achieve high availability,
including failover and load balancing, depending on how you configure your

servers.
Multiple Remote Your Novell Vibe site depends on the Lucene Index Server for full functionality.
Lucene Servers Running multiple Lucene Index Servers provides high availability, so that if one

Lucene Index Server goes down, Vibe users can still access the Vibe site
because other Lucene Index Servers are still available.

Multiple Remote Each of the three databases supported by Vibe each has its own approach to
Database Servers clustering the database server. Information about clustering database servers is
available on the Internet.

For more information, see Part 1V, “Multi-Server Configurations and Clustering,” on page 115.

What Is Novell Vibe OnPrem? 15
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Vibe OnPrem System
Requirements

You, as aNovell Vibe OnPrem site administrator, must ensure that your system meets Vibe system
requirements, so that your Vibe site can be set up successfully. After your Vibe siteis set up, you
must ensure that users' browsers and office applications meet Vibe user requirements, so that users
can access the Vibe site successfully.

+ Section 2.1, “Vibe Server Requirements,” on page 17
+ Section 2.2, “Vibe User Requirements,” on page 18

*

Section 2.3, “Moabile Device Requirements,” on page 19

*

Section 2.4, “ Supported Environments,” on page 20

*

Section 2.5, “Recommended Hardware Configurations,” on page 21

2.1 Vibe Server Requirements

+ Hardware for the Novell Vibe server:
+ X86-32 processor or x86-64 processor
+ Minimum 2 GHz processor
+ Multi-CPU systems preferred
+ Minimum server memory:
+ Atleast 3 GB RAM for ax86-32 processor
+ Atleast 4 GB RAM for ax86-64 processor

See Section 2.5, “Recommended Hardware Configurations,” on page 21 and
Section 3.2.3, “Vibe Server Memory,” on page 27

+ Any of the following supported server operating systems for the Vibe server:
+ Novell Open Enterprise Server (OES) 2 Linux, plusthe latest Support Pack
+ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack

NOTE: On SLES, the X Window System is required by the Vibe installation program. It
is not required when running Vibe after installation.

+ Windows Server 2003 or Windows Server 2008, plus the latest Service Pack
+ Windows Server 2003R2 or Windows Server 2008R2, plus the latest Service Pack
+ Database server:
+ Linux:
+ MySQL 5.0.26 or later server and client, or MySQL 5.1 server and client

NOTE: MySQL 5.0.26 isincluded with SLES 10 SP1 and OES 2 Linux. MySQL
5.0.67 isincluded with SLES 11.

+ Oracle 10g or Oracle 11g

Vibe OnPrem System Requirements
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*

Windows:
+ MySQL 5.0.26 or later server and tools, or MySQL 5.1 server and tools
+ Microsoft SQL Server 2005 or SQL Server 2008, plus the latest Service Pack
+ Oracle 10g or Oracle 11g

More information about MySQL is availablein Section A.2, “MySQL Database Server,” on
page 185.

+ Tomcat 6.0.18

NOTE: Tomcat 6.0.18 isincluded with Vibe on Linux and Windows.

+ Java Developer Kit (JDK):

*

*

Sun JDK 6.0
IBM JDK 6.0
Java scripting must be enabled for proper Vibe site functionality.

More information about JDKsis available in Java Development Kitin Appendix A, “Vibe
System Requirements Assistance,” on page 183.

+ Directory service:

*

Linux: Novell eDirectory 8.8 or later, plus the latest Support Pack

For information about eDirectory, see the Novell eDirectory 8.8 Documentation Web site
(http://www.novell.com/documentation/edir88).

Windows: Microsoft Active Directory, plusthe latest Service Pack, or Novell eDirectory
8.8 or later, plus the latest Support Pack

For information about Active Directory, see Windows Server 2003 Active Directory
(http://www.microsoft.com/windowsserver2003/technol ogies/directory/activedirectory)
or Windows Server 2008 Active Directory (http://www.microsoft.com/
windowsserver2008/en/us/active-directory.aspx).

+ Adequate server disk space:

*

*

*

*

Vibe software: Approximately 250 MB

Database server software: Approximately 250 MB

Vibe file repository: Depends on the anticipated size of the Vibe site
Database content: Substantially less than the Vibe file repository

See Section 3.6, “Planning the Vibe Database,” on page 33 to plan for the disk space needs
of your Vibe site.

2.2 Vibe User Requirements

+ Web browser:

*

Linux: MozillaFirefox 3 or later

18 Novell Vibe OnPrem 3 Installation Guide
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+ Windows: Microsoft Internet Explorer 6 or later; Mozilla Firefox 3 or later

NOTE: When you use Internet Explorer 6 or 8, be aware of the following:
+Internet Explorer 6: Some functionality might not be available
+Internet Explorer 8: Ensure that Compatibility View is enabled on the browser

+ Mac: Safari 4 or later; MozillaFirefox 3 or later
+ Office applications:
+ Linux: OpenOffice.org 3.1.1 or later
+ Windows: Microsoft Office 2007 or later; OpenOffice.org 3.1.1 or later
+ Mac: OpenOffice.org 3.1.1 or later
+ Collaboration clients:
+ Linux:
+ GroupWise 8 with the latest Support Pack
+ Windows:
+ GroupWise 8 with the latest Support Pack
+ QOutlook 2007 with iCal support enabled
+ Notes 7 with iCal support enabled

2.3 Mobile Device Requirements

+ Section 2.3.1, “ Supported Mobile Devices,” on page 19
+ Section 2.3.2, “Device Browser Requirements,” on page 19

2.3.1 Supported Mobile Devices

The Novell Vibe mobile interface is supported on the following mobile devices:

+ iPhone
+ BlackBerry

NOTE: The BlackBerry Curve hasissues with JavaScript, so it does not work with the Vibe
mobile interface. For more information, see “Y our BlackBerry Curve Does Not Work with the
Mobile Interface” in “ Troubleshooting” in the Novell Vibe OnPrem 3 User Guide.

+ Any other mobile device that provides an HTTP/HTML-based interface

Ensure that your device's browser meets the requirements that are discussed in Section 2.3.2,
“Device Browser Requirements,” on page 19.

2.3.2 Device Browser Requirements

To use Vibe from amobile device, your device's browser must support:

s HTML 4
+ JavaScript

Vibe OnPrem System Requirements
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2.4 Supported Environments

+ Section 2.4.1, “File Viewer Support,” on page 20

+ Section 2.4.2, “1PV6 Support,” on page 20

+ Section 2.4.3, “Clustering Support,” on page 20

+ Section 2.4.4, “Xen Virtualization Support,” on page 20
* Section 2.4.5, “VMware Support,” on page 20

+ Section 2.4.6, “ Single Sign-On Support,” on page 21

* Section 2.4.7, “Linux File System Support,” on page 21

2.4.1 File Viewer Support

In Novell Vibe, file viewing capabilities are provided by Oracle Outside In viewer technology. See
Oracle Outside In Technology 8.3 Supported Formats (http://www.oracle.com/technol ogy/products/
content-management/oit/ds_oitFiles.pdf) for alist of the supported file formats. See Oracle Outside
In Technology (http://www.oracle.com/technol ogies’embedded/outside-in.html) for background
information about the Oracle viewer technology included in Vibe.

Thefile viewers also support data indexing by the Lucene Index Server.

2.4.2 IPV6 Support

Novell Vibe supports the IPV6 protocol when it is available on the server. If it isavailable, Vibe
detectsit and supports |PV6 by default, along with IPV 4.

2.4.3 Clustering Support

You can install Vibe components on multiple serversto provide failover support, as described in
Part IV, “Multi-Server Configurations and Clustering,” on page 115.

2.4.4 Xen Virtualization Support

You can install Vibein virtual environments where a software program enables one physical server
to function asif it were two or more physical servers. Xen virtualization technology in Novell Open
Enterprise Server (Linux version) and SUSE Linux Enterprise Server is supported. For more
information, see:

+ Open Enterprise Server 2 Virtualization Documentation Web site (http://www.novell.com/
documentation/oes2/virtualization.html#virtualization)

+ SLES Virtualization Technology Documentation Web site (http://www.novell.com/
documentation/vmserver).

2.4.5 VMware Support

Vibe is supported on the following versions of VMware:

+ VMware Server (formally GSX Server), an enterprise-class virtual infrastructure for x86-based
servers
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+ VMware ESX Server, adata-center-class virtual infrastructure for mission-critical
environments

For more information, see the VMWare Web site (http://www.vmware.com).

2.4.6 Single Sign-On Support

Novell Access Manager can be used to provide single sign-on capabilities for your Vibe site. For
setup instructions, see Section 9.9, “Configuring Single Sign-On with Novell Access Manager,” on
page 89.

2.4.7 Linux File System Support

For best Vibe performance on Linux, the ext 3 file system is recommended. If you are running OES
Linux and need the feature-rich environment of the NSSfile system, Vibe is also supported there.
The reiser3 file system is also supported.

2.5 Recommended Hardware Configurations

The hardware configuration that you set up for your Novell Vibe site should be based on the number
of active usersthat the Vibe site must support. Server machines can be physical or virtual.

Active . Java
Users Vibe Components CPU Memory Heap
10 1 dedicated Vibe server with: x86 2GB 1GB
¢ Tomcat
¢ Lucene
* SQL
50 1 dedicated Vibe server with: Xx64 4GB 2GB
dual core
+ Tomcat
¢ Lucene
* SQL
100 Multiple Vibe servers: x64 4GB 2GB
dual core

+ 1 dedicated Tomcat server
+ 1 dedicated Lucene server
¢ 1 dedicated SQL server

500 Multiple Vibe servers: x64 8 GB 6 GB

quad core
+ 3 dedicated Tomcat servers with an L4 load balancer

+ 2 dedicated Lucene servers

* 2 dedicated SQL servers

Vibe OnPrem System Requirements
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Active Java

Users Vibe Components CPU Memory Heap
1000 Multiple Vibe servers: x64 8 GB 6 GB
quad core

+ 5 dedicated Tomcat servers with an L4 load balancer
+ 4 dedicated Lucene servers

* 2 dedicated SQL servers

The Novell Vibe Installation program provides two installation types: Basic and Advanced. When
you perform aBasic installation, the result is afully functional Vibe site with all required options
configured and with typical defaultsin use for optional settings.

If you are new to Vibe, the easiest way to get started is to perform a Basic installation first, with all
Vibe componentsinstalled on the same server, then add advanced configuration optionsto your Vibe
site after the Basic installation has been successfully tested. However, experienced Vibe
administrators can choose to perform an Advanced installation immediately, which includes all
installation and configuration options, as described in Part 111, “ Advanced Installation and
Reconfiguration,” on page 79.

You can perform a Basic installation to set up asingle-server configuration, as described in
Chapter 3, “Planning aBasic Vibe Instalation,” on page 25 and Chapter 4, “Installing and Setting
Up aBasic Vibe Site,” on page 49.

You can perform a Basic installation to set up a multiple-server configuration, but the remote
database must be created manually and in advance of performing the installation, as described in
Part IV, “Multi-Server Configurations and Clustering,” on page 115.
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Basic Installation

+ Chapter 3, “Planning aBasic Vibe Installation,” on page 25

+ Chapter 4, “Installing and Setting Up aBasic Vibe Site,” on page 49
+ Chapter 5, “Adding Usersto Your Vibe Site,” on page 63

+ Chapter 6, “Updating Your Vibe License,” on page 69

+ Chapter 7, “What's Next,” on page 71

¢ Chapter 8, “Basic Vibe Installation Summary Sheet,” on page 73
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Planning a Basic Vibe Installation

Theinstallation program for Novell Vibe OnPrem helps you install the Vibe software and file
repository to the appropriate locations.

* Section 3.1, “What Isa Basic Vibe Installation?,” on page 25

+ Section 3.2, “ Selecting the Operating Environment for Your Vibe Server,” on page 26

+ Section 3.3, “ Selecting a Java Development Kit,” on page 29

+ Section 3.4, “Gathering Network Information for Your Vibe Site,” on page 30

+ Section 3.5, “Planning the WebDAV A uthentication Method,” on page 32

+ Section 3.6, “Planning the Vibe Database,” on page 33

¢ Section 3.7, “ Gathering Outbound E-Mail Information,” on page 36

+ Section 3.8, “Enabling Inbound E-Mail,” on page 38

+ Section 3.9, “Planning Site Security,” on page 40

+ Section 3.10, “ Gathering Directory Services Information,” on page 41

+ Section 3.11, “Accommodating Multiple Languages,” on page 47

3.1 What Is a Basic Vibe Installation?

The Novell Vibe installation program provides two installation types. Basic and Advanced. When
you perform aBasic installation, the result is afully functional Vibe site with all required options
configured and with typical defaultsin use for optional settings.

If you are new to Vibe, the easiest way to get started is to perform a Basic installation first, with all
Vibe componentsinstalled on the same server, then add advanced configuration optionsto your Vibe
site after the Basic installation has been successfully tested. However, experienced Vibe
administrators can choose to perform an Advanced installation immediately, which includes all
installation and configuration options, as described in Part 111, “ Advanced Installation and
Reconfiguration,” on page 79.

IMPORTANT: The following Vibe configurations require that you perform an Advanced
installation as your initial installation of the Vibe software:

+ Setting up the Vibe file repository so that some types of files are located outside the Vibe file
repository root directory. See Section 9.2, “Distributing Different Data Types to Different
Locations,” on page 82 for Advanced installation instructions. You cannot move subdirectories
within the Vibe file repository after they have been created.

+ Installing the Vibe software on multiple serversto create a clustered environment. See
Chapter 15, “Running Vibe on Multiple Servers,” on page 127 for Advanced installation
instructions. The option to enable a clustered environment is available only during an
Advanced installation.

If you want to implement an Advanced installation option, you should perform aBasic installation
first, in atest environment, before performing the Advanced installation to set up your permanent
Vibe site.

Planning a Basic Vibe Installation

25



This section helps you make informed decisions about the required options for a Basic installation:

+ Server platform (Linux or Windows)

+ Server architecture (32-bit or 64-hit)

+ Physical server memory requirements

+ Filelocations (Vibe software and data)

+ Java Development Kit (JDK) version (Sun or IBM)

+ Database type (MySQL, Microsoft SQL Server, or Oracle)

+ Database creation (during installation or before installation)

+ Database authentication (username and password)

+ Network information (Vibe server hostname or fully qualified domain name, and ports)

¢ Outbound e-mail configuration (SMTP vs. SMTPS, hostname, SMTP port, time zone,
authentication)

+ Inbound e-mail configuration (SMTP address, SMTP port, and TL S support)
+ User and group for running the Vibe software (Linux only)

Before performing a Basic installation, make sure al system requirements are met, aslisted in
Chapter 2, “Vibe OnPrem System Requirements,” on page 17.

As you proceed with planning, you can use the Basic Vibe Installation Summary Sheet to record
your decisions about the options you want to use.

3.2 Selecting the Operating Environment for
Your Vibe Server

+ Section 3.2.1, “Vibe Server Platform,” on page 26

+ Section 3.2.2, “Vibe Server Architecture,” on page 26

+ Section 3.2.3, “Vibe Server Memory,” on page 27

+ Section 3.2.4, “Vibe Installation Locations,” on page 28

+ Section 3.2.5, “TrueType Font Location (Linux Only),” on page 29

3.2.1 Vibe Server Platform

Novell Vibe can run on the versions of Linux and Windows listed in Section 2.1, “Vibe Server
Requirements,” on page 17.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Vibe Server Platform, mark your operating system of choice.

3.2.2 Vibe Server Architecture

Vibe can run on 32-bit or 64-bit processors. A 64-bit processor isrecommended for alarge Vibe site
where the processor load is heavy and data storage requires alarge amount of disk space.
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BASIC VIBE INSTALLATION SUMMARY SHEET

Under Processor Architecture, mark the processor capacity required for the size of Vibe site that you
want to set up.

3.2.3 Vibe Server Memory

If a32-hit processor is sufficient for your Vibe server, the server needs at least 3 GB of memory. If
you plan to use a 64-hit processor in your Vibe server, the server needs more.

Vibe server memory usage is significantly affected by some factors and less affected by others:

+ Number of userslogged in: No significant effect.
+ Number of concurrent active sessions: No significant effect.
+ Database server caches: Significant memory usage.

When you follow the instructions for a Basic installation, the database is located on the same
server asthe Vibe software. After you have successfully tested your Basic installation, you can
reconfigure Vibe to have its database on a remote server, so that the database uses separate
memory resources, as described in Chapter 13, “ Creating the Vibe Database on a Remote
Server,” on page 117.

+ Vibeinternal data caches: Significant memory usage.

When you follow the instructions for a Basic installation, the Vibe interna data caches are
subdirectories of the teamingdata directory, described in Section 3.2.4, “Vibe Installation
Locations,” on page 28. The Vibe internal data caches are separate from any caching or
memory usage by the database server itself.

+ Luceneindex cache: Significant memory usage.

The Lucene Index Server is a high-performance Java search engine. Large file repositories
(particularly with large files or alarge number of files) can create avery large dataindex. When
you perform aBasic installation, the Lucene index is created on the same server where the Vibe
softwareisinstalled. After you have successfully tested your Basic installation, you can
reconfigure Vibe to have its Lucene index on a remote server, so that it uses separate memory
resources, as described in “Installing the Lucene Index Server on a Remote Server” on

page 123.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Memory Requirements, specify the amount of physical memory you plan to have for your Vibe
server.

When you perform aBasic installation, the amount of memory allocated to the Java Virtual Machine
(JVM) where the Vibe software runs defaultsto 1 GB, which is adequate for a medium-sized Vibe
siterunning on a 32-bit server. This memory allocation, called the Java“heap size,” does not include
memory used by your database server or by the Lucene Index Server when these programs are
running on the same server as the Vibe software.

Planning a Basic Vibe Installation

27



A general ruleisthat no more than 75% of the available physical memory should be allocated to the
JVM. Memory not allocated to the VM must be sufficient to support the operating system, the
database server, and the Lucene Index Server if they are also running on the Vibe server, and any
other processes running on the Vibe server.

IMPORTANT: A JVM on a 32-hit server should not be configured to take more than 1.5 G of
memory. However, large numbers of users and documents often need memory settings higher than 2
GB to provide adequate performance. This type of Vibe system should be set up on 64-bit hardware.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location, specify the amount of memory to allocate to the JVM where Vibe runs.

Although it is possible to run Vibe with less than 1 GB of memory for the JVM, this applies only to
very small test configurations, and is not suitable for production systems. In atest configuration, 512
MB is the minimum amount of memory required to produce a functioning Vibe installation.

3.2.4 Vibe Installation Locations
The default file location for the Vibe software varies by platform:

Linux: /opt/novell/teaming

Windows: c:\Program Files\Novell\Teaming

Included under the main Vibe software directory are subdirectories for Tomcat and file viewer
software.

The default file location for the Vibe file repository also varies by platform:

Linux: /var/opt/novell/teaming

Windows: c¢:\Novell\Teaming

IMPORTANT: On Windows, the Vibe installation program displays the Windows pathname with
forward dlashes (/) rather than the traditional backslashes (\). This syntax is necessary in the
installation program.

The Vibefile repository holds al files that are imported into Vibe, information related to the
imported files, such as thumbnails and HTML renderings, and the search engine index.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under File Locations, specify the directories where you want to install the Vibe software and data if you
prefer not to use the default locations.

A Basicinstallation allows you to change the root directory for the Vibe software and the Vibe file
repository.
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IMPORTANT: If you want to organize the Vibe file repository so that somefile types are not under
the Vibe file repository root directory, you must perform an Advanced installation as your initial
Vibeinstallation. You cannot move directories out of the Vibefile repository root directory after the
initial installation has been performed. To perform an Advanced installation in order to organize the
Vibefile repository to meet your needs, complete the planning steps for a Basic installation and
complete the Basic Vibe Installation Summary Sheet, then follow the additional instructionsin
Section 9.2, “ Distributing Different Data Types to Different Locations,” on page 82.

3.2.5 TrueType Font Location (Linux Only)

The Oracle Outside In viewer technology used by Novell Vibe to render variousfile formatsinto
HTML for viewing requires access to TrueType fonts. Typical locations for these fonts are:

/usr/X11R6/1ib/X11/fonts/truetype
/usr/share/fonts/truetype

BASIC VIBE INSTALLATION SUMMARY SHEET

Under TrueType Font, specify the directory that contains the TrueType font location.

3.3 Selecting a Java Development Kit

Aslisted in Section 2.1, “Vibe Server Requirements,” on page 17, you need to install a Java
Development Kit (JDK) before you install Novell Vibe. You can use either the Sun JDK or the IBM
JDK for the platform where you areinstalling Vibe (Linux or Windows).

If you want to use an SSL connection between your Novell Vibe site and a WebDAV server, and if
the WebDAV server has a self-signed certificate rather than a certificate provided by a certificate
authority, you must use the Sun JDK. The existing Vibe functionality for handling self-signed
certificates is not compatible with the way the IBM JDK handles self-signed certificates.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java Development Kit, mark the JDK that you want to use with Vibe.

You must install the JDK on the Vibe server before you install the Vibe software. If you are not
familiar with installing a JDK, see Java Development Kit in Appendix A, “Vibe System
Requirements Assistance,” on page 183 for instructions.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java Development Kit, specify the directory where you have installed the JDK.

The Vibe Installation program uses this path as if you had set the JAVA_HOME environment
variable. The path is stored for future referenceinthe installer.xml file so that you need to
specify the path to the JDK only once.

Planning a Basic Vibe Installation
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3.4 Gathering Network Information for Your Vibe
Site

When you perform a Basic instalation, the Novell Vibe installation program needs hostname and
HTTP port information about the server where you are installing Vibe.

+ Section 3.4.1, “Host Identification,” on page 30
+ Section 3.4.2, “Port Numbers,” on page 30

3.4.1 Host Identification

When you install Vibe, the Vibe installation program needs to know the name of the server where
you are installing the Vibe software. The default is 1ocalhost. Do not use the default.

For internal use, you can use the DNS hostname of the Vibe server. However, if you want your Vibe
site to be accessible from the Internet, you must specify the fully qualified domain namefor the Vibe
server in order to allow external access.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the hostname or fully qualified domain name to use for the Vibe
server.

3.4.2 Port Numbers

When you install Vibe, Tomcat isinstalled along with the Vibe software. Vibe uses Tomcat as a
standalone Web server for delivering datato Vibe usersin their Web browsers. For more information
about Tomcat, see the Apache Tomcat Web site (http://tomcat.apache.org).

IMPORTANT: If the server where you want to install Vibe already has a Web server running onit,
shut it down while you install and test Vibe. The instructions for a Basic Vibe installation assume
that no other Web server is running on the Vibe server. If you want to maintain another Web server
on the Vibe server, you are responsible for resolving any port conflicts that might arise.

On the command line, use thenet stat command to see what ports are currently in use on the server
where you plan to install Vibe:

Linux: netstat -tan

Windows: netstat -a -n -p tcp

Make sure that the port numbers that you specify during Vibe installation do not conflict with ports
that are aready in use on the server.

¢ “HTTP/HTTPS Ports’ on page 31
+ “Shutdown Port” on page 31
+ “AJP Port” on page 32
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HTTP/HTTPS Ports

By default, standard Web servers such as Apache and Microsoft Internet Information Server (115)
use port 80 for non-secure HTTP (Hypertext Transfer Protocol) connections and port 443 for secure
HTTPS connections. HTTPS connections use SSL (Secure Sockets Layer) for added security. Asa
result, Web browsers default to port 80 when no port is specified in anon-secure HTTP URL and to
port 443 when no port is specified in a secure HTTPS URL.

Tomcat defaults to port 8080 for non-secure HT TP connections and to port 8443 for secure HTTPS
connections, so that it does not conflict with the standard Web server port numbers. If you configure
Vibe with the Tomcat default port numbers, users must include the appropriate port number when
providing the Vibe site URL. Typically, users prefer not to do this.

Unfortunately, the situation is not as simple as just configuring Vibe to use the default port numbers
of 80 and 443. On Linux, non-root processes are not allowed access to port numbers lower than
1024 and you are counseled against running Vibe as root in Section 3.9.2, “Linux User ID for
Vibe,” on page 40. Also on Linux and Windows, the default Tomcat installation expects ports 8080
and 8443.

For aBasic installation, you can use the default port numbers as presented by the Vibe Installation
program:

HTTP port: 80

Secure HTTP port: 443
Listen port: 8080
Secure listen port: 8443

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, the default port numbers have been provided for you. You only need to
specify different port numbers if you anticipate port conflicts with other software on the Vibe server.
Resolving port conflicts is beyond the scope of this Vibe documentation.

After you install Vibe on Linux, you need to complete the stepsin “ Setting Up Port Forwarding” on
page 54 so that users are not required to include the port number in the Vibe URL.

If you want to use secure HTTPS connections for your Vibe site, you must obtain signed certificate
filesasdescribed in “ Preparing for Secure HTTP Connections” in “ Site Security” inthe Novell Vibe
OnPrem 3 Administration Guide either before or after you install Vibe.

Shutdown Port

By default, Vibe uses 8005 as its shutdown port. For an explanation of the shutdown port, see
Tomcat - Shutdown Port (http://www.wellho.net/mouth/837_Tomcat-Shutdown-port.html).

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Vibe to use as its shutdown port if the default of
8005 is already in use on the Vibe server.
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AJP Port

By default, Vibe uses 8009 asits AJP port. For an explanation of the Apache JServ Protocol port,
see The AJP Connector (http://tomcat.apache.org/tomcat-6.0-doc/config/ajp.html).

IMPORTANT: If you areinstalling Vibe on Novell Open Enterprise Server 2, port 8009 is aready
in use, so you need to select a different port, such as 8010.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Vibe to use as its AJP port if the default of 8009 is
already in use on the Vibe server.

3.5 Planning the WebDAV Authentication Method

+ Section 3.5.1, “Understanding WebDAV,” on page 32
+ Section 3.5.2, “Choosing the WebDAV A uthentication Method,” on page 32

3.5.1 Understanding WebDAV

WebDAV isastandard collaborative editing and file management protocol. Novell Viberelieson the
WebDAV protocol for two key features:

+ Edit-in-Place for using tools such as OpenOffice and Microsoft Office, as described in “Using
WebDAV to Edit Individual Files’ in the Novell Vibe OnPrem 3 Advanced User Guide.

+ Mapping Vibe folders as aWeb folder on the client computer, which allows accessto Vibefiles
from a WebDAV-compliant file navigation tool such as Windows Explorer or Nautilus, as
described in “ Creating a Mapped Drive to the Vibe Folder” in the Novell Vibe OnPrem 3
Advanced User Guide.

IMPORTANT: Because of WebDAV limitations in Windows 7, when Vibe users are running
Windows 7 as the client operating system, various issues can be introduced. If your Vibe users are
using the Windows 7 operating system, see “ Configuring Vibe to Support WebDAV on Windows 7”
inthe Novell Vibe OnPrem 3 Administration Guide.

3.5.2 Choosing the WebDAV Authentication Method

The WebDAV authentication method determines how user credentials are passed from Vibe to the
WebDAV server. Vibe 3 and later supports three types of WebDAV authentication methods:

+ “Choosing Basic Authentication” on page 32

+ “Choosing Digest Authentication” on page 33

+ “Choosing Windows Authentication” on page 33

Choosing Basic Authentication

Basic authentication uses a one-way encryption algorithm known as asymmetric encryption. Select
this type of authentication when you plan to use Novell Access Manager (NAM) or Internet
Information Services (11S) to authenticate users.
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For more information about encryption algorithms, see Section 3.6.5, “Database Encryption
Algorithm,” on page 36.

Choosing Digest Authentication

Digest authentication uses a reversible two-way encryption algorithm known as symmetric
encryption. Select this type of authentication when client users are using Windows 7 as their
operating system and Microsoft Office as their text editor.

For more information about encryption algorithms, see Section 3.6.5, “ Database Encryption
Algorithm,” on page 36.

Choosing Windows Authentication

Windows Authentication provides Windows users with a single sign-on experience, enabling users
to automatically authenticate to Vibe after they are logged in to their individual workstations.
Internet Information Services (11S) provides this capability.

To configure Vibe to use Windows Authentication as the WebDAV authentication method, select
basic in the WebDAYV authentication method field during the Vibe installation program, then
configure Windows Authentication as described in Section 9.10, “Configuring Single Sign-On with
Internet Information Services for Windows,” on page 90.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under WebDAV authentication method, specify the authentication method you want Vibe to use when
authenticating to WebDAV.

3.6 Planning the Vibe Database

Novell Vibe database disk space requirements are relatively modest. Files that are imported into
Vibe are saved in the Vibe file repository, as described in Section 3.2.4, “Vibe Installation
Locations,” on page 28.

The Vibe database is primarily used for storing the following information:

+ Structural information about workspaces, folders, and entries (for example, their location in the
workspace tree)

+ Identification information about workspaces, folders, and entries (for example, titles,
descriptions, dates of creation/modification, and users associated with creation/modification)

+ User profile information (for example, full name, phone number, and e-mail address)

You or your database administrator must make the following decisions about the Vibe database:

*

Section 3.6.1, “Database Type,” on page 34

Section 3.6.2, “ Database Setup Method,” on page 34
Section 3.6.3, “Database Location,” on page 34

Section 3.6.4, “Database Credentials,” on page 35

Section 3.6.5, “ Database Encryption Algorithm,” on page 36

*

*

*

*
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3.6.1 Database Type

By default, Vibe uses open source MySQL as its database on Linux and on Windows. On Linux,
Vibe also supports Oracle. On Windows, Vibe a so supports Microsoft SQL Server and Oracle.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Type, mark the type of database that you want to use with Vibe.

Make sure that a supported version of the database server, aslisted in Section 2.1, “Vibe Server
Requirements,” on page 17, isinstalled and running before you install Vibe.

3.6.2 Database Setup Method

If you plan to use aMySQL database or a Microsoft SQL database, the Vibe installation program
can automatically set up the database for you. Thisisthe easiest way to get started.

If you plan to use an Oracle database, you must have your database administrator set up the database
for you. Instructions for your database administrator are provided in Section 13.4, “Creating an
Oracle Database,” on page 120.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Setup Method, mark whether you want the Vibe Installation program to automatically
set up a MySQL or Microsoft SQL database, or whether you need your database administrator to
manually set up an Oracle database before you install Vibe.

3.6.3 Database Location

When you have the Vibe Installation program create the database for you, the database is created on
the same server where you install the Vibe software. Thisisthe preferable location for your Basic
installation. The default database nameis sitescape, areference to the company that previously
devel oped the Vibe software.

Database Server Default Linux Location Default Windows Location

MySQL /var/lib/mysqgl c:\Documents and Settings\All Users\
Application Data\MySQL\
MySQL Server version\Data

Microsoft SQL  N/A c:\Program Files\Microsoft SQL Server\
MSSQL\Data

Oracle N/A N/A

You can have your database administrator create a database on aremote server later, after you have
successfully tested your Basic installation. See Chapter 13, “ Creating the Vibe Database on a
Remote Server,” on page 117.

If you need to have your database administrator create an Oracle database, you must decide before
installation whether you want the database on the Vibe server or on aremote server. See
Section 13.4, “Creating an Oracle Database,” on page 120.
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Vibe knows where to find its database from the JDBC (Java Database Connectivity) URL that you
provide during installation. For a database that islocal to the Vibe software, the default JDBC URL
that provides 1ocalhost asthe hostname of the Vibe server is appropriate. If the databaseison a
remote server, the JDBC URL must provide the hostname of the remote database server.

The JDBC URL aso includes the port number on which Vibe can communicate with the database
server. The default port number depends on the database server you are using:

Database Server Default Port Number

MySQL 3306
Microsoft SQL 1433

Oracle 1521

Use this port number unlessit is aready in use by another process on the database server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under JDBC URL, specify the appropriate hostname for the database server (localhost or the
hostname of a remote server) and the port number it will use to communicate with Vibe.

3.6.4 Database Credentials

When you have the Vibe I nstallation program create the database for you, it defaultsto the following
administrator usernames for the database server:

Database Default Administrative Username

MySQL root

IMPORTANT: The MySQL root username is not the same as the Linux root user on a
Linux server.

Microsoft SQL  sa (system administrator)

Oracle (no default) For an Oracle database, your database administrator establishes the
administrator username and password for the database server.

For an Oracle database, your database administrator establishes the administrator username and
password for the database server.

Check with your database administrator to seeif the default administrator usernameis still in use for
your database server, and obtain the administrator password for the database server before you run
the Vibe Installation program.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials, specify the administrator username and password for the database server
so that Vibe can access its database.
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3.6.5 Database Encryption Algorithm

Different encryption algorithms provide differing encryption strength. The supported a gorithms for
encrypting the Vibe database password are listed below, in order from least strength to most
strength.

+ MD5

¢ SHA

Thisis the default option when using Basic Authentication for WebDAV authentication, as
described in Section 3.5, “Planning the WebDAV Authentication Method,” on page 32

+ SHA-256
+ PBEWithMD5ANdDES

Thisisthe only available option when selecting Digest Authentication for WebDAV
authentication, as described in Section 3.5, “Planning the WebDAV A uthentication Method,”
on page 32

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Encryption Algorithm, mark the encryption algorithm you want to use for Vibe
passwords.

3.7 Gathering Outbound E-Mail Information

Your Novell Vibe site can be configured to send outbound e-mail through an existing e-mail system.
E-mail from the Vibe site is useful for the following activities:

+ Vibe users can subscribe to e-mail notifications, so that they automatically receive a message
whenever content of interest changes. For more information, see “ Subscribing to a Folder or
Entry” in “Getting Informed” in the Novell Vibe OnPrem 3 User Guide.

+ From the Vibe site, users can send e-mail messages to individual users or to teams. For more
information, see “ Sending E-Mail from within Vibe” in “Connecting With Your Co-Workers’
in the Novell Vibe OnPrem 3 User Guide.

+ If your e-mail client isiCal-enabled, appointments created in aVibe Calendar folder can be sent
to your e-mail client for posting in your e-mail client Calendar. For example, if you are using
GroupWise, see“ Accepting or Declining Internet Items’ in “Calendar” in the GroupWse 8
Windows Client User GuideGroupWse 8 Windows Client Help.

In order for your Vibe site to communicate with your e-mail system, you need to gather the
following information about your e-mail system.

+ Section 3.7.1, “Outbound E-Mail Protocol,” on page 37

+ Section 3.7.2, “Outbound E-Mail Host,” on page 37

+ Section 3.7.3, “Outbound E-Mail Authentication,” on page 38

+ Section 3.7.4, “Outbound E-Mail Send Restriction,” on page 38
After installation, outbound e-mail can be disabled and enabled again on the Vibe site, as described

in “Configuring E-Mail Integration” in “ Site Setup” in the Novell Vibe OnPrem 3 Administration
Guide However, you must configure outbound e-mail in the Vibe installation program.
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3.7.1 Outbound E-Mail Protocol

E-mail systems communicate using SMTP (Simple Mail Transfer Protocol). You need to determine
whether the e-mail system that you want your Vibe site to communicate with isusing SMTP or
SMTPS (secure SMTP).

For GroupWise, you can check how the Internet Agent is configured:

1 In ConsoleOne, browse to and right-click the Internet Agent object, then click Properties.
2 Click GroupWise > Network Address.

Inthe SMTP field, if the SSL column displays Disabled, GroupWiseisusing SMTP. If the SSL
column displays Enabled, GroupWise isusing SMTPS.

3 Click Cancel to close the Network Address page.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound E-Mail Protocol, mark SMTP or SMTPS to match the e-mail system that you want Vibe
to communicate with.

If the e-mail system requires SMTPS, see “ Securing E-Mail Transfer” in “ Site Security” in the
Novell Vibe OnPrem 3 Administration Guide

3.7.2 Outbound E-Mail Host

In order to send messages to your e-mail system, Vibe needs to know the hostname of your SMTP
mail server.

The default SMTP port of 25 istypically appropriate, unlessthe SMTP mail server requires port 465
or 587 for SMTPS connections.

For GroupWise, thisis the hostname of a server where the Internet Agent is running. GroupWise
always uses port 25, even when SSL is enabled.

When the Vibe site sends e-mail notifications for scheduled events, the messages are time-stamped
according to the time zone you specify here during installation. This setting allows you to use atime
zone for e-mail notifications that is different from the time zone where the server is located. The
time zone list is grouped first by continent or region, optionally by country or state, and lastly by
city. Some common selections for United States time zones are:

Time Zone Continent/City

Pacific Time America/Los Angeles
Mountain Time America/Denver
Central Time America/Chicago
Eastern Time America/New_York
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BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound E-Mail Host, specify the name of the mail host, the SMTP port number it uses, and the
time zone for the time stamp you want on scheduled event notifications.

3.7.3 Outbound E-Mail Authentication

Many SMTP mail hosts require avalid e-mail address before they establish the SMTP connection.
Some e-mail systems can construct avalid e-mail addressif you specify only avalid username.
Other e-mail systems require that you specify the full e-mail address for successful authentication.

Some e-mail systems a so require a password. Some do not.

By default, the GroupWise Internet Agent does not require authentication in order to receive
inbound messages. However, the /forceinboundauth startup switch isavailablefor usein the Internet
Agent startup file (gwia. cfg) to configure the Internet Agent to refuse SMTP connections where a
valid e-mail username and password are not provided. The Internet Agent can accept just the
username or the full e-mail address.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound E-Mail Authentication, indicate whether or not authentication is required for the Vibe
site to communicate with your e-mail system. If it is, specify the username or e-mail address, and if
necessary, the password for the e-mail account.

3.7.4 Outbound E-Mail Send Restriction

By default, the Vibe site allows Vibe users to send messages to al Vibe by users using the All Users
group on the Vibe site. On avery large Vibe site, this generates a very large number of e-mail
messages. If desired, you can prevent messages from being sent to the All Users group.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Allow Sending E-Mail to All Users, mark whether or not you want users to be able to send
messages to the All Users group.

3.8 Enabling Inbound E-Mail

You can configure your Novell Vibe site so that users can post comments by e-mailing them to the
folder where they want to post the comment. In order to receive e-mail postings, folders must be
properly configured, as described in “Enabling Folders to Receive Entries through E-Mail” in
“Managing Folders’ in the Novell Vibe OnPrem 3 User Guide. Also, users must know the e-mail
address of the folder where they want to post their comment.

+ Section 3.8.1, “Internal Mail Host for Inbound E-Mail,” on page 39
Section 3.8.2, “Inbound E-Mail Port Number,” on page 39
Section 3.8.3, “Inbound E-Mail IP Address,” on page 39

Section 3.8.4, “Inbound E-Mail Security,” on page 40

*

*

*
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After installation, inbound e-mail can be disabled and enabled again on the Vibe site, as described in
“Disabling/Enabling Inbound E-Mail Postings’ in “Site Setup” in the Novell Vibe OnPrem 3
Administration Guide However, you must configure inbound e-mail in the Vibe installation
program.

3.8.1 Internal Mail Host for Inbound E-Mail

Inbound e-mail is disabled by default. When you enableit, the Vibe site starts an internal SMTP
mail host to receive incoming messages and post them to the fol ders associated with the e-mail
addresses to which the messages are addressed. By default, the internal SMTP mail host uses port
2525, so that it does not conflict with another mail host that might be running on the Vibe server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound E-Mail Configuration, mark whether or not you want users to be able to post to the Vibe
site from their e-mail clients.

3.8.2 Inbound E-Mail Port Number

Selecting the port number for the Vibe internal SMTP mail host presents the same issue that needs to
be dealt with for the HTTP port numbers, as described in “HTTP/HTTPS Ports’ on page 31. You
might want to configure the Vibe internal SMTP mail host to use the standard SMTP port of 25.
How you handle the issue depends on whether you are installing on Linux or on Windows.

Linux: Keep the default port number (2525) in the Vibe Installation program, then complete the
steps in Section 4.1.5, “Setting Up Port Forwarding,” on page 54 so that requests incoming
on port 25 are forwarded to port 2525.

Windows:  Specify port 25 for incoming e-mail in the Vibe Installation program.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound E-Mail Configuration, specify the port number for the Vibe internal SMTP host to listen on.

3.8.3 Inbound E-Mail IP Address

If you want to install Vibe on a server where an SMTP mail host is already running, you can do so if
the server has multiple | P addresses. The existing SMTP mail host can use port 25 on one | P address
and Vibe can use port 25 on another |P address. During installation, you only need to specify an IP
address if the server has multiple | P addresses and you want Vibe to bind to a specific |P address
rather than all of them.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound E-Mail Configuration, specify the IP address for the Vibe internal SMTP host to listen on,
if you are installing Vibe on a server with multiple IP addresses and you want Vibe to bind to just one of
them.
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3.8.4 Inbound E-Mail Security

You can choose whether the Vibe internal mail host uses TLS (Transport Layer Security) when it
communi cates with other SMTP mail hosts. In order for TLSto function properly, you must have a
certificate on the Vibe server, as described in “ Securing E-Mail Transfer” in “ Site Security” in the
Novell Vibe OnPrem 3 Administration Guide. When an SMTP mail host queries the Vibe mail host,
the Vibe mail host communicates its ability or inability to handle TLS. The other SMTP mail host
then communicates appropriately, taking into account how the Vibe internal mail host is configured.
The default isto use TLS, because this provides more secure communication between mail hosts.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound E-Mail Configuration, mark whether or not you want the Vibe server to announce that it
can use TLS.

You can install Vibe with Announce TLS selected, and then set up the certificate afterwards.
However, if you select Announce TLS, inbound e-mail does not work until the certificateis available
on the Vibe server.

3.9 Planning Site Security

+ Section 3.9.1, “Vibe Site Administrator Password,” on page 40
+ Section 3.9.2, “Linux User ID for Vibe,” on page 40

3.9.1 Vibe Site Administrator Password

When you first log in to the Novell Vibe site, you use admin as the Vibe administrator username and
admin asthe password. You should immediately change the password to one of your own choosing.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Vibe Administrator Credentials, specify the password that you want to use whenever you log in as
the Vibe site administrator.

3.9.2 Linux User ID for Vibe

For optimum security, Vibe should not run as the Linux root user. For example, if an intruder
manages to assume the identity of the Vibe program, the intruder gains all the privileges of the
commandeered process. If the processis running with root user privileges, the intruder has root
access to your system. If the processis running as a user with minimal privileges, the intruder has
only restricted access to your system. Therefore, your system is more secure if the Vibe program
does not run as root. For example, you might want to create a user named vibeadmin for the Vibe
program to run as. Linux users require afull name and a password.

In addition to creating a Linux user for the Vibe program to run as, you can aso create a Linux
group for that user to belong to. This enables the Vibe program to create directories and files with
consistent ownership and permissions. For example, you might want to create a group named
vibeadmin for the vibeadmin user to belong to. Groups do not require passwords.

As an alternative to creating a custom Linux username and group for Vibe, you can use the existing
wwwrun username and the www group. This account istypically used to start Web server processes.
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BASIC VIBE INSTALLATION SUMMARY SHEET

Under Linux Username and Group, specify the non-root Linux username and group name to use for
running the Vibe program. If you are creating a new Linux user, specify its full name and password.

IMPORTANT: The non-root Linux username and group must exist before you start the Vibe
Installation program. Instructions for creating the username and group are provided in Section 4.1.2,
“Performing Pre-Installation Tasks on Linux,” on page 49.

3.10 Gathering Directory Services Information

Unless you are planning avery small Novell Vibe site, the most efficient way to create Vibe usersis
to synchronize initial user information from your network directory service (Novell eDirectory,
Microsoft Active Directory, or other LDAP directory service) after you have installed the Vibe
software. Over time, you can continue to synchronize user information from the LDAP directory to
your Vibe site.

+ Section 3.10.1, “LDAP Directory Service,” on page 41

¢ Section 3.10.2, “LDAP Connections,” on page 41
¢ Section 3.10.3, “LDAP Synchronization Options,” on page 44

IMPORTANT: Vibe performs one-way synchronization from the LDAP directory to your Vibesite.
If you change user information on the Vibe site, the changes are not synchronized back to your
LDAP directory.

3.10.1 LDAP Directory Service

You can synchronize initial Vibe user information from any LDAP directory. This guide provides
instructions for synchronizing user information from eDirectory and Active Directory. If you are
using ancther LDAP directory, use the instructions as guidelines for the tasks you need to perform.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP Directory Service, mark the LDAP directory service from which you want to synchronize
Vibe user information.

3.10.2 LDAP Connections

You can configure one or more L DAP connections. Each connection requires the following
configuration information:

*

“LDAP Server” on page 42

“LDAP Attribute to Identify a User” on page 42
“LDAP Attribute for Vibe Name” on page 43
“User and Group Object Locations’ on page 43

*

*

*
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LDAP Server

In order to synchronize initial user information, Vibe needs to access an LDAP server where your
directory serviceis running. You need to provide the hostname of the server, using a URL with the
following format:

ldap://hostname
If the LDAP server requires a secure SSL connection, use the following format:
ldaps://hostname

If the LDAP server is configured with adefault port number (389 for non-secure connections or 636
for secure SSL connections), you do not need to include the port number in the URL. If the LDAP
server uses a different port number, use the following format for the LDAP URL :

ldap://hostname:port number
ldaps://hostname: port number

In addition, Vibe needs the username and password of a user on the LDAP server who has sufficient
rights to access the user information stored there. You need to provide the username, along with its
context in your LDAP directory tree, in the format expected by your directory service.

Directory Service Format for the Username
eDirectory cn=username,ou=organizational unit,o=organization
Active Directory cn=username,ou=organizational unit,dc=domain_component

BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP Server URL, specify the LDAP URL of the server, a fully qualified username with sufficient
rights to read the user information, and the password for that user.

If the LDAP server requires a secure SSL connection, additional setup isrequired. You must
complete the stepsin “ Securing LDAP Synchronization” in “ Site Security” in the Novell Vibe
OnPrem 3 Administration Guide to import the root certificate for your LDAP directory into the Java
keystore on the Vibe server before you configure Vibe for LDAP synchronization.

LDAP Attribute to Identify a User

The LDAP attribute that uniquely identifies a user helps facilitate renaming and moving Vibe users
and groups in the LDAP directory. If this attribute is not set, and you rename or move a user in the
LDAP directory, Vibe assumes that the new name (or the new location of the same name) represents
anew user, not amodified user, and creates a new Vibe user.

For example, suppose you have a Vibe user with agiven name of William Jones. If William changes
his nameto Bill, and you make that change in the LDAP directory, Vibe creates a new user named
Bill Jones.

To ensure that Vibe modifies the existing user instead of creating a new user when the user is
renamed or moved in the LDAP directory, map each user to a binary attribute, such asthe cu1p or
objectGUID attribute in the LDAP directory. This attribute always has a unique value that does not

Novell Vibe OnPrem 3 Installation Guide



change when you rename or move a user in the LDAP directory. If you want to map usersto a
different attribute, you must ensure that the attribute that you use is a binary attribute. For example,
the cn attribute cannot be used because it is not a binary attribute.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP that uniquely identifies a user or group, mark GUID or objectGUID, depending on whether
your LDAP directory is eDirectory or Active Directory.

LDAP Attribute for Vibe Name

LDAP directories differ in the LDAP attribute used to identify a User object. eDirectory and Active
Directory both use the cn (common name) attribute. Other LDAP directories might use the uid
(unique ID) attribute. Vibe needs to know which attribute to look for in order to find User objects.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP attribute used for Vibe name, mark cn or uid, based on the convention used by your LDAP
directory service for User objects. Ensure that users have a value for the attribute that you mark.

Vibe callsthe User object attribute screenName, So when you configure LDAP synchronization,
YyOU map screenName to either cn or uid.

As needed, other LDAP attributes can be used for logging in to the Vibe site, aslong as the attribute
isunique for each User object. For example, themail LDAP attribute on User objects could be used
to enable Vibe usersto log in to the Vibe site by using their e-mail addresses.

NOTE: Because the login name becomes part of the user’sworkspace URL, the at sign (@) inthe e-
mail address is replaced with an underscore () in the workspace URL because @ is not avalid
character inaURL.

User and Group Object Locations

Vibe can find and synchronize initial user information from User objects located in one or more
containersin the LDAP directory tree. A container under which User objects are located is called a
base DN (distinguished name). The format you use to specify a base DN depends on your directory
service.

Directory Service Format for the User Container
eDirectory ou=organizational unit,o=organization
Active Directory ou=organizational unit,dc=domain component

To identify potential Vibe users, Vibe by default filters on the following LDAP directory object
attributes:

¢ Person
¢ orgPerson

¢ inetOrgPerson
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If you want to create Vibe groups based on information in your LDAP directory, Vibe filters on the
following LDAP directory object attributes:

¢ group

¢ groupOfNames

¢ groupOfUniqueNames

You can add attributes to the user or group filter list if necessary. You can use the following
operatorsin thefilter:

+ | OR (the default)

+ & AND

+ INOT

You can choose whether you want Vibe to search for users (and optionally, groups) in containers
underneath the base DN (that is, in subtrees).

BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP User Context, specify a base DN, along with object attributes if any, and mark whether you
want subtrees searched for Vibe users.

Under LDAP Group Context, specify a base DN, along with object attributes if any, and mark whether you
want subtrees searched for Vibe groups.

You might find it convenient to create a group that consists of all the users that you want to set up in
Vibe, regardless of where they arelocated in your LDAP directory. After you create the group, you
can use the following filter to search for User objects that have the specified group membership
attribute:

(groupMembership=cn=group name,ou=organizational unit,o=organization)

IMPORTANT: Be sureto include the parentheses in your filter.

3.10.3 LDAP Synchronization Options

The following synchronization options apply to all LDAP configurations within the same Vibe zone:

+ “Synchronization Schedule” on page 45
+ “User Synchronization Options’ on page 45
* “Group Synchronization Options’ on page 46

NOTE: Because the synchronization options apply to all LDAP configurations within the same
zone, you cannot have customized synchronization settings for each LDAP configuration. However,
Novell Vibe site can have multiple zones. For more information about zones, see“ Setting Up Zones
(Virtual Vibe Sites)” in “ Site Setup” in the Novell Vibe OnPrem 3 Administration Guide.
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Synchronization Schedule

When you enable LDAP synchronization, you can set up a schedule for when it is convenient for
synchronization to occur. In planning the schedule, take into account how often your LDAP
directory user (and, optionally, group) information changes and the server resources required to
perform the synchronization for the number of users (and, optionally, groups) that you have.

You can choose to have LDAP synchronization performed every day (for example, on Saturday), or
you can select specific days of the week when you want it performed (for example, on Monday,
Wednesday, and Friday). You can choose to have it performed once a day at a specified time (for
example, at 2:00 am.), or you can set atimeinterval, so that it is performed multiple times each day
(for example, every four hours). The smallest time interval you can set is .25 hours (every 15
minutes).

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Synchronization Schedule, record the schedule for when you want LDAP synchronization to take
place.

User Synchronization Options

The following options are available for enabling and configuring user synchronization from your
LDAP directory to your Vibe site:

+ Synchronize User Profiles: Select this option to synchronize user information whenever the
LDAP directory information changes after initial Vibe site setup. The attributes that are
synchronized are the attributes that are found in the map box in the Users section on the
Configure LDAP Synchronization page.

Users
LDAF Aftribute That Identifies the User  con

In the box below, map the internal identifiers to the LDAF attribute names ofthe user recard.

By default, Vibe synchronizes the following attributes from the LDAP directory:
+ First name
¢ Last name
+ Phone number
+ E-mail address
+ Description
For information about how to add additional attributes to be automatically synchronized, see

“Synchronizing Additional LDAP Attributes’ in the Novell Vibe OnPrem 3 Administration
Guide.

+ Register LDAP User Profiles Automatically: Select this option to automatically add LDAP
usersto the Vibe site. However, workspaces are not created until userslog into the Vibe site for
the first time.
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+ DeleteUsers That AreNot in LDAP: Select this option to delete users that exist on the Vibe
site but do not exist in your LDAP directory. Use this option under the following conditions:

+ You have deleted users from your LDAP directory and you want the LDAP
synchronization process to delete them from Vibe as well.

+ In addition to the users synchronized from LDAP, you create some Vibe users manually,
as described in Section 5.2, “Creating a User,” on page 65, and you want the LDAP
synchronization process to delete the manually created users.

+ When Deleting Users, Delete Associated User Workspaces and Content: Select this option
to remove obsolete information along with the user accounts.

+ TimeZonefor New Users Select this option to set the time zone for user accounts that are
synchronized from the LDAP directory into your Vibe site. The time zone list is grouped first
by continent or region, optionally by country or state, and lastly by city. Some common
selections for United States time zones are:

Time Zone Continent/City

Pacific Time America/Los Angeles
Mountain Time America/Denver
Central Time America/Chicago
Eastern Time America/New_York

BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP User Options, mark the synchronization options you want to use.

Group Synchronization Options

The following options are available for enabling and configuring user and group synchronization
from your LDAP directory to your Vibe site;

+ Synchronize Group Profiles: Select this option to synchronize group information, such asthe
group description, to the Vibe site whenever thisinformation changesin LDAP.

+ Register LDAP Group Profiles Automatically: Select this option to automatically add
LDAP groups to the Vibe site.

+ Synchronize Group Membership: Select this option so that the Vibe group includes the same
users (and possibly groups) as the group in your LDAP directory. If you do not select this
option, and you make changes to group membership in the LDAP directory, the changes are not
reflected on your Vibe site.
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+ DeleteLocal Groups That Are Not in LDAP: Select this option to delete groups that exist on
the Vibe site but do not exist in your LDAP directory. Use this option under the following
conditions:

+ You have deleted groups from your LDAP directory and you want the LDAP
synchronization process to delete them from Vibe as well.

+ In addition to the groups synchronized from LDAP, you create some Vibe groups
manually, as described in “ Creating Groups of Users’ in “ Site Setup”, in the Novell Vibe
OnPrem 3 Administration Guide, and you want the LDAP synchronization process to
delete the manually created groups.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP Group Options, mark the synchronization options you want to use.

3.11 Accommodating Multiple Languages

The Novell Vibeinstallation program runsin English only. When you install the Vibe software, you
can choose to have the primary language of the Vibe site to be any of the following languages:

¢ Chinese-Simplified

+ Chinese Traditional

¢ Danish

+ Dutch

+ English

+ French

+ German

+ Hungarian

¢ [talian

+ Japanese

+ Polish

+ Portuguese

+ Russian

+ Spanish

+ Swedish
Some languages have an additional distinction by locale (the country where the language is spoken).

The language you select during installation establishes the language of the global text that displays
inlocations vi/here al Vibe users seeit, such asin the Workspace tree when you click the Workspace
treeicon B |

o

Horme YWaorkspace FPersonal Waorkspace Guest [guest)
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The language you select also establishes the default interface language and locale for creating new
workspaces.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Default Locale, mark the default language and specify the default country for your Vibe site.

Additional language customization can be done after installation, as described in “Managing a
Multiple-Language Vibe Site” in “Site Setup” in the Novell Vibe OnPrem 3 Administration Guide

48 Novell Vibe OnPrem 3 Installation Guide



Installing and Setting Up a Basic
Vibe Site

Follow the setup instructions for the platform where you are installing Novell Vibe OnPrem:

*

*

Section 4.1, “Linux: Installing and Setting Up aBasic Vibe Site,” on page 49
Section 4.2, “Windows: Installing and Setting Up aBasic Vibe Site,” on page 57

4.1 Linux: Installing and Setting Up a Basic Vibe
Site
You should aready have reviewed Chapter 3, “Planning aBasic Vibe Installation,” on page 25 and

filled out the Basic Vibe Installation Summary Sheet. The following sections step you through the
process of installing and starting Novell Vibe on Linux.

*

*

Section 4.1.1, “Installing Missing Libraries,” on page 49

Section 4.1.2, “Performing Pre-Installation Tasks on Linux,” on page 49
Section 4.1.3, “Running the Linux Vibe Installation Program,” on page 51
Section 4.1.4, “ Configuring Vibe to Start Automatically on Reboot,” on page 54
Section 4.1.5, “ Setting Up Port Forwarding,” on page 54

Section 4.1.6, “ Starting Vibe on Linux,” on page 56

Section 4.1.7, “ Checking the Status of the Vibe Server,” on page 56

Section 4.1.8, “Restarting Vibe,” on page 56

Section 4.1.9, “ Stopping Vibe,” on page 57

Section 4.1.10, “Uninstalling Vibe,” on page 57

4.1.1 Installing Missing Libraries

Before you install Vibe on SLES 10 SP3, you should check for and install any missing libraries.

1

Change to the following directory:
/opt/novell/teaming/stellent-converter/linux/x86

Run the exporter program.

The errors about missing input and output files are to be expected.

Look for errors about missing libraries.

If there arelibrary errors, install any libraries that are missing.

On 64-bit Linux systems, acommon missing library is 1ibstdc++33-32bit.

4.1.2 Performing Pre-Installation Tasks on Linux

1 Make surethat the Linux server where you plan to install Vibe meets the system requirements

listed in Section 2.1, “Vibe Server Requirements,” on page 17.
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2 Inaterminal window, become root by entering su - and the root password.
3 Set the Linux open file limit to meet the needs of the Vibe software:
3a Openthe /etc/security/limits.conf filein an ASCII text editor.
3b Add the following lines to the bottom of the list, following the format of the example
lines:
* hard nofile 65535
* soft nofile 4096

3c Savethefile, then exit the text editor.
4 Perform the following conditional tasks if necessary:
+ “Stopping and Disabling an Existing Web Server” on page 50
+ “Creating a Vibe User and Group” on page 50

Stopping and Disabling an Existing Web Server
If a Web server is currently running on the Vibe server, stop it, and preferably disableit.
For example, to stop the Apache Web server and its associated instance of Tomcat:

1 Enter the following commands to stop Apache and Tomcat:

/etc/init.d/tomcat5 stop
/etc/init.d/apache2 stop

2 Enter the following commands to make sure that A pache and Tomcat do not start again when
you reboot the server:

chkconfig --del apache2
chkconfig --del tomcat5s

Creating a Vibe User and Group

If the user and group that you want to use for Vibe, as described in Section 3.9.2, “Linux User ID for
Vibe,” on page 40 do not exist yet, create them. It iseasier if you create the group first.
1 Createthe Linux group that you want to own the Vibe software and data store directories:

la InYaST, click Security and Users > User Management to display the User and Group
Administration page.

1b Click Groups, then click Add.
1c Specify the group name, then click Accept or OK.
The group does not need a password.
2 Createthe Linux user that you want Vibe to run as:
2a Click Users, then click Add.

2b On the User Data tab, specify the user’s full name, username, and password, then select
Disable User Login.

Like any Linux system user, the Vibe Linux user does not need to manually login. The
Vibe Linux user does not need a password, either, but YaST requires you to provide one.

2c Click the Details tab.

2d Inthe Login Shell drop-down list, select /bin/false, because this user does not need to
manually log in.
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2e Inthe Default Group drop-down list, select the Linux group that you created in Step 1.
2f Inthe Groupslist, select the Linux group that you created in Step 1.
2g Click Accept or OK.

3 Exit YaST.

4.1.3 Running the Linux Vibe Installation Program

When you run the Vibe installation program for the first time, you typically want to use the GUI
interface. However, if you areinstalling Vibe on a server where the X Window System is not
available, atext-based installation program is also available. After you are familiar with the Vibe
installation process, you can use a silent installation to automate the process.

+ “Using the GUI Installation Program” on page 51

+ “Using the Text-Based Instalation Program” on page 52

+ “Performing a Silent Installation” on page 53

Using the GUI Installation Program

1 Inaterminal window, enter su - to becomethe root user, then enter the root password.

You need root permissionsin order to install the Vibe software, but you should not run the
Vibe software as root.

2 Changeto the directory where you downloaded and extracted the Vibe software.

3 Make surethat you have a1icense-key.xml filein the same directory with the Vibe
installation program.

more license-key.xml

The Vibe installation program does not start without alicensefile in the same directory, and the

licensefile has a different name when you download it.

For more information about licensing, see Chapter 6, “Updating Your Vibe License,” on
page 69.
4 Enter the following command to start the Vibe installation program:

./installer-teaming.linux

5 Accept the License Agreement, then click Next.

Novell/Vibe 3/ Installation Program

Installation Options

Select the action you want to perform.

" New installation
" Update software and settings
" Reconfigure settings

6 Click Next to accept the default of New installation.
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Novell Vibe 3'Installation/ Program)

Choose Installation Type

Select the type of installation you want to perform

Select the Basic installation if you do not want to configure

Advanced any of the optional features.

7 Click Next to accept the default of Basic.
8 Usetheinformation that you have gathered on the Basic Vibe Installation Summary Sheet to

10

11

provide the information that the Vibe installation program prompts you for:

Installation Locations
Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Vibe
User ID for Novell Vibe
Network Information
Database Selection
Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm
Java JDK Location
Outbound E-Mail Configuration
Protocol
Host, Port, and Time Zone
Username, Password, and Authentication
Allow Sending E-Mail to All Users
Inbound E-Mail Configuration

The installation program stores the information it gathersin the installer.xml filein the
same directory where you started the installation program.

After you have provided all the requested information, click Install to begin the Vibe
installation.

When the installation is completed, click Finish to exit the Vibe installation program.

Information about the installation process is written to the installer. log filein the same
directory where you ran the Installation program. If aproblem arises during the installation, the
installer.log file providesinformation that can help you resolve the problem.

Continue with Section 4.1.4, “Configuring Vibe to Start Automatically on Reboot,” on page 54.

Using the Text-Based Installation Program

If you try to start the GUI Vibe installation program in an environment where the X Windows
System is not running, the text-based Vibe Installation program starts instead.
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Checking license key...

License Summary

Product: Novell Teaming
Version: 2.1

UID: 1

Users: 50

Installing this software requires agreement to the
terms and conditions set forth in the:
Novell EULA and Export Compliance Notice

You can review this agreement again at the download =site or
type "REVIEW" below.

Note: You must answer "YES" to install the software.

Have vou read and agree with the license? :

If you want to use the text-based installation program in an environment where it is starting with a
GUI by default, use the following command in the directory where the installation program is
located:

./installer-teaming.linux --text

IMPORTANT: Thetext-based Vibe installation program must be run in the same directory where
the Vibe licensefileislocated. If the license fileis not in the same directory, the text-based
installation program cannot find it.

The text-based installation program gathers the same configuration information as the GUI
installation program does. Thisinformation is stored in the installer.xml filein the directory
where you run the installation program.

Theinstallation program does not write theinformation it gathersinto the installer.xml file until
you exit the installation program, and you cannot go back when you use the text-based installation
program. Therefore, when you use the text-based installation program, you should plan your
installation carefully in advance, using the Basic Vibe Installation Summary Sheet or the Advanced
Vibe Installation Summary Sheet. If you make a mistake during the installation, continue to the end
of theinstallation process and exit the installation program normally, so that all information is saved.
Then run the text-based installation program again. Your previousinformation is supplied as
defaults and you can change the information as needed.

Performing a Silent Installation

If your Vibe system expands beyond one server, you might need to repeatedly install the same Vibe
components. A silent installation makes this an easy process. Edit an existing installer.xml file
so that it has the hostname of the server where you want to perform the silent installation and copy it
to that server. In the directory where the installation program is located. use the appropriate
command to run the Vibe installation program, depending on the action that you want the silent
installation to perform:

./installer-teaming.linux --silent --install

./installer-teaming.linux --silent --upgrade
./installer-teaming.linux --silent --reconfigure
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The Installation program obtains al the information it needs from the installer.xml fileand
completes the installation without user interaction.

4.1.4 Configuring Vibe to Start Automatically on Reboot

You can configure Vibe to start automatically each time you reboot the Linux server.

1 AstheLinux root user, enter the following command:
chkconfig --add teaming
2 To verify that automatic startup is turned on, enter the following command:

chkconfig teaming

4.1.5 Setting Up Port Forwarding

In order to make Vibe available on the default HTTP/HTTPS ports of 80 and 443, you must set up
port forwarding in order to forward the browser default ports (80 and 443) to the Vibe server ports
(8080 and 8443). In addition, you must set up port forwarding if you want to forward the default
SMTP mail host port (25) to the default Vibe internal mail host port (2525).

You can set up port forwarding in one of two ways, depending on whether or not you are using the
Vibe server as afirewall.

+ “Using the SuSEfirewall2 File” on page 54

+ “Using iptables Commands” on page 55

Using the SuSEfirewall2 File
To enable port forwarding on a SUSE Linux server that uses susEfirewall2:

1 AstheLinux root user, open the following file:
/etc/sysconfig/SuSEfirewall?

2 Findthefollowing line:
FW_REDIRECT=""

3 Between the quotation marks, copy and insert the following string:

0/0,ip address,tcp,80,8080 0/0,ip address,tcp,443,8443
0/0,1ip address,tcp,25,2525

4 Replace ip address with the |P address of the Vibe server.

5 Savethe susefirewall2 file, then exit the text editor.

6 Usethefollowing command to restart the firewall:
/sbin/SuSEfirewall2 start

7 Usethefollowing command to verify that the default browser ports (80 and 443) have been
forwarded to the Vibe server ports (8080 and 8443) and that the default SMTP mail host port
(25) has been forwarded to the Vibe internal mail host:

iptables-save | grep REDIRECT

Now, users do not need to include a port number in the Vibe site URL.
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Using iptables Commands
To use iptables commands to enable port forwarding on any type of Linux server:

1 AstheLinux root user, changetothe /etc/init.d directory.
2 Inatext editor, create a new file for aset of iptables commands, for example:
gedit vibe-iptables
3 Copy and paste the following linesinto the vibe-iptables file
iptables -t nat -A OUTPUT -d localhost -p tcp --dport 80
-7 REDIRECT --to-ports 8080

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 80
-j REDIRECT --to-ports 8080

iptables -t nat -A PREROUTING -d hostname -p tcp --dport 80
-j REDIRECT --to-ports 8080

iptables -t nat -A OUTPUT -d localhost -p tcp --dport 443
-j REDIRECT --to-ports 8443

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 443
-j REDIRECT --to-ports 8443

iptables -t nat -A PREROUTING -d hostname -p tcp --dport 443
-j REDIRECT --to-ports 8443

iptables -t nat -A OUTPUT -d localhost -p tcp --dport 25
-3 REDIRECT --to-ports 2525

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 25
-j REDIRECT --to-ports 2525

iptables -t nat -A PREROUTING -d hostname -p tcp --dport 25
-j REDIRECT --to-ports 2525

In this example, the lines are wrapped for readability. When you paste them into the text editor,
if thelines are still wrapped, remove the hard returns from the middl e of the commands, so that
you have six iptables commands, each onits own line.

4 Replace hostname With the hosthame or | P address of the Vibe server.

5 Savethevibe-iptables filg, then exit the text editor.

6 Usethefollowing command to make the file executable:
chmod +x vibe-iptables

7 Usethe following command to immediately execute the commandsinthevibe-iptables file
chkconfig vibe-iptables on

8 Usethefollowing command to add vibe-iptables to future server boot initialization:
chkconfig --add vibe-iptables

9 Usethefollowing command to verify that the default browser ports (80 and 443) have been
forwarded to the Vibe server ports (8080 and 8443) and that the default SMTP mail host port
(25) has been forwarded to the Vibe internal mail host:

iptables-save | grep REDIRECT
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Now, users do not need to include a port number in the Vibe site URL.

4.1.6 Starting Vibe on Linux

The Vibe Installation program created a teaming Startup script inthe /etc/init . d directory.

1 Inaterminal window, become root by entering su - and the root password.
2 Enter the following command to start Vibe:
/etc/init.d/teaming start

You must execute the teaming Script as root, but the script runs Vibe as the user you selected
in Section 3.9.2, “Linux User ID for Vibe,” on page 40 and specified during installation.

You should see output similar to the following example:

Using CATALINA BASE: /opt/teaming/apache-tomcat
Using CATALINA HOME: /opt/teaming/apache-tomcat
Using CATALINA TEMPDIR: /opt/teaming/apache-tomcat/temp
Using JRE_HOME: /use/java/jdkl.6.0 _02/jre

3 To make sure that Vibeis ready for work:
3a Changeto the following directory:
/opt/novell/teaming/apache-tomcat/logs

where version is the version number of Tomcat that was installed along with Vibe (for
example, 6.0.18)

3b Enter the following command to display the end of the Tomcat log:
tail --f catalina.out
At the end of the log file listing, you should see:
INFO: Server startup in nnnn ms

4 Press Ctrl+C when you are finished viewing thethe catalina.out file.

4.1.7 Checking the Status of the Vibe Server

You can seeif Vibeis running by checking for its process ID (PID).

1 Inaterminal window, enter the following command:
ps -eaf | grep teaming

You should see the Vibe PID number, along with alisting of configuration settings.

4.1.8 Restarting Vibe

You need to restart Vibe whenever you use the Vibe installation program to make configuration
changes, as described in Chapter 10, “Performing an Advanced Vibe Installation,” on page 107.

1 Asroot inatermina window, enter the following command:
/etc/init.d/teaming restart

You should see the same output as when you originally started Vibe.
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4.1.9 Stopping Vibe

1 Asroot inatermina window, enter the following command:
/etc/init.d/teaming stop
You should see the same output as when you started Vibe.

2 To verify that Vibe has stopped, check for its PID number:
ps -eaf | grep teaming

The Vibe PID number, along with alisting of configuration settings, should no longer be
displayed.

4.1.10 Uninstalling Vibe

If you move the Vibe site to a different server, you can delete the Vibe files from the original server
to reclaim disk space. The default Vibe file locations are;

Vibe Software /opt/novell/teaming

Vibe File Repository and /var/opt/novell/teaming
Lucene Index

MySQL Database /var/lib/mysqgl

For acomplete list of your Vibefiles, check the installer.xml filein the directory where you
originally ran the Vibe installation program.

4.2 Windows: Installing and Setting Up a Basic
Vibe Site

You should already have reviewed Chapter 3, “Planning aBasic Vibe Installation,” on page 25 and
filled out the Basic Vibe Installation Summary Sheet. The following sections step you through the
process of installing and starting Novell Vibe on Windows.

+ Section 4.2.1, “Performing Pre-Installation Tasks on Windows,” on page 57
+ Section 4.2.2, “Running the Windows Vibe Installation Program,” on page 58

*

Section 4.2.3, “Running Vibe as a Windows Service,” on page 60

*

Section 4.2.4, “Running Vibe as a Windows Application,” on page 61
Section 4.2.5, “Uninstalling Vibe,” on page 62

*

4.2.1 Performing Pre-Installation Tasks on Windows

+ “Verifying System Requirements’ on page 58
+ “Stopping an Existing Web Server” on page 58
* “Setting Environment Variables’ on page 58
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Verifying System Requirements

Make sure that the Windows server where you plan to install Vibe meets the system requirements
listed in Section 2.1, “Vibe Server Requirements,” on page 17.

Stopping an Existing Web Server
If aWeb server is currently running on the Vibe server, stop it, and preferably disableit.
For example, to stop and disable the Internet Information Services (11S) Web server:

1 Onthe Windows desktop, click Sart > Administrative Tools > Services.
2 Right-click World Wide Web Publishing Service, then click Properties.
3 Inthe Sartup type drop-down list, select Disabled.

4 Click Sop, then click OK.

Setting Environment Variables

Make sure that the JAVA_HOME environment variable is set to the path where you installed the
JDK and that the Windows PATH environment variable includes the path to your database server.
1 Right-click My Computer, then click Properties.
2 On the Advanced tab, click Environment Variables.
3 Set the JAVA_HOME environment variable:
3a Inthe Systemvariables box, click New.
3b Inthe Variable name field, specify JAVA_HOME.
3c Inthe Variable valuefield, specify the path where you installed the JDK.

3d Click OK to add the JAVA_HOME environment variable to the list of system variables,
then click OK again to save the setting and return to the Advanced tab.

4 Check the PATH environment variable:
4a On the Advanced tab, click Environment Variables.
4b Inthe System variableslist, locate the PATH environment variable.
4c If the path includes your database server software directory, click Cancel.
or

If the path does not include your database server software directory, add the directory, then
click OK.

4.2.2 Running the Windows Vibe Installation Program

1 Loginto the Windows server as a user with Administrator rights.

2 InWindows Explorer, browse to the directory where you downloaded and extracted the Vibe
software.

3 Make surethat thereisalicense-key.xml filein the directory.

The Vibe installation program does not start without a license file, and it has a different name
when you download it.
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For more information about licensing, see Chapter 6, “Updating Your Vibe License,” on
page 69.

4 Double-click the installer-teaming.exe fileto start the Vibe installation program.

Accept the License Agreement, then click Next.

Novell Vibe 3 Installation Program x|
Installation Options
Select the action you want to perform. N

& New installation
" Update software and settings
" Reconfigure settings

Click Next to accept the default of New installation.

Novell Vibe 3 Installation Program x|

Choose Installation Type

Select the type of installation you want to perform N

Select the Basic installation if you do ot want to configure any of the
Advanced optional features.

7 Click Next to accept the default of Basic.
8 Usetheinformation that you have gathered on the Basic Vibe Installation Summary Sheet to

provide the information that the Vibe installation program prompts you for:

Installation L ocations
Default Locale for Novell Vibe
Network Information
Database Selection
Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm
Java JDK Location
Outbound E-Mail Configuration
Protocol
Host, Port, and Time Zone
Username, Password, and Authentication
Allow Sending E-Mail to All Users
Inbound E-Mail Configuration

The installation program stores the information it gathersin the installer.xmi filein the
same directory where you started the installation program.

After you have provided all the requested information, click Install to begin the Vibe
installation.
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10 When theinstallation is completed, click Finish to exit the Vibe installation program.

11

Information about the installation process is written to the installer. log filein the same
directory where you ran the Installation program. If a problem arises during the installation, the
installer.log file provides information that can help you resolve the problem.

Continue with one of the following sections, depending on how you want to run the Vibe
software:

+ Section 4.2.3, “Running Vibe as a Windows Service,” on page 60
+ Section 4.2.4, “Running Vibe as a Windows Application,” on page 61

4.2.3 Running Vibe as a Windows Service

*

*

*

*

*

“Configuring Vibe as a Windows Service” on page 60

“Starting Vibe as a Windows Service” on page 61

“Configuring the Vibe Service to Start Automatically on Reboot” on page 61
“Restarting the Vibe Service” on page 61

“Stopping the Vibe Service” on page 61

Configuring Vibe as a Windows Service

The Vibeinstallation program created aservice . bat filefor configuring Vibe to run as a Windows
service.

1

In a Command Prompt window, change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat\bin\windows

where version isthe version number of Tomcat that wasinstalled along with Vibe (for example,
6.0.18).

In the windows directory, copy the files from the appropriate subdirectory.
The following subdirectories exist: x86, x64, ia64.

If you are unsure which subdirectory is appropriate for your server, use the readme . txt file
located inthe c: \Program Files\Novell\Teaming\apache-tomcat\bin\windows
directory as areference.

Paste the filesinto the ¢c: \Program Files\Novell\Teaming\apache-tomcat\bin
directory.

(Conditiona) If Vibeisrunning on a supported 64-bit Windows operating system and you have
a 64-bit IDK, complete the following:

4a Changetothec:\Program Files\Novell\Teaming\apache-
tomcat\bin\windows\x64 directory.

4b Copy any 64-hit . exe files and paste them into the c: \Program
Files\Novell\Teaming\apache-tomcat\bin directory, overwriting any existing files.

Use the following command to configure Vibe as a Windows service:
service.bat install Teaming

This creates a service named Apache Tomcat Teaming.
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Starting Vibe as a Windows Service

1 Onthe Windows desktop, click Sart > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Sart.

Configuring the Vibe Service to Start Automatically on Reboot

When you run Vibe as a Windows service, you can configure Vibe to start automatically each time
you reboot the Windows server.

1 Onthe Windows desktop, click Sart > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Properties.
3 Inthe Sartup type drop-down list, select Automatic, then click OK.

Restarting the Vibe Service

You need to restart Vibe whenever you use the Vibe installation program to make configuration
changes, as described in Chapter 10, “Performing an Advanced Vibe Installation,” on page 107.

1 On the Windows desktop, click Sart > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Restart.
3 Close the Services window.

Stopping the Vibe Service

1 Onthe Windows desktop, click Sart > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Sop.
3 Close the Services window.

4.2.4 Running Vibe as a Windows Application
+ “Starting Vibe as an Application” on page 61
* “Stopping Vibe as an Application” on page 61

Starting Vibe as an Application

The Vibeinstallation program created astartup.bat filefor starting Vibe.
1 InaCommand Prompt window, change to the following directory:

c:\Program Files\Novell\Teaming\apache-tomcat\bin

where version isthe version number of Tomcat that was installed along with Vibe (for
example, 6.0.18).

2 Runthestartup.bat fileto start Vibe as an application.

Stopping Vibe as an Application
1 InaCommand Prompt window, change to the following directory:

c:\Program Files\Novell\Teaming\apache-tomcat\bin
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where version isthe version number of Tomcat that wasinstalled along with Vibe (for example,
6.0.18).

2 Run the shutdown.bat fileto stop the Vibe application.

4.2.5 Uninstalling Vibe

If you move the Vibe site to a different server, you can delete the Vibe files from the original server
to reclaim disk space. The default Vibe file locations are:

Vibe Software c:\Program Files\Novell\Teaming

Vibe File Repository and ¢ :\Novell\Teaming
Lucene Index

MS SQL Database c:\Program Files\Microsoft SQL Server\MSSQL\Data

For acompletelist of your Vibefiles, check the installer.xml filein the directory where you
originally ran the Vibe Installation program.
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Adding Users to Your Vibe Site

After you haveinstalled Novell Vibe OnPrem and made sure that Vibe starts successfully, you are
ready to access your Vibe site from your Web browser and add users.

+ Section 5.1, “Accessing Your Basic Vibe Site as the Site Administrator,” on page 63

+ Section 5.2, “Creating a User,” on page 65

¢ Section 5.3, “Adding Vibe Users from Your LDAP Directory,” on page 66

5.1 Accessing Your Basic Vibe Site as the Site
Administrator

1 Inyour Web browser, specify one of the following URLSs, depending on whether or not you are
using a secure SSL connection:
http://vibe server
https://vibe server
Replace vibe server with the DNS hostname or fully qualified domain name of the Novell
Vibe server. If you have configured the HTTP ports correctly, you do not need to include the
port number in the Vibe URL.

User ID:

Passwaord

2 Loginusing admin asthelogin name and admin as the password.
3 Click My Wbrkspace in the Action toolbar.
The Vibe administrator’s personal workspace displays.
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4 Change the default administrator password to a secure password:
4a Click Profile, then in the upper right corner of the Profile page, click Edit.

4b  Specify your own password for the Vibe administrator in the New Password and Confirm
New Password fields.

4c (Optiona) Provide useful information in the additional fields of the Vibe administrator’'s
profile.

4d Click OK to return to the administrator’s profile.
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5.2 Creating a User

For testing purposes or for avery small Novell Vibe site, you can create each Vibe user manually.

1 Login asthe Vibe administrator, then click the Administration icon E
2 Under Management,click New User.

User ld

New Password

Confirm New Password

First Name Middle Name Last Name

E-Mail Address Mobile E-Mail Address  Text Messaging E-Mail Address

3 Specify at least the user ID, password, first name, and last name.
4 (Optional) Provide useful information in the additional fields for the new user.
5 Click OK, then click Close to return to the administrator’s workspace.

If you click the Workspace treeicon & | then expand Personal Workspaces, you see that the
workspace for the user you just created does not exist yet. Workspaces are not created for users
until the userslog in for the first time.

6 Click the Log Out icon u to log out as the Vibe administrator.

7 Onthelogin page, provide the username and password for the Vibe user you just created, then
click OK to log in to the Teaming site.

8 Click My Workspace in the Action toolbar to see the workspace for the new user.

Novell. Vibe Jade Suml &4 @ e 7

L TRET- R () My Workspace ) vnats New My Favanias: = MyTeams ®  RecentPlaces ™ WWorkspare ®  Miew ® .
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S
(GRS =T (RN (TN Aecoteeies

Toshs mw =
e Enliiad

...... s Frissity e ata stia Assignadta " e Lozatien

+ 4@ =

Sigm the guesthook

acle Surmd (= umd) 1 Biog
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[ Calendar
LIFiles

B Guesthook
[E] Photo Alburn
[ Tasks

[T Trash
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Guestbook +t+ e
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As each new user logs into the Vibe site, a personal workspace is created.
9 Click the Log Out icon to leave the new user’s personal workspace.

5.3 Adding Vibe Users from Your LDAP Directory

Unlessyou have avery small Novell Vibe site, you create Vibe users by synchronizing their user
information from an LDAP directory service such as Novell eDirectory or Microsoft Active
Directory.

IMPORTANT: For alarge Vibe site with thousands of users, the synchronization process can
consume substantial server resources and can take some time to complete. Perform theinitial import
from the LDAP directory at atime when this processing does not conflict with other activities on the
server.

1 If the LDAP server requires a secure SSL connection in order to access the directory service,
create a public key certificate for the Vibe server.

For instructions, see “ Securing LDAP Synchronization” in “ Site Security” in the Novell Vibe
OnPrem 3 Administration Guide.

2 InaWeb browser, log in to the Vibe site as the Vibe administrator, then click the
Administration icon &

3 Under System, click Configure LDAP, then click Add a New LDAP Connection.

4 Fill inthe following fields based on the information you gathered on the Basic Vibe Installation
Summary Sheet:
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Configure LDAP Synchronization

\P Cannection

New LDAP connection

Configuration for: New LDAP connection  (SsE L ER TEsE BT

The LDAF server URL format is, Idapi#thost port For example: ldap:/flocalhost380

LDAP semver URL
User DN

Password

For eliractany use GUID. For Active Direstory use objectGUID

LDAP aftribute that uniguely identifies a user ar group:

Users

LDAP attribute used for Vibe name:  uid

In the box below, map the internal identifiers to the LOAP attribute names of the user record. Use the following syntax internallD=|dapAttName

E

lasitlame=surmame
phone= 1]
description=description

Bage DN

(ltnbjeciClass=Person)iobjectClass=on abjects

Filter

&
Search Sublree

Groups

LDAP Server URL
User DN
Password

LDAP attribute that uniquely identifies a user or group

LDAP attribute used for Vibe name
Base DN

Set the following synchronization options based on the information you gathered on the Basic

Vibe Installation Summary Sheet:
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[ Enable Schedule

O run Immediately

= Schedule

(@] Every Day
(O] ‘Weekly (on the days selected below)

Ooooooon

SunMon Tue'Wed Thu Fri Sat

@ MTime 12 % : 15 % GMT
O Repeat Every 0.25 ¥ Hours

Users

O Synchranize User Profiles

O Register LOAP User Profiles Automatically

[ Delets Users That are not in LDAP

O when Deleting Users, Delete Associated User Workspaces and Content
Use the following time zone when creating new users.

(GMT 0:00) Greemwich Mean Time (GMT) v

Use the following locale when creating new users.
English (United States) [English (United States)] v

Groups

Synchranize Group Profiles

O Register LOAP Group Profiles Automatically
O Synchronize Group Membership

O Delete Lacal Groups That Are Mot in LDAP

Lacal user accaunts
Allow Login for Local User Accounts, ({i.e., user accounts notin LOAPY

Enable Schedule
Synchronize User Profiles
Register LDAP User Profiles Automatically

6 Click Apply to save the information and settings.
7 Select Run Immediately, then click Apply to test LDAP synchronization.

A status box displays the users and groups that have been added, maodified, or deleted on the
Vibesite.

IMPORTANT: If you used an LDAP user attribute of uid and some users were not
synchronized from the LDAP directory to Vibe, repeat the procedure and use cn instead of uid.

The usernames admin and guest are reserved for use by Vibe. If your LDAP directory
includes users with these names, LDAP information for these reserved usernames is not
imported into the Vibe site.

8 Click Closeto close the status box, then click Close to close the Configure LDAP
Synchronization page.

Vibe performs one-way synchronization from the LDAP directory to your Vibe site. If you
change user information on the Vibe site, the changes are not synchronized back to your LDAP
directory.

IMPORTANT: At this point, users could log into the Vibe site by using their eDirectory or Active
Directory usernames and passwords. However, you should not invite usersto visit the Vibe site until
after you have finished setting up the Vibe site, as described in “ Site Setup” in the Novell Vibe
OnPrem 3 Administration Guide.
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Updating Your Vibe License

Several different Vibe licenses are available:
+ Evaluation License: Available from Novell Downloads (http://download.novell.com).

You receive your evaluation license when you download the evaluation version of Vibe.

+ Sarter Pack License: Available from the Novell Vibe Starter Pack Web page (http://
www.novell.com/products/teaming/starterpack.html).

You receive your 20-user starter pack license when you download the 20-user starter pack.
+ Sandard Vibe License: Purchased through a Novell sales representative or Novell partner.

The Standard Vibe License gives full Vibe functionality on a per-user basis. It includes Guest
user functionality for Vibe userswho are covered by a Standard Vibe License. However, if non-
licensed Vibe users are accessing the Vibe site through the Guest user functionality (as an
anonymous user), then you must purchase a Guest Access Instance License in addition to the
Standard Vibe License for each Vibe instance.

After you purchase the Standard Vibe License, you can access your license key or view your
purchase history in the Novell Customer Center (http://www.novell.com/customercenter).

+ Guest Access I nstance License: Purchased through a Novell sales representative or Novell
partner.

Thislicense must be purchased in addition to the Standard Vibe License. If you purchase 500 or
more Standard Vibe Licenses, the Guest Access Instance License isincluded for free.

The Guest Access Instance License allows you to provide Guest user accessto your Vibe site
for non-licensed Vibe users. If you are using Guest user access for licensed Vibe users only,
you do not need to purchase this license.

The Guest Access Instance License is a paper license and does not requireanew license-
key.xml file.

The Guest Access |nstance License can provide added benefit to your site at amanageabl e cost.
For example, suppose that your company employs 500 people. Only 200 are company
knowledge-workers whom you expect to actively participate in the Vibe site; the other 300
employees ssimply need to accessinformation that is already posted on the Vibe site, such as
files, news, or other company information. In this case, you would purchase 200 Standard Vibe
Licenses. For the remaining 300 employees who will simply be accessing the site to obtain
information, you would purchase a single Guest Access Instance License.

You must purchase one Guest Access Instance License for each Vibe instance that you are
running.

For more information about the added functionality provided by this license, see “Allowing
Guest Accessto Your Vibe Site” and “ Allowing Web Crawler Accessto Your Vibe Site” in
“Site Setup” in the Novell Vibe OnPrem 3 Administration Guide.

If you originally installed Vibe with an Evaluation License or a Starter Pack License, it is easy to
update your Vibe site with the new licensefile.

1 Copy the new licensefile that you downloaded from one of the sources listed above into the
directory where you originaly ran the Vibe installation program.
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Rename the existing 1icense-key.xml file to a different name.
Rename the new licensefileto be 1icense-key.xml.
Stop Vibe.

Run the Vibe Installation program, select the Reconfigure Settings option, then select the Basic
Installation option.

ga b~ W N

6 Click Next through all the installation program pages, then click Install to update your Vibe
license.

7 Start Vibe.
8 Loginto the Vibe site as the Vibe administrator.
9 Click the Administration icon [&l, then under Management, click License.
You should see the contents of the new licensefile.
10 Click Close.

At any time, you can generate a report of license usage, as described in “License Report” in “Site
Maintenance” in the Novell Vibe OnPrem 3 Administration Guide.
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What's Next

After you haveinstalled and started Novell Vibe OnPrem, there are still administrative tasks to
perform before your Vibe siteis ready for usersto log in and use Vibe efficiently. Refer to the
following sections of the Novell Vibe OnPrem 3 Administration Guide as you finish setting up your
Vibe site.

*

“Setting Up Initial Workspaces’

+ “Planning and Controlling User Access to Workspaces and Folders’
+ “Setting Up User Access to the Vibe Site”

+ “Configuring E-Mail Integration”

+ “Configuring Real-Time Communication Tools”

+ “Setting Up Mirrored Folders’

* “Setting Up Zones (Virtua Vibe Sites)”

+ “Adding Software Extensions to Your Vibe Site”

+ “Using Remote Applications on Your Vibe Site”

+ “Customizing Your Vibe Site by Editing Vibe Configuration Files”
+ “Managing a Multiple-Language Vibe Site”
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Basic Vibe Installation Summary

Sheet

Installation Program Field

Value for Your Vibe Site

Explanation

Vibe Server Platform:

+ Windows

¢ Linux

See Section 3.2.1, “Vibe Server
Platform,” on page 26.

Vibe Server Architecture:

* 32-bit
* 64-bit

See Section 3.2.2, “Vibe Server
Architecture,” on page 26.

Vibe Server Memory:

¢ 4GB
¢ 8GB
+ More

See Section 3.2.3, “Vibe Server
Memory,” on page 27.

Java Development Kit (JDK):

¢ Sun JDK
¢ |IBM JDK

See Section 3.3, “Selecting a
Java Development Kit,” on
page 29.

Vibe Installation Locations:
* Software
Linux default:
/opt/novell/teaming
Windows default:

c:\Program
Files\Novell\Teaming

+ File repository
Linux default:
/var/opt/novell/teaming
Windows default:

c¢:\Novell\Teaming

See Section 3.2.4, “Vibe
Installation Locations,” on
page 28.

TrueType Font Location:
Default:

/usr/X11R6/1ib/X11/fonts/
truetype

See Section 3.2.5, “TrueType
Font Location (Linux Only),” on
page 29.

Basic Vibe Installation Summary Sheet
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Installation Program Field

Value for Your Vibe Site

Explanation

Vibe Site Locale:
Language:

+ Chinese-Simplified
+ Chinese Traditional
+ Danish

+ Dutch

+ English

* French

*+ German

+ Hungarian

* Japanese

+ Polish

* Portuguese

* Russian

+ Spanish

¢ Swedish

Country:

See Section 3.11,
“Accommodating Multiple
Languages,” on page 47.

User ID for Novell Vibe (Linux only):

+ User ID:
Full name:

Password:
* Group ID:

See Section 3.9.2, “Linux User
ID for Vibe,” on page 40.

Network Information:

¢ Host:

¢ HTTP port: 80

* Secure HTTP port: 443
+ Listen port: 8080

+ Secure listen port: 8443
* Shutdown port:

* AJP port:

Section 3.4, “Gathering Network
Information for Your Vibe Site,”
on page 30.

Database Type:

+ MySQL
+ Microsoft SQL

* Oracle

See Section 3.6.1, “Database
Type,” on page 34.

JDBC URL:

¢ Hosthame:

¢ Port number:

See Section 3.6.3, “Database
Location,” on page 34.
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Installation Program Field Value for Your Vibe Site

Explanation

Database Credentials:

¢ Username:

+ Password:

See Section 3.6.4, “Database
Credentials,” on page 35.

Database Setup Method:
* During installation (automatically
by the Vibe Installation program)

+ Before installation (manually by
your database administrator)

See Section 3.6.2, “Database
Setup Method,” on page 34.

Database Encryption Algorithm:

* SHA

* SHA-256

* MD5

+ PBEWIithMD5AndDES

See Section 3.6.5, “Database
Encryption Algorithm,” on
page 36.

Java JDK Location:

+ Java home:
+ JVM heap size:

See Section 3.3, “Selecting a
Java Development Kit,” on
page 29.

Outbound E-Mail Protocol:

¢ SMTP
¢ SMTPS

See Section 3.7.1, “Outbound
E-Mail Protocol,” on page 37.

Outbound E-Mail Host:

¢ Hostname:
¢ SMTP port:
Default: 25
+ Time zone
+ Continent/region:
+ Country/state:
+ City:

See Section 3.7.2, “Outbound
E-Mail Host,” on page 37.

Outbound E-Mail Authentication:

¢ Username:
+ Password:

+ Authentication required? No / Yes

See Section 3.7.3, “Outbound
E-Mail Authentication,” on
page 38.

Allow Sending E-Mail to All Users

Yes / No

See Section 3.7.4, “Outbound
E-Mail Send Restriction,” on
page 38.
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Installation Program Field

Value for Your Vibe Site

Explanation

Inbound E-Mail Configuration

¢ Enable: No/ Yes
¢ SMTP bind address:
¢ SMTP port:

¢ Announce TLS: Yes / No

See Section 3.8, “Enabling
Inbound E-Mail,” on page 38.

Vibe Site Password:

* Administrator username: admin
* Default password: admin

* Your password:

See Section 3.9.1, “Vibe Site
Administrator Password,” on
page 40.

LDAP Directory Service:

* Novell eDirectory
+ Microsoft Active Directory
* Other LDAP directory

See Section 3.10, “Gathering
Directory Services Information,”
on page 41.

LDAP Server:

¢ LDAP server URL:
¢ User DN:
+ Password:

See “LDAP Server” on page 42.

LDAP Attribute to Identify User:
¢ GUID

screenName=GUID
¢ object GUID

screenName=objectGUID

See “LDAP Attribute to Identify
a User” on page 42.

LDAP Attribute for Vibe Name:
¢ cn

screenName=cn
¢ uid

screenName=uid

See “LDAP Attribute for Vibe
Name” on page 43.

LDAP User Search Context:

+ Base DNs:
+ Additional filter attributes:

+ Search subtree: Yes / No

See “User and Group Object
Locations” on page 43.

LDAP Group Search Context:

+ Base DNs:
+ Additional filter attributes:

+ Search Subtree: Yes / No

See “User and Group Object
Locations” on page 43.
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Installation Program Field

Value for Your Vibe Site

Explanation

LDAP Synchronization Schedule:

* Days
+ Every day
* Weekly
Sun Mon Tue Wed Thu Fri
Sat
* Hours:
¢ Attime:

¢ Repeat every nn hours

See “Synchronization Schedule”
on page 45.

LDAP User Options:

+ Synchronize user profiles

* Register LDAP user profiles
automatically

+ Delete users that are not in LDAP

+ When deleting a user, delete
associated user workspaces and
content

+ Time zone for new users

See “User Synchronization
Options” on page 45.

LDAP Group Options:

+ Synchronize group profiles

+ Register LDAP group profiles
automatically

+ Synchronize group membership

+ Delete local groups that are not in
LDAP

See “User Synchronization
Options” on page 45.

Basic Vibe Installation Summary Sheet
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Advanced Installation and
Reconfiguration

*

Chapter 9, “Planning an Advanced Vibe Installation,” on page 81

Chapter 10, “Performing an Advanced Vibe Installation,” on page 107
Chapter 11, “ Setting Configuration Options after Installation,” on page 109
Chapter 12, “ Advanced Vibe Installation Summary Sheet,” on page 111

*

*

*
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Planning an Advanced Vibe
Installation

The Advanced installation provides additional options for you to customize Novell Vibe OnPrem.

+ Section 9.1, “What Is an Advanced Installation?,” on page 81

+ Section 9.2, “Distributing Different Data Types to Different Locations,” on page 82
+ Section 9.3, “Using Advanced Network Information Settings,” on page 83

* Section 9.4, “Configuring Web Services,” on page 84

+ Section 9.5, “Changing Your Lucene Index Server Configuration,” on page 85

+ Section 9.6, “Managing RSS Feeds,” on page 87

+ Section 9.7, “Configuring Presence,” on page 87

+ Section 9.8, “Configuring Conferencing,” on page 89

+ Section 9.9, “Configuring Single Sign-On with Novell Access Manager,” on page 89

+ Section 9.10, “Configuring Single Sign-On with Internet Information Services for Windows,”
on page 90

¢ Section 9.11, “Configuring Mirrored Folder Resource Drivers,” on page 103
+ Section 9.12, “Installing the Vibe Software in a Clustered Environment,” on page 105

Asyou proceed with planning, you can use the Advanced Vibe Installation Summary Sheet to record
your decisions about the options you want to use.

9.1 What Is an Advanced Installation?

In addition to the Basic installation options described in Section 3.1, “What Is aBasic Vibe
Installation?,” on page 25, the installation program for Vibe provides severa optional advanced
installation and configuration alternatives. You can implement the advanced options after
performing a Basic installation option, or you can have the installation program present al the
options together.

Compared to aBasic installation, an Advanced installation offers the following additional options:

+ Changing the session timeout

+ Specifying akeystorefile

+ Specifying different directories for different types of data

+ Disabling and enabling four different Web services

+ Changing the configuration of the Lucene Index Server

+ Configuring aremote Lucene Index Server or agroup of high-availability Lucene nodes
+ Reconfiguring how RSS feeds are retained or disabling them entirely

+ Enabling presence in conjunction with Novell Messenger

+ Configuring areverse proxy to accommodate single sign-on

Planning an Advanced Vibe Installation

81



82

+ Configuring Windows Authentication
+ Configuring mirrored folders
+ Ingtalling Vibe in a clustered environment

IMPORTANT: Thefollowing Vibe configurations require that you perform an Advanced
installation as your initial installation of the Vibe software:

+ Setting up the Vibe file repository so that some types of files are located outside the Vibe file
repository root directory. See Section 9.2, “Distributing Different Data Types to Different
Locations,” on page 82 for Advanced installation instructions. You cannot move subdirectories
within the Vibe file repository after they have been created.

+ Installing the Vibe software on multiple serversto create a clustered environment. See
Chapter 15, “Running Vibe on Multiple Servers,” on page 127 for Advanced installation
instructions. The option to enable a clustered environment is available only during an
Advanced installation.

If you want to implement an Advanced installation option, you should perform aBasic installation
first, in atest environment, before performing the Advanced installation to set up your permanent
Vibe site.

9.2 Distributing Different Data Types to Different
Locations

The default location for the Novell Vibe file repository varies by platform:

Linux: /var/opt/novell/teaming

Windows: c¢:\Novell\Teaming

Under the main Vibe file repository root directory are subdirectories for various kinds of datafiles
that are not stored in the Vibe database (MySQL, Microsoft SQL Server, or Oracle). Using an
Advanced installation, you can store Vibe datafiles in various locations.

The data files not stored in the Vibe database are divided into several functional areas;
+ Simplefilerepository: A large consumer of disk space.

All attachment files are stored in the file repository. All versions of files are also stored here.
+ Jackrabbit repository: (Optional) Takes only afraction of the space consumed by the file
repository.

By default, Vibe stores al datafilesindividually on disk, in thefile repository. If you prefer to
store datafilesin the database itself, you can use Apache Jackrabbit with Vibe. See the Apache
Jackrabbit Web site (http://jackrabbit.apache.org) for setup instructions.

+ Extensionsrepository: Disk space consumption depends on the number of extensions you add
to your Vibe site.
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An extension is a software program that you can incorporate into your Vibe sitein order to
enhance (extend) Vibe capabilities. Adblock Plusis an example of a browser extension for the
Firefox Web browser that filters out advertisements. You or a Java developer can create custom
extensions for your Vibe site. For more information about creating and using Vibe extensions,
see the Novell Vibe OnPrem 3 Developer Guide.

+ Archivestore: A large consumer of disk space.

When entries are deleted, files that were attached to the deleted entries are retained in the
archive store in order to meet compliance and archival goals. Previous versions of documents
are also retained in the archive store. After files have been archived, they are inaccessible from
the Vibe site. Files that accumulate in the archive store must be manually deleted as needed to
manage the disk space occupied by the archive store.

+ Cachestore: Consumes less disk space than the file repository.

Information derived from the attachments, such as thumbnails, HTML renderings, scaled
images, and word lists for indexing are stored in the cache store.

+ Luceneindex: Takes only afraction of the space consumed by the file repository.

The Lucene index contains only pointers to the actual data stored in the file repository. The
index enables the Lucene search engine to perform very fast searches through large quantities
of data.

The directories for the various types of data can be on the Vibe server or on aremote server. Data
accessisfastest if the dataislocal, but depending on the size of your Vibe site and the types of data
you store, the Vibe server might not be the best place to store all the Vibe data. If you want to store
any of the datatypes on aremote server, you must ensure that the remote location of the data appears
local to the Vibe server and that it is always available with read/write access.

Linux: Mount the file repository to the Vibe server.
Windows:  Map a drive from the Vibe server to the file repository.

Linux and  Place the file repository on a SAN (storage area network) with read/write access. This

Windows  alternative provides the most reliable remote location for the Vibe file repository. This is
required for a clustered environment, as described in Chapter 15, “Running Vibe on Multiple
Servers,” on page 127.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Data Locations, specify the directories where you want to store the various types of Vibe data.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe Installation,”
on page 107.

9.3 Using Advanced Network Information
Settings

+ Section 9.3.1, “Changing the Vibe Session Timeout,” on page 84
+ Section 9.3.2, “Providing a Secure Keystore File,” on page 84

Planning an Advanced Vibe Installation
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9.3.1 Changing the Vibe Session Timeout

By default, if auser’'s Novell Vibe session isidle for four hours (240 minutes), Vibe logstheidle
user out. For increased convenience to Vibe users, you can make the session timeout interval longer.
For increased security for your Vibe site, you can make the session timeout shorter.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the session timeout interval (in minutes) for your Vibe site.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe Installation,”
on page 107.

9.3.2 Providing a Secure Keystore File

For your convenience, the Vibe software includes a self-signed public certificate that enables you to
specify secure HTTP and listen ports during installation. This certificateis stored in the . keystore
filein the following directory:

Linux: /opt/novell/teaming/apache-tomcat/conft

Windows: c:\Program Files\Novell\Teaming\apache-tomcat\conf

To ensure secure SSL connections for your Vibe site, you should replace the self-signed public
certificate with a public certificate issued by avalid certificate authority.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the name and location of the public certificate.

If you do not already have a permanent public certificate for your Vibe server, see“Securing HTTP
Browser Connections” in * Site Security” in the Novell Vibe OnPrem 3 Administration Guide.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe Installation,”
on page 107.

9.4 Configuring Web Services

When you install and set up your Novell Vibe site, three Web services are enabled by default. A
fourth is available for selection. These Web services enable programs to access information on your
Vibe sitejust as users would. Allowing programmatic access to your Vibe site can be useful or can
be viewed as a security risk.

+ WSS authentication: Uses OASIS Web Services Security (WSS) (http://www.oasis-
open.org).

+ HTTP Basic authentication: Uses HTTP Basic Access authentication (http://tools.ietf.org/
html/rfc2617).
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+ Token-based authentication: Uses custom Vibe tokens to communicate with Vibe remote
applications. For more information, see “Using Remote Applications on Your Vibe Site” in
“Site Setup” inthe Novell Vibe OnPrem 3 Administration Guide.

+ Anonymous access. Allows accessto your Vibe site without authentication. It is similar to the
Guest access provided for users, as described in “ Allowing Guest Accessto Your Vibe Site” in
“Site Setup” inthe Novell Vibe OnPrem 3 Administration Guide.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Web Services, mark which Web services you want enabled for your Vibe site. The first three are
enabled by default. The fourth is disabled by default.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe Installation,”
on page 107.

9.5 Changing Your Lucene Index Server
Configuration

The default Lucene Index Server configuration is appropriate for a medium-sized Novell Vibe site.
If you have alarger Vibe site, you can change its Lucene Index Server configuration.

*

Section 9.5.1, “Understanding Indexing,” on page 85

*

Section 9.5.2, “ Changing L ucene Configuration Settings,” on page 86
Section 9.5.3, “Running the Lucene Index Server in Its Own JVM,” on page 86
Section 9.5.4, “Running the Lucene Index Server on a Remote Server,” on page 86

*

*

*

Section 9.5.5, “Running Multiple Lucene Index Servers,” on page 87

After planning your Lucene configuration, complete the planning process for additional Advanced
installation features as needed, then perform the Advanced installation as described in Chapter 10,
“Performing an Advanced Vibe Installation,” on page 107.

9.5.1 Understanding Indexing

The Lucene Index Server isresponsible for indexing al data on the Vibe site so that Vibe users can
easily use the Find and Search features to retrieve the information that they need. Text posted in
folder entriesis easy to index, because the formatting is simple. However, text in attached files
arrivesin many different file formats, many of which require conversion before the text in the files
can be indexed. Therefore, the Lucene Index Server is dependent on the available file conversion
technology in order to perform its indexing function. For information about the file viewers that
Vibe uses, see Section 2.4.1, “File Viewer Support,” on page 20.

The Lucene Index Server provides additional services on your Vibe site in addition to indexing. In
fact, you cannot access your Vibe siteif the Lucene Index Server is not running. For this reason,
Novell Vibe provides multi-server Lucene configuration options that are not available in Kablink
Vibe.
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9.5.2 Changing Lucene Configuration Settings

If you have an extremely large Vibe site and you need to reindex the Vibe data, you might see
improved performance by increasing these settings.

+ Max booleans; The default is 10000. This means that 10,000 Boolean clauses are allowed in a
query. You need to increase this only if your Vibe siteincludes more than 10,000 users, groups,
or teams.

+ RAM in MB that may be used for buffering: The default is 256 MB. Specify the amount of
RAM that you want to allocate for buffering.

+ Mergefactor: Thedefault is 10. This sets the number of index segments that are created on
disk. When additional index segments are needed, existing segments are merged to keep the
merge factor constant.

+ Network interfacefor RMI service: (Optional) Specify the IP address or hostname for the
network interface for the RMI (Remote Method Invocation (http://java.sun.com/javase/
technol ogies/core/basic/rmi/index.jsp)) service.

Thisis the hostname of the server where the Lucene Index isinstalled.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify any Lucene configuration settings that you want to change.

9.5.3 Running the Lucene Index Server in Its Own JVM

By default, the Lucene Index Server runsin the same Java Virtual Machine (VM) asthe Vibe
software. To leave more memory available for the Novell Vibe software, you can configure the
Lucene Index Server to run in aseparate JVM. In this configuration, it communicates with the Vibe
software using the RM| (Remote Method Invocation (http://java.sun.com/javase/technol ogies/core/
basic/rmi/index.jsp)) port, which by default is 1199.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify a hostname of localhost. Use the default RMI port number
unless it is already in use on the server.

To change from running the Lucene Index Server in the same JVM with Vibeto running it initsown
JVM, you must complete the same steps as if you were setting up the Lucene Index Server on a
remote server, including manually installing the L ucene Index Server software on the Vibe server, as
described in Chapter 14, “Installing the Lucene Index Server on a Remote Server,” on page 123.

9.5.4 Running the Lucene Index Server on a Remote Server

If the Lucene Index Server requires more memory, disk space, or CPU resources than are available
on the Novell Vibe server, you can move it to aremote server. This requires installing the Lucene
Index Server software on that server. For instructions, see Chapter 14, “Installing the L ucene Index
Server on a Remote Server,” on page 123.
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9.5.5 Running Multiple Lucene Index Servers

Because the availability of the index is critical to the functioning of the Novell Vibe site, you can
install multiple Lucene Index Servers on multiple remote servers to provide high availability. For
instructions, see Chapter 16, “Running Multiple Lucene Index Servers,” on page 131.

9.6 Managing RSS Feeds

By default, Novell Vibe users can set up RSS feedsin folders on the Vibe site, as described in
“Viewing Folders as RSS or Atom Feeds’ in “ Getting Informed” in the Novell Vibe OnPrem 3 User
Guide.

+ Section 9.6.1, “Configuring RSS Feeds,” on page 87
+ Section 9.6.2, “Disabling RSS Feeds,” on page 87
After planning the RSS settings, compl ete the planning process for additional Advanced installation

features as needed, then perform the Advanced installation as described in Chapter 10, “ Performing
an Advanced Vibe Installation,” on page 107.

9.6.1 Configuring RSS Feeds

The following aspects of RSS functionality on your Vibe site are configurable:

+ Max elapsed days. By default, items from RSS feeds are retained on the Vibe site for 31 days.
You can decrease the number of days to reduce the amount of disk space occupied by the RSS
files.

+ Max inactive days: By default, if no one on the Vibe site accesses an RSS feed for 7 days, the
feed isno longer updated. Increase or decrease the retention time for inactive feeds to meet the
needs of Vibe users and disk space considerations.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under RSS Configuration, specify the number of days that meet the needs of your Vibe site.

9.6.2 Disabling RSS Feeds

Some administrators consider RSS feeds to be a security risk because the RSS feed URL includes
username and password information. If you do not want Vibe site users to be able to subscribe to
RSS feeds from the Vibe site, you can disable this feature.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under RSS Configuration, mark No.

9.7 Configuring Presence

If you are using Novell Messenger as your instant messaging solution, you can configure Novell
Vibe to display a user’s Messenger presence information. For information about where presence
information is displayed in Vibe, see* Sending an Instant Message from within Vibe” in the Novell
Vibe OnPrem 3 User Guide.
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When you click a user’s presence icon, the Profile Quick View is displayed, which enables you to
send an instant message to the user, view the user’s personal workspace, follow the user, and more.

In order to configure Messenger presence to be displayed in Vibe, you need the following
information about the Messenger system during the Vibe installation:

+ Server address: Specify the |P address or DNS hostname of the messaging agent for your
Messenger system.
+ Port: Specify the port number.

+ Server user: Specify the fully typed, comma-delimited context username of the Allowed
Service User that you want to log in to the Messenger system and retrieve presence
information.

For example, cn=vibesvc, o=acme

For more information about the Allowed Service User, see “Integrating Novell Vibe OnPrem
with Novell Messenger” in the Novell Messenger 2.2 Administration Guide.

+ Password: Specify the password for the Allowed Service User that you want to log in to the
Messenger system and retrieve presence information.

For more information about the Allowed Service User, see “Integrating Novell Vibe OnPrem
with Novell Messenger” in the Novell Messenger 2.2 Administration Guide.

+ Server Certificate: Browseto and select the Messaging Agent’s SSL certificate. Vibe usesthis
certificate to identify the Messenger server.

If Messenger isinstalled on a separate server, copy the certificate from the Messenger server
and placeit in alocation on the Vibe server that can be reached from the Vibe installation
program.

The certificate is located in the following directory on the Messenger server:

Linux: /opt/novell /messenger/certs

Windows: c:\Novell\Messenger\certs

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Presence Configuration, select Enable Novell Messenger Presence, then list the information that
the Vibe site needs to know in order to communicate with the Messenger system.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe Installation,”
on page 107.

IMPORTANT: For Messenger presence to display in Vibe when using LDAP, you need to map
presenceID t0 your authentication attribute in the Vibe LDAP configuration page. For example,
presenceID=cn. For moreinformation, see “Configuring Presence” in the Novell Messenger 2.2
Administration Guide.
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9.8 Configuring Conferencing

Novell Vibe enables you to integrate with Novell Conferencing, so that Vibe users can easily set up
instant conferencing meetings with other Vibe users, as described in “Using Novell Conferencing
with Novell Vibe” in “Connecting With Your Co-Workers® in the Novell Vibe OnPrem 3 User
Guide.

In order to configure Conferencing to integrate with Vibe, you need the URL of your Conferencing
server.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Conferencing Configuration, select Enable Novell Conferencing Integrations, then list the
information that the Vibe site needs to know in order to communicate with the Conferencing system.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 10, “ Performing an Advanced Vibe Installation,”
on page 107.

9.9 Configuring Single Sign-On with Novell
Access Manager

Novell Access Manager provides secure single sign-on access to your Novell Vibe site by
functioning as areverse proxy server. Access Manager 3.1 SP1 IR1 isrequired for use with Novell
Vibe. You can download the required version of Access Manager from Novell Downloads (http://
download.novell.com).

For background information about setting up Novell Access Manager 3.1, see the Access Manager
3.1 Documentation Web site (http://www.novell.com/documentati on/novellaccessmanager31). For
instructions specific to Vibe, see “ Configuring a Protected Resource for a Novell Teaming 2.x
Server” (http://www.novell.com/documentati on/novell accessmanager 31/accessgateway/data/
b3nqgsg.html#bl pk97e). These instructions are based on the Linux text-based Vibe installation
program, as described in “ Using the Text-Based Installation Program” on page 52. They can easily
be adapted for running the Linux GUI Vibe installation program, as described in “ Using the GUI
Installation Program” on page 51, or when installing on Windows, as described in Section 4.2.2,
“Running the Windows Vibe Installation Program,” on page 58.

After you have configured Novell Access Manager, you must configure your Vibe site with the IP
address of one or more Access Gateway servers and with the logout URL . When you configure the
Vibe site to use the Access Gateway, the | P addresses that you specify are the only locations from
which the Vibe site accepts logins. The logout URL is the location where users find themselves
when they log out of the Vibe site.

When you enable the Access Gateway for use with your Vibe site, all Vibe users must log in through
the Access Gateway. It is not possible to set up the Vibe site so that some users log in through the
Access Gateway and some do not.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Reverse Proxy Configuration, list one or more IP addresses of Access Gateway servers that have
been configured for use by Vibe. List the logout URL, and if necessary, the Access Gateway hostname
for WebDAV connections.
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Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 10, “ Performing an Advanced Vibe Installation,”
on page 107.

9.10 Configuring Single Sign-On with Internet
Information Services for Windows

Like Novell Access Manager, Windows Authentication provides Windows users with asingle sign-
on experience, enabling usersto automatically authenticate to Novell Vibe after they arelogged in to
their individual workstations. Internet Information Services (11S) provides this capability.

Before you implement Windows Authentication, consider the following limitations:
+ |ISisbest suited for anintranet environment. Because NTLM is aconnection-based protocol, it
does not work well with HTTP proxy servers.
¢ |1S Does not support Guest Access.
After you configure the Vibe server to support Windows Authentication, complete the planning
process for additional Advanced installation features as needed, then perform the Advanced
installation as described in Chapter 10, “Performing an Advanced Vibe Installation,” on page 107.
+ Section 9.10.1, “ System Requirements,” on page 90
+ Section 9.10.2, “Planning Your 11S Installation and Configuration,” on page 91
+ Section 9.10.3, “ Configuring the Vibe Server to Support Windows Authentication,” on page 92
+ Section 9.10.4, “Running the Vibe Installation Program,” on page 99
+ Section 9.10.5, “Configuring Your Browser to Allow Access to the Vibe Site,” on page 99

+ Section 9.10.6, “Bypassing Windows Authentication to Configure LDAP and Perform Other
Tasks,” on page 100

+ Section 9.10.7, “Logging In to the Vibe Site through Windows Authentication,” on page 101
+ Section 9.10.8, " Editing Files through WebDAV with Windows Authentication,” on page 101
+ Section 9.10.9, “Configuring I1S to Load Balance in a Clustered Environment,” on page 102

9.10.1 System Requirements
Windows Authentication with 11S can be enabled for Vibe only in the following environments:

Server

+ Windows 2008 Server
+ Windows 2008 R2 Server

s

+ [IS7 with 1IS Manager with CGI and ISAPI components
+ 1S 7.5 with I1S Manager with CGI and ISAPI components
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Authentication Protocol
One of the following authentication protocols:

¢ NTLM
+ Kerberosv5
+ Negotiate/ SPNEGO (wrapper for NTLM and Kerberos v5)

Domain Controller
+ Active Directory Service

Vibe needs to be configured and synchronized with your Active Directory directory service.
For more information about configuring LDAP synchronization within Vibe, see Section 3.10,
“Gathering Directory Services Information,” on page 41 and “ Synchronizing Users and Groups
from an LDAP Directory” in the Novell Vibe OnPrem 3 Administration Guide.

If you are using Kerberos as your authentication protocol, then Key Distribution Servicesis
also required.

For more information about installing and configuring Domain Controller and other domain
services to support Windows Authentication, refer to the appropriate Microsoft documentation.

Client
One of the following clients:
+ Windows 7
+ Windows XP
Browser
One of the following browsers, configured to support Windows Authentication:

+ Internet Explorer
* Firefox

For information on how to configure your browser to support Windows Authentication, see
Section 9.10.5, “Configuring Your Browser to Allow Access to the Vibe Site,” on page 99.

9.10.2 Planning Your IIS Installation and Configuration

Use the information in the following table as you consider your |1S installation.

Directory: The default installation directory for the IIS plugin is C: \Program Files\Novell.
This is the recommended directory. If for some reason you choose to install the 1IS plug-in in a
directory other than the C: \Program Files\Novell directory, then you need to modify the
isapi redirect.properties files, as described in “Installing the Vibe 1IS Plug-in” on page 93.
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External or Local Server: You can install the IS plug-in on the same server where you are running
Vibe, or you can install it on an external server. Installing 1S on an external server can have several
benefits, such as:

* Performance improvement
+ Ability to integrate with several Vibe servers in a clustered environment

+ Ability to run Vibe from a non-Windows server

If you are running IS from an external server, then you need to edit the C: \Program
Files\Novell\Vibe IIS Plugin\conf\workers.properties file, as described in
“Installing the Vibe IS Plug-in” on page 93.

64-bit/32-bit: You can install the IIS plug-in on a 64-bit or 32-bit operating system. However, Vibe
should run on a 64-bit operating system, so if you install IS on a 32-bit operating system, you
should use an external server.

HTTP Ports: Regardless of whether 1IS and Vibe are located on the same server or separate
servers, the HTTP port and secure HTTP port for Vibe should always be 80 and 443, respectively.
This ensures that when links are generated, they contain the correct hostname and port number.

These are the ports that Vibe uses to refer to the browser. In a very basic Vibe system (single server
without Windows Authentication), the HTTP ports can be the same as the listen ports. However, in
a Vibe system with Windows Authentication enabled, the HTTP ports correspond with the ports that
the IIS server is configured to use.

Listen Ports: If you plan to run IIS on the same server as the Vibe server, you need to set the listen
port and secure listen port for Vibe to something other than 80 and 443.

By default, Vibe listens on ports 80 and 443. Because IIS also uses these ports to listen on, you
must reconfigure the Vibe listen ports to ports that are not currently in use, such as 8080 for the
listen port and 8443 for the secure listen port.

You configure Vibe ports during the Vibe installation, as described in Chapter 10, “Performing an
Advanced Vibe Installation,” on page 107.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the HTTP ports and listen ports.

Under Integration with IS for Windows Authentication, select Enable Integration with IIS for Windows
Authentication, then list the logout URL.

9.10.3 Configuring the Vibe Server to Support Windows
Authentication

To configure the Vibe server to support Windows Authentication, you must first configure I1S. You
can set up 1S on the same server where Vibe is running, or on a separate server. See Section 9.10.2,
“Planning Your I1S Installation and Configuration,” on page 91 for more information.

Complete the following sections to ensure that 11Sis configured correctly to work with Vibe.

+ “Installing the Vibe 1S Plug-in” on page 93
+ “Installing IS Manager” on page 94
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+ “Installing Windows Authentication Role Service” on page 94
+ “Creating and Managing Vibe Resources with I|S Manager” on page 95

Installing the Vibe IIS Plug-in
1 Locatethe teaming-version-iis-plugin.zip filefrom the Vibe distribution, then unzip it
intothe c:\Program Files\Novell directory.
Thiscreatesadirectory called vibe 1IS Plugin.

2 If in Step 1 you chose to unzip the teaming-version-iis-plugin.zip fileinto the
C:\Program Files\Novell directory, continue with Step 3.

or

If in Step 1 you chose to unzip the teaming-version-iis-plugin.zip fileinto alocation
other than ¢: \Program Files\Novell, you must complete the following steps:

2a Locatethe isapi redirect.properties filein each of the following directories:
¢ Vibe IIS Plugin\resourcesl\bin
¢ Vibe IIS Plugin\resources2\bin
2b Ineach of the directories, openthe isapi redirect.properties filein atext editor.

2c Adjustthevaluesof thelog file,worker file,andworker mount file propertiesto
reflect the directory where you chose to unzip the teaming-version-iis-plugin.zip
file.

2d Saveyour changes and close both of the isapi redirect.properties files.
3 If lISand the Vibe server are located on the same server, continue with Step 4.
or
If 1S and the Vibe server are located on separate servers, complete the following steps:

3a Locatethec:\Program Files\Novell\Vibe IIS
pPlugin\conf\workers.properties file.

3b Opentheworkers.properties filein atext editor.

3c Adjust the value of the worker .worker1.host property from localhost to the
hostname or IP address of the Vibe server.

3d Saveyour changes and close the editor.
4 (Conditional) If you are running 11S on a 64-bit server, complete the following steps:
4a Locatethe c:\Program Files\Novell\Vibe IIS Plugin\library\wine4 directory.

4b Copy the appropriate version of the .d11 library and paste it into each of the following
directories:

¢ C:\Program Files\Novell\Vibe IIS Plugin\resourcesl\bin
¢ C:\Program Files\Novell\Vibe IIS Plugin\resources2\bin

Ensure that you copy the correct version of the . d11 library. If you copy the incorrect
version, you receive a 500 error when trying to access the Vibe site.

4c Deletethe existing isapi_redirect.dll filesfrom the c:\Program
Files\Novell\Vibe IIS Plugin\resourcesl\bin directory, aswell asfrom the
C:\Program Files\Novell\Vibe IIS Plugin\resources2\bin directory.
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4d

Renamethe .d11 library files that you copied in Step 4b t0 isapi redirect.dll.

For example, if Vibe isrunning on an AMD64/EM6AT platform, copy C: \Program
Files\Novell\Vibe IIS Plugin\library\winé4\amdé4\isapi redirect-
version.dll intothe c:\Program Files\Novell\Vibe IIS
Plugin\resourcesl\bin and C:\Program Files\Novell\Vibe IIS
Plugin\resources2\bin directories, then deletetheorigina isapi redirect.dll file
and rename isapi redirect-version.dll tO isapi redirect.dll.

Installing IS Manager

If Internet Information Services (11S) Manager is not already installed on your server, you need to
download and install it. You also need to install the CGI and ISAPI components.

1 Install thellS 7 Administration Pack:

la
1b
1c
1d

le

1f

Navigate to Microsoft 11S Download Site (http://www.iis.net/downl oad/Manage).
Click the Manage tab.
Under Administration Pack, click Install.

(Conditional) If you have not yet installed the Microsoft Web Platform, click Get the
Microsoft Web Platform to download the . exe file, install the Microsoft Web Platform,
then click Finish your installation.

The Launch Application dialog box is displayed.
Select Web Platform Installer, then click OK.
The Web Platform Installer 2.0 dialog box is displayed.

Click Install to install the Administration Pack, then accept the terms of the license
agreement.

2 Instal the ISAPI and CGI components:

2a
2b
2c
2d
2e

2f

Launch the Web Platform Installer.

From the Web Platform Installer, select Web Platform.

Under Web Server, click Customize.

In the Application Development section, select CGI, |SAPI Extensions, and | SAPI Filters.
Click Install, then accept the terms of the license agreement.

Click Finish after the components have been installed successfully.

Installing Windows Authentication Role Service

If the Windows Authentication Role Service is not already installed, you need to install it.

1 Onthe Windows 2008 server, click Sart > Administrative Tools > Server Manager.
2 Expand Roles, then right-click Web Server (11S).
3 Click Add Role Services.
The Add Role Services window is displayed.
4 Scroll to the Security section, then select Windows Authentication.
5 Click Next, then complete the installation.
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Creating and Managing Vibe Resources with IIS Manager

1 Click Sart > Administrative Tools > Internet Information Services (11S) Manager.

2 Inthe Connections pane on the | eft side of the window, expand your server, expand Stes.
3 Right-click Default Web Site, then click Add Virtual Directory.

The Add Virtual Directory dialog box is displayed.

Add Virtual Directory

2l

Site name:  Defsult Web Site
Path: !

Alias:

Example: images

Physical path:

| e

Pass-through authentication

Connect as... Test Settings... |

o |

Cancel

4 Inthedialog box, specify the following information:
Alias. VibeResources1.
Physical path: ¢:\Program Files\Novell\Vibe
5 Click OK.

IIS Plugin\resourcesl\bin.

6 Repeat Step 3 through Step 5 to add another virtua directory.
Thistime, specify the following information in the Add Virtual Directory dialog box:

Alias: VibeResources2

Physical path: ¢:\Program Files\Novell\Vibe

IIS Plugin\resources2\bin
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7 Inthe Connections panel, select VibeResourcesl, then double-click Handler Mappings.

"E Internet Information Services (IIS) Manager P ] |

@ (5] [4] » PEN b Sites b DefaultWebSite » VibeResourcesl b |88 e -

Fle view Help

e ~ Handler Mappings o —————
€ 7|8 e pping Add Managed Handler...
W3 StartPage Add Script M
ptMap...
P . ) Use this feature to specfy the resources, such as DLLs and managed cade,
B8 PENLPTEAMING ecninstater) that handle responses for specific requect typee. Add Widcard Script Map...
£} application Pacls W
E-la) Sites Groupby: State = Add Module Mapping. .
B @ Defauit ieb Site e & [Path [state Edit Feature Permissions. ..
B ] MibeResoirces] Disabled Revert To Inherited
4] VibeResources2
= . View Ordered List...
exe Jexe
ISAPI-d @ Help
Online Help
Enabled
OPTIONSVerbHandler = Enabled
TRACEVerbHandler = Enabled
StaticFile = Enabled
A |
b (¥ [E]Features view |72 Content View
Configuration: ‘Default Web Site /VibeResources 1’ web.config €.

8 Inthe Actions pane, click Edit Feature Permissions.
The Edit Feature Permissions dialog box is displayed.

Edit Feature Permissions 21l

Permissions:
v Read
W seript

I Execute

O I Cancel

9 Select Execute, then click OK.
10 Repeat Step 7 through Step 9 for the vibeResources2 virtua directory.
11 Inthe Connections pane, select Default Web Site, then double-click |SAPI Filters.
12 Inthe Actions panel, click Add.
The Add ISAPI Filter dialog box is displayed.
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13

14
15

16

Add ISAPT Filter 2=l
Filter name:

Executsble:

| L

OK I Cancel

In the dialog box, specify the following information:
Filter name: vibeResourcesl.

You must name the filter vibeResources1 for Windows Authentication to work successfully.

Executable: ¢:\Program Files\Novell\Vibe IIS
Plugin\resourcesl\bin\isapi redirect.dll.

Click OK.

Repeat Step 12 through Step 14 to add another ISAPI Filter.

Thistime, specify the following information in the Add | SAPI Filter dialog box:
Filter name: vibeResources2.

You must name the filter vibeResources2 for Windows Authentication to work successfully.

Executable: ¢:\Program Files\Novell\Vibe IIS
Plugin\resources2\bin\isapi redirect.dll.

In the Connections pane, select the server, then double-click 1SAPI and CGI Restrictions.

Planning an Advanced Vibe Installation

97



1’5 Internet Information Services (I15) Manager

o [l 3]

@G‘) EEE

& @ -

File  View Help

€-id|

|6
- q'j StartPage
E...Gﬂ PEN (LPTEAMING\administrator)
_::2 Application Poals
=-[@) Sites

-4 Default Web Site

VibeResources1
VibeResources2

4

Q‘él ISAPI and CGI Restrictions
=

Use this feature to specify the ISAPT and CGI extensions that can run on the

Web server,
Group by: Mo Grouping i
Description = | Restriction | Path
TeamingResourc... Allowed C:'\Program FilesMovellTeamir
TeamingResourc... Allowed C:'\Program Files\MNovell\Teamir

4] |

| »

Configuration: localhost’ applicationHost. config

17 Inthe Actions pane, click Add.
The Add ISAPI or CGI Restriction dialog box is displayed.

Add ISAPT or CGI Restriction

ISAPI or CGI path:

2

Description:

L

r Allow extension path to execute

Cancel

Lo |

18 Inthe dialog box, specify the following information:

ISAPI or CGI path: Specify ¢:\Program Files\Novell\Vibe IIS

Plugin\resourcesl\bin\isapi redirect.dll.

Description: vibeResourcesl.
Allow extension path to execute: Select this option to allow the path to execute.

19 Inthe Actions pane, click Add.
The Add ISAPI or CGI Restriction dialog box is displayed.
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ISAPI or CGI path:

|| ]

Description:

r Allow extension path to execute

(04 I Cancel

20 Inthe dialog box, specify the following information:

ISAPI or CGI path: Specify ¢:\Program Files\Novell\Vibe IIS
Plugin\resources2\bin\isapi redirect.dll.

Description: vibeResources?2.

Allow extension path to execute: Select this option to allow the path to execute.
21 Inthe Connections pane, select VibeResourcesl, then double-click Authentication.
22 Select Anonymous Authentication, then click Disablein the Actions panel.
23 Select Windows Authentication, then click Enable in the Actions panel.
24 Exit the Internet Information Services Manager.

25 Perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe
Installation,” on page 107.

9.10.4 Running the Vibe Installation Program

See “Choosing Windows Authentication” on page 33 for information about how to configure the
Vibe installation program to support Windows Authentication, then follow the instructions for the
advanced installation as described in Chapter 10, “Performing an Advanced Vibe Installation,” on
page 107. Return here and continue with additional configuration steps.

9.10.5 Configuring Your Browser to Allow Access to the Vibe
Site

After Windows Authentication has been enabled on the server, you need to configure the client
browser to allow access to the Vibe site.

+ “Internet Explorer” on page 99
+ “Firefox” on page 100

Internet Explorer

1 Inan Internet Explorer window, click Tools > Internet Options.
The Internet Options dialog box is displayed.

2 Click the Security tab, select Local intranet, then click Sites.
The Local Intranet dialog box is displayed.
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3 Click Advanced.
4 Inthe Add this website to the zone field, specify the Vibe Web site.

5 Click Add > Close.

Firefox

1 InFirefox, specify about : config in the URL field.

2 Specify nt1m in the Filter window, then locate and select the networ k.automatic-ntlim-
auth.trusted-uris entry.

The Enter String Value dialog box is displayed.
3 Specify the DNS name of your Vibe site, then click OK.
For exampl €, vibe.mycompany.com.

4 Repeat Step 2 through Step 3 for network.negotiate-auth.trusted-uris and network.negotiate-
auth.delegation-uris.

9.10.6 Bypassing Windows Authentication to Configure LDAP
and Perform Other Tasks

After Windows Authentication is working on your Vibe server, you can bypass the Windows
Authentication functionality by including the Vibe listening port in the Vibe URL.

You need to do thisin order to configure your LDAP directory.

1 InaWeb browser, specify your Vibe URL with the Vibe listening port.
For example, http://vibe:8080.
The Vibe login page is displayed.

User ID: | i

Passward: |

2 Loginto the Vibe site as the Vibe administrator.

3 Configure LDAP, as described in Section 5.3, “Adding Vibe Users from Your LDAP
Directory,” on page 66.

You might also need to bypass Windows Authentication to access Vibe for the following reasons:

+ To access a specific Vibe node in a clustered environment.
+ To troubleshoot the Vibe system.
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9.10.7 Logging In to the Vibe Site through Windows
Authentication

After you have performed the configuration steps described in Section 9.10.3, “ Configuring the
Vibe Server to Support Windows Authentication,” on page 92 through Section 9.10.5, “ Configuring
Your Browser to Allow Accessto the Vibe Site,” on page 99, users can access the Vibe site through
Windows Authentication. Users who have been configured through LDAP and are already logged in
to their individual workstations do not need to log in again to access the Vibe site. Userswho are not
aready logged in before they access Vibe see the following dialog box:

x

0 Enter username and password for http://13.6.7.31

User Mame: I

Password: quuu.

Cancel |

9.10.8 Editing Files through WebDAV with Windows
Authentication

+ “Achieving Single Sign-On When Editing Files through WebDAV” on page 101
+ “Enabling Basic Authentication for WebDAV” on page 101

Achieving Single Sign-On When Editing Files through WebDAV

By default, when you edit afilein Vibe through WebDAV, you are prompted for your system login
credentials before you can edit the file. However, when Windows A uthentication is enabled on your
Vibe server, you are no longer prompted for your system login credentials before you edit afile
through WebDAV.

Thisfunctionality is supported only when you use Microsoft Office as your default document editor.
When you use OpenOffice 3.1 or later as your default document editor, Vibe allows you to edit files
through WebDAV, but it still requires you to enter your system login credentials. The single sign-on
experience is only available when you use Microsoft Office.

Enabling Basic Authentication for WebDAV

If you are using OpenOffice 3.0 or earlier, or any other document editor that requires basic
authentication (it does not support Windows Authentication), you need to configure your |1S server
to support basic authentication. Supporting basic authentication enables Vibe users to edit files
through WebDAV when using a document editor other than Microsoft Office or OpenOffice 3.1 or
later.

NOTE: If you enable basic authentication on your |1S server, all users who access the Vibe site
through Firefox are prompted for their login credentials. Single sign-on to the Vibe server no longer
functions. However, users who access the Vibe site using Internet Explorer retain the single sign-on
experience.
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To enable basic authentication on your IS server, you need to install the Basic Authentication Role
Service.
1 Onthe Windows 2008 server, click Sart > Administrative Tools > Server Manager.
2 Expand Roles, then right-click Web Server (11S).
3 Click Add Role Services.
The Add Role Services window is displayed.
Scroll to the Security section, then select Basic Authentication.
Click Next, then complete the install ation.
Click Sart > Administrative Tools > Internet Information Services (11S) Manager.

~N o o b~

In the Connections pane on the left side of the window, expand your server, expand Stes, then
expand Default Web Site.

8 Select VibeResourcesl, then double-click Authentication.
9 Sedlect Basic Authentication, then click Enable in the Actions panel.
10 Closethe Internet Information Services (11S) Manager.

9.10.9 Configuring IS to Load Balance in a Clustered
Environment

If you have Vibe installed in a clustered environment where there are multiple Vibe nodes, you can
configure 1S to balance the load of user requests from the multiple Vibe nodes, while still
supporting Windows Authentication.

1 OnthellSserver, locate the ¢: \Program Files\Novell\Vibe IIS
Plugin\conf\workers.properties.clustered.template file, then open thefilein atext
editor.

2 Copy the contents of thefile.

3 Locatethe c:\Program Files\Novell\Vibe IIS Plugin\conf\workers.properties
file, then open thefilein atext editor.

4 Paste the contents of the ¢: \Program Files\Novell\Vibe IIS
Plugin\conf\workers.properties.clustered.template that you copiedin Step 2 and
intothe c:\Program Files\Novell\Vibe IIS Plugin\conf\workers.properties filg,
overwriting the content that was previously there.

5 Replace the value of worker.worker 1.host from first_hostname_or_ip with the hostname or IP
address of your first Vibe node.

6 Repeat Step 5for each additional Vibe node that is running in your environment. If you have
more than two Vibe nodes, you can add an additional section to the workers.properties file
for each additional node.

7 For each Vibe node that you specified in Step 5 and Step 6, locate the corresponding Vibe
directory and open the tomcat\conf\server.xml filein atext editor.

8 Locatethe <Engine...> element and modify the value of the jvmRoute attribute to the value of
the worker that you used in the workers .properties file.

For example, the modified <Engine. . .> XML element for the Vibe node that corresponds to
workerl should look like this:

<Engine name=“Catalina” defaultHost=“localhost” jvmRoute=“workerl”>
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Repeat this step for each Vibe node.

9 Locatethec:\Program Files\Novell\Vibe IIS
Plugin\resourcesl\conf\uriworkermap.properties file then openthefilein atext
editor.

10 Replaceal instances of worker1 withbalancer.
11 Repeat Step 9 and Step 10 for each Vibe node.

12 Locatethec:\Program Files\Novell\Vibe IIS
Plugin\resources2\conf\uriworkermap.properties file then open thefilein atext
editor.

13 Replace all instances of worker1 with balancer.

14 Repeat Step 12 and Step 13 for each Vibe node.

15 Restart each Vibe node.

16 Restart the l1S server:
16a Click Sart > Administrative Tools > Internet Information Services (11S) Manager.
16b Select your server in the Connections panel, then click Restart in the Actions panel.

9.11 Configuring Mirrored Folder Resource
Drivers

A mirrored folder is adirectory, either local or shared on a SAN (storage area network), that is
directly accessible from the Novell Vibe site. The files on the file system are accessed by the Novell
Vibe program through aresource driver, not directly by individual Vibe users. A resource driver
defines how the Vibe program accesses the file system.

During installation, you define the users and groups that can access the mirrored folder resource
drivers. After installation, from the Vibe site, you associate resource drivers with specific Vibe
folders and use folder access controls to govern which users and groups can access the datain the
mirrored folder. Asaresult, you can set up asmall number of userswho can create mirrored folders,
and allow alarger number of usersto access the mirrored folders.

Vibe attempts to keep the metadata about each mirrored folder synchronized with the contents of the
actual file system. Therefore, mirrored folders are most appropriate for large sets of relatively static
data. Mirrored folders are also useful for making extremely large files available from your Vibe site
without including them in the Vibe file repository.

Although the installation program allows you to set up three mirrored folder resource drivers during
installation, you can set up and test just one to start with, then set up additional resource drivers|ater.
+ Section 9.11.1, “File System Type,” on page 104
+ Section 9.11.2, “File System Directory,” on page 104
+ Section 9.11.3, “File System Access,” on page 104
+ Section 9.11.4, “Mirrored Folder Setup,” on page 105
After planning mirrored folders, complete the planning process for additional Advanced installation

features as needed, then perform the Advanced installation as described in Chapter 10, “ Performing
an Advanced Vibe Installation,” on page 107.
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9.11.1 File System Type

Vibe provides resource drivers for two different types of file systems:

+ file: A directory in aregular file system on aLinux or Windows server.

+ webdav: A directory on a Web server that supports WebDAV (Web-based Distributed
Authoring and Versioning). The WebDAV server must support HTTP Basic Authentication
(http://en.wikipedia.org/wiki/Basic_access authentication) so that Vibe can provide a
username and a password when making a request from the WebDAV server.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, mark the type of directory that you want to mirror
in your Vibe site.

9.11.2 File System Directory

Thefile system that a Vibe mirrored folder uses can be on Linux, NetWare, or Windows, as long as
the following conditions are met:

+ Thefile system is accessible from the Vibe server by using adirectory path specification that
the Vibe server operating system understands.

+ Thefile system is accessible through the standard java . io package interface.

IMPORTANT: On Windows, you must use forward slashes (/) in the pathname, not the typical
Windows backslashes (\). For example, use c : /Document s rather than c: \Documents.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, specify the full path for the directory that you want
to mirror in your Vibe site. Also, provide a title for the mirrored folder resource driver that indicates what

directory or data is being mirrored. For WebDAV mirrored folders, you must also specify the URL of the

WebDAV host where the data is located.

If you need to eventually set up morethan three directories as mirrored foldersin your Vibe site, you
can edit the installer.xml filein the directory where you run the Installation program.

9.11.3 File System Access

Vibe offers several security options for controlling access to the data that resides on the file system.
+ You can restrict the Vibe program to read-only access to the mirrored data, or you can alow
full read/write access.

+ You can list specific Vibe users who are allowed to access the mirrored folder resource drivers
and thereby create mirrored folders.

+ You can list specific Vibe groups whose members are allowed to access the mirrored folder
resource drivers and thereby create mirrored folders.

+ For WebDAV mirrored folder resource drivers, you must also specify a username and password
that the Vibe program can use to access the WebDAV server.

104 Novell Vibe OnPrem 3 Installation Guide


http://en.wikipedia.org/wiki/Basic_access_authentication

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, list the file access (read/write or read-only) for the
mirrored data, along with users and groups that you want to have access to the resource driver. For a
WebDAV mirrored folder, list a username and password that provides access to the WebDAV server.

9.11.4 Mirrored Folder Setup

After you run the Vibe Installation program to configure the Vibe site for mirrored folder resource
drivers, additional folder setup isrequired. Follow the instructionsin “ Setting Up Mirrored Folders’
in “Site Setup” inthe Novell Vibe OnPrem 3 Administration Guide.

9.12 Installing the Vibe Software in a Clustered
Environment

You must use an Advanced installation in order to install the Novell Vibe software on multiple
servers and set up a clustered environment. Setting up multiple Vibe servers, along with other
clustering options, are described in Chapter 15, “Running Vibe on Multiple Servers,” on page 127.
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Performing an Advanced Vibe
Installation

You should aready have reviewed Chapter 3, “Planning aBasic Vibe Installation,” on page 25 and
filled out the Basic Vibe Installation Summary Sheet. You should also have reviewed Chapter 9,
“Planning an Advanced Vibe Installation,” on page 81 and filled out the Advanced Vibe Installation
Summary Sheet for those aspects of an Advanced installation that you want to implement for your
Novell Vibe OnPrem site.

1 Follow the Basic installation instructions provided in Chapter 4, “Installing and Setting Up a
Basic Vibe Site,” on page 49 for the platform where you are installing Vibe.

2 When you run the installation program, select Advanced on the Choose I nstallation Type page.

Choose Installation Type

Select the type of installation you want to perform

Select the Advanced installation if you want te configure any
of the opticnal features.

3 Usetheinformation that you have gathered on the Basic Vibe Installation Summary Sheet and
the Advanced Vibe Installation Summary Sheet to provide the information that the Vibe
Installation program prompts you for:

Basic Installation Pages:

Installation Locations

Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Vibe

User ID for Novell Vibe (Linux only)

Network Information

Database Selection

Java JDK Location

Outbound E-Mail Configuration

Inbound E-Mail Configuration

Some Basic installation pages have additional options available when you perform an
Advanced installation.

Advanced Installation Pages:

Web Services

Lucene Configuration

RSS Configuration

Presence Configuration

Reverse Proxy Configuration

Integration with 11S for Windows Authentication
Mirrored Folder Resource Driver Configuration
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Vibe Cluster Configuration

The Installation program stores the information it gathersinthe installer.xml filein the
same directory where you started the Installation program.

4 After you have provided all the requested information, click Install to begin the Advanced
installation.

5 When theinstallation is complete, click Finish to exit the Vibe installation program.

Information about the installation process is written to the installer. log filein the same
directory where you ran the Installation program. If a problem arises during the installation, the
installer.log file providesinformation that can help you resolve the problem.

6 After you complete the Advanced installation, continue setting up your Vibe site, as described
in Chapter 5, “Adding Usersto Your Vibe Site,” on page 63.
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Setting Configuration Options
after Installation

After you install Novell Vibe OnPrem, following the instructionsin Part 11, “Basic Installation,” on
page 23 or Part |11, “ Advanced Installation and Reconfiguration,” on page 79, you can rerun the
Vibeinstalation program to change configuration options or add new functionality to your Vibe site.

1 Stop Vibe.

2 Start the Vibeinstallation program as described in Section 4.1.3, “ Running the Linux Vibe
Installation Program,” on page 51 and Section 4.2.2, “Running the Windows Vibe Installation
Program,” on page 58.

x| Novell Vibe 3 Installation/Program _ x|

Installation Options

Select the action you want to perform.

" New installation
" Update software and settings

f+ Reconfigure settings

Because the Installation program finds an existing installer.xml file, it defaultsto
Reconfigure settings.

3 Click Next.
The Vibe Installation program asks you to verify that you have stopped Vibe.
4 Click Yes.

Novell Vibe3 Installation/Program

Choose Installation Type

Select the type of installation you want to perform

Basic

of the optional features.

Select the Advanced installation if you want to configure any

5 Select Basic or Advanced, depending on the configuration settings that you want to change,
then click Next.

6 Click Next until you reach an installation page where you want to reconfigure settings.
Basic I nstallation Pages:
Installation Locations
Location of TrueType Fonts for Stellent Converters

Default Locale for Novell Vibe
User ID for Novell Vibe (Linux only)
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Network Information

Database Selection

Java JDK Location

Outbound E-Mail Configuration
Inbound E-Mail Configuration

Advanced Installation Pages:

Web Services

Lucene Configuration

RSS Configuration

Presence Configuration

Reverse Proxy Configuration

Integration with 1S for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration

7 When you reach the Ready to Install page, click Install to implement the reconfigured settings.
8 Start Vibe.
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Advanced Vibe Installation
Summary Sheet

Installation Program Field

Value for Your Vibe Site

Explanation

Data Locations:

Linux default:

/var/opt/novell/teaming

Windows default:

c:\Novell\Teaming

*

Simple file repository
Jackrabbit repository
Extensions repository
Archive store

Cache store

Lucene index

See Section 9.2, “Distributing
Different Data Types to Different
Locations,” on page 82.

Network Information:

*

*

Enable Web services:

No / Yes

Session timeout

Default: 240 minutes
Enable Tomcat access log:
No / Yes

Keystore file:

See Section 9.3, “Using
Advanced Network Information
Settings,” on page 83.

Web Services:

Enable WSS authentication
Enable Basic authentication

Enable token-based
authentication

Enable anonymous access

See Section 9.4, “Configuring
Web Services,” on page 84.
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Installation Program Field

Value for Your Vibe Site

Explanation

Lucene Configuration:
Configuration type: all
+ Max booleans:

Default: 10000
+ Merge factor:
10

See Section 9.5.2, “Changing
Lucene Configuration Settings,”
on page 86.

Server Lucene Configuration:

Configuration type: server only

+ Host:
* RMI port:
Default: 1199

See Section 9.5.3, “Running the
Lucene Index Server in Its Own
JVM,” on page 86.

High Availability Lucene
Configuration:

Configuration type: high
availability only

Number of high availability search

nodes:

+ Service name:
* Service title:
¢ Host:

* RMI port:

+ Service name:
* Service title:
¢ Host:

* RMI port:

See Chapter 16, “Running
Multiple Lucene Index Servers,”
on page 131.

RSS Configuration:
Enable RSS: No/ Yes

* Max elapsed days:

+ Max inactive days:

See Section 9.6, “Managing RSS
Feeds,” on page 87.

Presence Configuration:
Enable presence: No / Yes

+ Server address:
+ Port:

* Server user:

+ Password:

+ Server Certificate:

See Section 9.7, “Configuring
Presence,” on page 87.
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Installation Program Field Value for Your Vibe Site

Explanation

Conferencing Configuration:
Enable Conferencing: No / Yes

+ Conferencing URL:

See Section 9.7, “Configuring
Presence,” on page 87.

Reverse Proxy Configuration:

Enable Access Gateway: No /
Yes

* Access Gateway
address(es):
* Logout URL:

+ Use Access Gateway for
WebDav connections: No /
Yes

* WebDAV Access
Gateway address:

See Section 9.9, “Configuring
Single Sign-On with Novell
Access Manager,” on page 89.

Integration with IIS for
Windows Authentication:

Enable Integration with 1IS for
Windows Authentication: No / Yes

* [IS address(es):

+ Logout URL:

See Section 9.10, “Configuring
Single Sign-On with Internet
Information Services for
Windows,” on page 90.

Mirrored Folder Resource
Driver Configuration:

Enable file share: No / Yes

* Share type

+ File

¢+ WebDav
+ Read only: No/ Yes
* Title
+ Root path
+ Allowed users
+ Allowed groups
* User
+ Password
¢ Host URL

See Section 9.11, “Configuring
Mirrored Folder Resource
Drivers,” on page 103.
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Multi-Server Configurations and
Clustering

*

*

*

*

*

Chapter 13, “
Chapter 14, “
Chapter 15, “
Chapter 16, “
Chapter 17, “

Creating the Vibe Database on a Remote Server,” on page 117
Installing the Lucene Index Server on a Remote Server,” on page 123
Running Vibe on Multiple Servers,” on page 127

Running Multiple Lucene Index Servers,” on page 131

Running Multiple Database Servers,” on page 149
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Creating the Vibe Database on a
Remote Server

The default database location for Novell Vibe OnPrem is on the same server with the Vibe software,
as described in Section 3.6.3, “Database L ocation,” on page 34. However, for better performance
and scalability, you can install the database server (MySQL, Microsoft SQL, or Oracle) on aremote
server, then use the scripts that are included with the Vibe software to manually create the Vibe
database in any location that you prefer.

+ Section 13.1, “Preparing to Manually Create a Database,” on page 117
Section 13.2, “Creating a MySQL Database,” on page 118
Section 13.3, “Creating a Microsoft SQL Database,” on page 119
Section 13.4, “Creating an Oracle Database,” on page 120

Section 13.5, “Installing Vibe with a Remote Database,” on page 121

*

*

*

*

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructionsin Part |1, “Basic Installation,”
on page 23 before attempting a more complex Vibe configuration.

13.1 Preparing to Manually Create a Database

Novell Vibe includes scripts for creating the Vibe database on a remote server.
1 Copy the teaming-3.0.n-sql.zip file from the Vibe server where the Vibe installation
program is located and copy it to the database server.
or
Download and unzip the Vibe software onto the database server.

2 Inthedirectory where the Vibe Installation program is located on the database server, or in the
location where you copied the teaming-3.0.n-sql.zip file, unzip the teaming-3.0.n-
sql.zip file.

This creates two new subdirectories, the create subdirectory for database creation scripts and
theupdate-2.1.n-3.0.n directory for database update scripts.

3 Changeto the create subdirectory.

4 Copy dl the scripts for your database type to a convenient temporary location on the server
where you want to create the database, and make sure that your database management utility is
on your path so that you can run it from that directory

Database Database Script Database Management Utility
MySQL *mysqgl.sql mysqgl

Microsoft SQL *gglserver.sql osqgl

Oracle *oracle.sqgl sqglplus
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5 Continue with the instructions for the type of database that you want to create:
+ Section 13.2, “Creating aMySQL Database,” on page 118
+ Section 13.3, “ Creating a Microsoft SQL Database,” on page 119
+ Section 13.4, “ Creating an Oracle Database,” on page 120

13.2 Creating a MySQL Database

Before you begin, you should be familiar with standard database maintenance procedures.
For more information about MySQL, see the following references:

+ MySQL 5.0 Reference Manual (http://dev.mysqgl.com/doc/refman/5.0/en)
+ MySQL 5.1 Reference Manual (http://dev.mysqgl.com/doc/refman/5.1/en)

The following database tools can be helpful:

+ MySQL GUI Tools (http://dev.mysgl.com/downl oads/gui-tool s)

+ SQLyog (http:/mww.webyog.com)

+ Squirrel SQL Client (http://squirrel-sgl.sourceforge.net)

1 Review the MySQL requirements listed in Section 2.1, “Vibe Server Regquirements,” on

page 17.

2 Make surethat the MySQL database server and client have been installed and configured, as
described in Section A.2, “MySQL Database Server,” on page 185.

3 Make surethat the MySQL database client is also installed on the Vibe server.

The Vibe installation program needs the MySQL client in order to communicate with the
remote MySQL database server.

4 Make sure that you know the password for the MySQL root administrator user.
5 Make surethat innodb support is enabled.
It is enabled by default. To verify that innodb support is enabled:
5a Enter the following command to access the MySQL monitor:
mysql -u root -p

For information on how to set a password for your MySQL database if you have not
already done so, see “Configuring MySQL” on page 186.

5b  Specify your password.

5¢ From the mysqgl prompt, enter the following command to display status information about
the server’s storage engines:

SHOW ENGINES\G
5d Locatethe InnoDB engine, and ensure that innodb support is enabled.
6 Update the MySQL configuration file:
6a Locatethe MySQL configuration file and open it in atext editor.

Linux: /etc/my.cnf

Windows: c¢:\Program Files\MySQL\MySQL Server version\my.ini
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6b Under the [client] section, add the following line:
default character set = utfs

6¢ Under the [mysqld] section, add the following line:
character set server = utfs8

Setting the character set to UTF-8 ensures that extended characters are handled correctly
in the database.

6d (Conditional) For a system with multiple network interfaces, under the [mysqld] section,
add the following line:

bind-address = mysgl server address

Replace mysgl server address with the IP address that you want MySQL to bind to
and to listen on.

6e Savethe updated configuration file, then exit the text editor.

7 Inthe directory where you copied the database scripts (Step 4 in Section 13.1, “Preparing to
Manually Create a Database,” on page 117), enter the following command to run the MySQL
database creation script:

mysgl -uuser -ppassword < create-database-mysqgl.sqgl
8 Configure MySQL to allow access from aremote server:

mysql -uuser -ppassword

mysqgl> grant all privileges on *.*
-> to 'username'@'%'
-> identified by 'password'
-> with grant option
->

9 Skipto Section 13.5, “Installing Vibe with a Remote Database,” on page 121.

13.3 Creating a Microsoft SQL Database

Before you begin, you should be familiar with standard database maintenance procedures.
For more information about Microsoft SQL, see the following references:

+ Microsoft SQL Server 2008 Learning Resources (http://www.microsoft.com/sqgl server/2008/
en/us/learning.aspx)
+ Microsoft SQL Server 2005 Learning Resources (http://www.microsoft.com/sqgl server/2005/
en/us/learning-resources.aspx)
The following database tool can be helpful:
+ Squirrel SQL Client (http://squirrel-sgl.sourceforge.net)

1 Review the Microsoft SQL requirementslisted in Section 2.1, “Vibe Server Regquirements,” on
page 17.

2 Make sure that the Microsoft SQL Server and Client have been installed and configured
properly.

IMPORTANT: Make surethat TCP/IP is enabled for the Microsoft SQL Server.

For more information, see Microsoft SQL Server (http://msdn.microsoft.com/en-ug/library/
bb545450.aspx).
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3 Make sure that the Microsoft SQL database client is also installed on the Vibe server.

The Vibe installation program needs the Microsoft SQL client in order to communicate with
the remote Microsoft SQL database server.

4 When you install Microsoft SQL Server, select SQL Server and Windows for authentication.
The default is Windows Only, which is not appropriate for Vibe

5 Immediately establish the database administrator username and password for the SQL database
server.

6 Change to the directory where you copied the database scriptsin Step 4 in Section 13.1,
“Preparing to Manually Create a Database,” on page 117.

7 Enter the following command to run the Microsoft SQL database creation script:

osqgl -Uuser -Ppassword -i create-database-sglserver.sql

8 Skipto Section 13.5, “Installing Vibe with a Remote Database,” on page 121.

13.4 Creating an Oracle Database

When you use an Oracle database, your database administrator must create it for you. The Novell
Vibe installation program cannot create an Oracle database.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Creation, make sure you have marked that you want your database administrator to
manually create the Oracle database before installation.

Bfore you begin, you should be familiar with standard database maintenance procedures.
For more information about your Oracle database, see the following reference:

+ Oracle Product Documentation (http://www.oracle.com/technol ogy/documentation)
+ Oracle SQL Plus Documentation (http://www.oracle.com/technology/docs/tech/sgl_plus)

The following database tool can be helpful:
+ Squirrel SQL Client (http://squirrel-sgl.sourceforge.net)

1 Review the Oracle database requirementslisted in Section 2.1, “Vibe Server Requirements,” on
page 17.
2 Make sure that the Oracle database server software has been installed and configured properly.

For more information, see Oracle Database (http://www.oracle.com/database).
3 Set up the Oracle database character set to support Unicode character encodings.

Vibe requires either the UTF-8 or AL32UTRF8 character set for proper operation. Oracle
recommends the use of AL32UTF8, because it has increased support for certain Asian
languages. For more information, see Choosing a Character Set (http://download.oracle.com/
docs/cd/B19306_01/server.102/b14225/ch2charset.htm) in the Oracle Database Globalization
Support Guide.

4 Changeto the directory where you copied the Oracle database scriptsin Step 4 in Section 13.1,
“Preparing to Manually Create a Database,” on page 117.

5 Edit the create-database-oracle.sqgl script with your Oracle database password.
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Original:

drop user sitescape cascade;

create user sitescape identified by sitescape;
grant connect, resource to sitescape;

connect sitescape/sitescape;

SiteScape is the name of the company that previously owned the Vibe software.
Updated:

drop user sitescape cascade;

create user sitescape identified by your oracle password;
grant connect, resource to sitescape;

connect sitescape/your oracle password;

IMPORTANT: Unlessyou are very familiar with editing scripts, change only the password.
Do not attempt to change the name of the database from the legacy default of sitescape.

6 Enter the following commands to run the database creation script:

sglplus "/ as sysdba"

SQL> spool create-database-oracle.out;
SQL> @create-database-oracle;

SQL> quit

7 Check theresulting create-database-oracle.out filefor errors and resolve them.

8 If you created the Oracle database on the Vibe server, skip to Chapter 4, “Installing and Setting
Up aBasic Vibe Site,” on page 49 or Chapter 10, “ Performing an Advanced Vibe Installation,”
on page 107.

IMPORTANT: On the Database Selection page in the Installation program, be sure to select
Database already exists or has already been created.

or

If you created the Oracle database on a remote server, continue with Installing Vibe with a
Remote Database.

13.5 Installing Vibe with a Remote Database

1 Runthe Novell Vibeinstallation program, as described in Chapter 4, “Installing and Setting Up
aBasic Vibe Site,” on page 49 or Chapter 10, “Performing an Advanced Vibe Installation,” on
page 107.

2 Fill inthefields on the Database Selection page:

Creating the Vibe Database on a Remote Server 121



Novell Vibe 3iInstallation Program

Database Selection

Select your database and set the database options.

The database server you select must already be installed.

Database type: |MySql j
JDBC URL: |jdbc:mysql:/localhost:3306/sitescape?usel nicode=truedcharacterEncoc

rCredential

Usemname: roct

Password:

~Setup
" Create the database during installation

* Database already exists or has already been created

~Encryption algorithm

User passwords are encrypted using the selected algerithm:

ST

Database type: Select the type of database that you just created.

JDBC URL: Replace 1ocalhost with the hosthame of the server where you created the Vibe
database.

For an Oracle database, the information in this field should look something like this:

jdbc:oracle:thin:@hostname:port:database name
Credentials. Specify the password for the database administrator user.

Setup: Select Database already exists or has already been created so that the installation
program does not create one for you.

Encryption algorithm: Set the encryption appropriate for the security needs of the Vibe site.
For more information, see Section 3.6.5, “ Database Encryption Algorithm,” on page 36.

3 Click Next.

The Vibe installation program tries to connect to the database. If it connects successfully, you
can continue with the installation. If the Vibe installation program cannot connect to the
database, you must resolve the problem with the database before you can continue with the
Vibe installation.

4 When the Vibe installation program can successfully connect to the remote database, continue
as usual with the installation.

122 Novell Vibe OnPrem 3 Installation Guide



Installing the Lucene Index Server
on a Remote Server

You can install the Lucene Index Server on adifferent server from where Novell Vibe OnPremis
running. If the Lucene Index Server is aready running on the same server as Vibe, you can move the
Lucene Index Server to adifferent server.

Running the Lucene Index Server on aremote server alows both the Lucene Index Server and the
Vibe server to have access to more server memory, disk space, and CPU resources.

Complete the following sections whether you are installing the Lucene Index Server on aremote
server, or moving the Lucene Index Server to aremote server.

IMPORTANT: The Vibe server and the Lucene Index Server must not have a firewall between
them. The RMI protocol used for the Lucene Index Server port works only within atrusted local
area network (LAN).

+ Section 14.1, “Installing the Lucene Software,” on page 123
+ Section 14.2, “Updating Your Vibe Site,” on page 124
+ Section 14.3, “Managing a Remote L ucene Index Server,” on page 125

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructionsin Part |1, “Basic Installation,”
on page 23 before attempting a more complex Vibe configuration.

14.1 Installing the Lucene Software
1 Make surethat a supported Java Developer Kit (JDK) isinstalled on the remote server where
you want to install the Lucene Index Server.
For instructions, see Appendix A, “Vibe System Requirements Assistance,” on page 183.
2 Make surethat thereis no firewall between the Vibe server and the Lucene Index Server.

3 Copy the Lucene installation program from its original location in the same directory with the
Vibe installation program to a convenient temporary directory on the remote server.

The filename for the Lucene Installation program varies by platform:

Linux: lucene-installer.linux

Windows: lucene-installer.exe

Change to the directory where you copied the Lucene installation program, then start it.
Accept the License Agreement, then click Next.
Select New installation, then click Next.

Browse to and select the directory where you want to install the Lucene Index Server, then
click Next.

~N o o b~
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The default location varies by platform:

Linux: /opt/novell/teaming/luceneserver

Windows: c¢:\Program Files\Novell\Teaming\luceneserver

8 Browseto and select the directory where you installed the JDK, then click Next.

9 Adjust the configuration of the Lucene Index Server, as described in Section 9.5, “Changing
Your Lucene Index Server Configuration,” on page 85, then click Next.

10 Click Install to install the Lucene software.
11 (Conditional) On Linux, deselect Sart Lucene server.

You must edit the Lucene Index Server startup script before you start the Lucene Index Server.
Instructions are provided later in this procedure.

12 (Conditional) On Windows, if you do not want to start the Lucene Index Server immediately,
deselect Sart Lucene server.

For instructions for starting and stopping the Lucene Index Server manually, see Section 14.3,
“Managing a Remote Lucene Index Server,” on page 125.

13 Click Finish.
14 (Conditiona) On Linux:
14a Changeto the following directory:
/opt/novell/teaming/luceneserver/indexserver/bin
14b Open the indexserver-startup.sh filein atext editor.
14c Add the following switch to the java launch command at the end of the script:
-Djava.rmi.server.hostname=ip address

Rename ip address with the IP address of the server where you installed the Lucene
Index Server.

14d Savethe indexserver-startup. sh file, then exit the text editor.

14e Start the Lucene Index Server.
For instructions for starting and stopping the Lucene Index Server manually, see
Section 14.3, “Managing a Remote L ucene Index Server,” on page 125.

Moving the Lucene Index Server from the Vibe server to aremote server increases the scalability of
your Vibe system because the workload is distributed between two different physical servers.
However, in this configuration, the Lucene Index Server still runs on asingle server. Your Vibe site
depends on the Lucene Index Server for full functionality. If that server goes down for some reason,
the Vibe site becomes inaccessible until access to the Lucene Index Server is restored. You can
further expand your Vibe system by setting up multiple Lucene Index Serversto provide high
availability, as described in Chapter 16, “Running Multiple Lucene Index Servers,” on page 131.

14.2 Updating Your Vibe Site

Complete this section only if you are moving the Lucene Index Server. If you are performing afresh
Lucene Index Server installation, disregard this section.

1 Stop Novell Vibe.
2 Start the Vibe installation program to reconfigure the Lucene Index Server settings.
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For information on how to start the install ation program, see Section 4.1.3, “Running the Linux

Vibe Installation Program,” on page 51 or Section 4.2.2, “Running the Windows Vibe
Installation Program,” on page 58.

3 Onthe Choose Installation Type page, select Advanced, then click Next.
4 Click Next until you reach the Lucene Configuration page.

Novell Vibe 3/Installation Pragram:

Lucene Configuration

Use the following fields to configure the Lucene index. N

To run the Lucene index as a server, select Server from the drop-down list.

You can run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and ediit the RMI port if the default port cannot be used.

Max bocleans 10000
Merge factor 10
Lucene configuration type: local j

5 Inthe Lucene configuration type field, select server to activate additional fields.

Host: Specify the hostname of the server where you installed the Lucene Index Server
software.

RMI Port: Use the same port number that you used when you installed the L ucene Index
Server software. The default RMI port is 1199.

6 Click Next until you reach the Ready to Install page, then click Install.
7 When theinstallation is complete, click Finish.
8 Start Vibe.

14.3 Managing a Remote Lucene Index Server

+ Section 14.3.1, “Linux: Managing a Remote L ucene Index Server,” on page 125
+ Section 14.3.2, “Windows: Managing a Remote L ucene Index Server,” on page 125

14.3.1 Linux: Managing a Remote Lucene Index Server

Use the following commands to start and stop the Lucene Index Server manually:

/etc/init.d/indexserver start
/etc/init.d/indexserver stop

To configure the Lucene Index Server to start automatically when the Linux server reboots, use:

chkconfig --add indexserver

14.3.2 Windows: Managing a Remote Lucene Index Server

Use the following commands at a DOS command prompt to start and stop the Lucene Index Server
manually:

Installing the Lucene Index Server on a Remote Server 125



c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin\

indexserver-startup.bat

c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin\

indexserver-shutdown.bat

To configure the Lucene Index Server to start automatically when the Windows server reboots, you
can set it up as a scheduled task that runs at system startup.

1

o N o O

On the Windows server where the Lucene Index Server isinstalled, click Sart > All Programs
> Accessories > System Tools > Scheduled Tasks.

Double-click Add Scheduled Task. to open the Scheduled Task Wizard, then click Next to
continue.

Click Browse, then browse to and double-click the indexserver-startup.bat fileinthe
following directory:

c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin

In the Task name field, specify an informative name for the task, such as Lucene Index Server.
The default task name is the name of the batch file.

In the Perform this task field, select When my computer starts, then click Next.

Specify and confirm the Administrator password for the Windows server, then click Next.
Select Open advanced properties for thistask when | click Finish, then click Finish.

Verify that Run only if logged on is desel ected, then click OK.

A new task with the name you specified in Step 4 is added to the list in the Scheduled Tasks
window.

Click File> Exit to close the Scheduled Task Wizard.
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Running Vibe on Multiple Servers

By running Novell Vibe OnPrem on multiple servers, you can achieve high availability, including
failover and load balancing, depending on how you configure your servers. You must perform an
Advanced installation on each server in order to configure the Vibe software for such a clustered
environment.

+ Section 15.1, “Planning a M ulti-Server Vibe Configuration,” on page 127

* Section 15.2, “Installing the Vibe Software on Multiple Servers,” on page 128

+ Section 15.3, “ Configuring a Web Application to Provide High Availability Functionality for
Your Vibe Site,” on page 129

+ Section 15.4, “Configuring Internet Information Services to Support Multiple Vibe Servers,”
on page 130

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommended that you follow theinstructionsin Part 11, “Basic
Installation,” on page 23 before attempting a more complex Vibe configuration.

15.1 Planning a Multi-Server Vibe Configuration

+ Section 15.1.1, “Lucene Index Server Considerations,” on page 127
+ Section 15.1.2, “Vibe File Repository Considerations,” on page 127

15.1.1 Lucene Index Server Considerations

Before you can implement a multi-server Novell Vibe configuration, you must move your Lucene
Index Server away from theinitial Vibe server, as described in Chapter 14, “Installing the Lucene
Index Server on a Remote Server,” on page 123.

15.1.2 Vibe File Repository Considerations

Before you implement a multi-server Novell Vibe configuration, you must plan the Vibe file
repository for the clustered Vibe servers. Your configuration must comply with the following
restrictions:

+ TheVibefilerepository must be placed in a shared location that is accessible to each Tomcat
instance

+ All Tomcat instances must be configured with the same path leading to the shared storage

For background information on the contents of the Vibe file repository, see Section 9.2,
“Distributing Different Data Types to Different Locations,” on page 82.
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15.2 Installing the Vibe Software on Multiple
Servers

1 Update your existing Novell Vibe server to participate in a multi-server configuration:
la Stop Vibe.
1b Start the Vibe Installation program.

For information on how to start the installation program, see Section 4.1.3, “Running the
Linux Vibe Installation Program,” on page 51 or Section 4.2.2, “Running the Windows
Vibe Installation Program,” on page 58.

1c OntheInstallation Settings page, select Reconfigure Settings, then click Next.
1d On the Choose Installation Type page, select Advanced, then click Next.
le Click Next to proceed through the installation pages where no changes are needed.

1f (Conditional) If you do not have the Basic Vibe Installation Summary Sheet and
Advanced Vibe Installation Summary Sheet from theinitia Vibe server installation,
record the configuration of theinitial Vibe server as you proceed through the installation
pages.
Subsequent Vibe serversin the multi-server configuration must be installed with the same
configuration settings as the initial Vibe server.

1g Onthe Vibe Cluster Configuration page, specify the following information:

Enable clustered environment: Select this option to enable your environment for a
multi-server configuration.

Selecting this option configures Ehcache (http://ehcache.sourceforge.net) for your Vibe
cluster.

Network interface for distributed cache service: Specify the |P address or hostname of
the distributed cache service.

Multicast Group Address. (Optional) Specify the common multicast group | P address.
Each clustered node recognizes other nodesin the cluster by means of this |P address.

IMPORTANT: Make sure you specify the same IP address on all Vibe nodesin the
cluster. After you have set this |P address for each Vibe node, restart each nodein
succession, allowing each node to initialize before restarting the next.

The default multicast group IP addressis 232.0.0.1. If you have more than one clustered
Vibe system (for example, onein the lab and one in production), or if you have another
software product that is aready using the default multicast group I P address, you must
update thisfield for one installation so that it uses an |P address other than the default.

Use an IP address in the range of 224.0.0.1 to 239.255.255.255.

Multicast Group Port: (Optional) Specify the port number through which the Vibe nodes
will communicate.

Vibe Cluster Configuration

Selsct the checkbox to configure this Vibe installation to participate in a cluster.

~ Enable cluster ed environment

Network interface for distributed cache service (Optional: |P address or hostname expected)

HostName
Multicast Group Address (Ip Address): [232.0.0.1

Multicast Group Port: [4446
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1h On the Ready to Install page, click Install.
1i OnthelInstallation Complete page, click Finish.

2 Instal the Vibe software on each additional server, using the same installation settings that you
used for the initial Vibe server.

3 On each Linux server where you installed the Vibe software, set the multicast route to enable
the serversto function as a cluster:

3a Usethe following command on the command line to immediately set the multicast route
for the server:

route add -net 232.0.0.0/8 dev ethO

3b To run this command each time the server reboots, add the command to the following file
on each server:

/etc/init.d/boot.local
4 Start Vibe on each server, as described for the platform where you are installing Vibe:
+ Section 4.1.6, “ Starting Vibe on Linux,” on page 56
+ Section 4.2.3, “Running Vibe as a Windows Service,” on page 60
+ Section 4.2.4, “Running Vibe as a Windows Application,” on page 61

5 Continue with Configuring a Web Application to Provide High Availability Functionality for
Your Vibe Site.

15.3 Configuring a Web Application to Provide
High Availability Functionality for Your Vibe Site

After Novell Vibeisinstalled and running on multiple servers, you must provide additional software
to provide high availability functionality. Because Vibe is based on Tomcat, software that can
provide high availability for Tomcat can be used to provide high availability for your Vibe site.

1 Install and configure one of the following Web applications to provide high availability for
your Vibe site:
+ Apache Web server (http://www.apache.org)
¢ Linux Virtual Server (http://www.linuxvirtual server.org)
+ Novell Access Manager (http://www.novell.com/products/accessmanager)
+ Microsoft Internet Information Services (http://www.iis.net)

2 Configure the Web application to establish the Vibe site URL, which then stays constant for
Vibe users regardless of which Vibe server they access at any given time.

3 Start the Web application with its new configuration settings.
4 Test your Vibe site for high availability.

+ If you are using Apache Web server, Linux Virtual Services, or Microsoft Internet
Information Services, users can immediately log in to the Vibe site again after afailover
has occurred. The connection between the user’s browser and the Vibe site is maintained
as the failover occurs.

+ |If you are using Novell Access Manager, users must start a new browser session, then log
into the Vibe site after afailover has occurred. They cannot log in again from the same
browser session because the connection between the user’s browser and the Vibe site must
be reestablished after the failover.
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The following sections provide information for how to configure the Web applications:

+ Section 15.3.1, “ Configuring Tomcat and Apache as a L oad Balancer,” on page 130
+ Section 15.3.2, “Configuring Linux Virtual Server as al oad Balancer,” on page 130

15.3.1 Configuring Tomcat and Apache as a Load Balancer
If you are using Novell Access Manager as described in Section 9.9, “ Configuring Single Sign-On

with Novell Access Manager,” on page 89, you do not need to configure Tomcat and Apacheto load
bal ance as described in this section, because Access Manager provides this service.

NOTE: When you upgrade your Vibe system, these settings are not preserved. You must redefine
these settings each time you upgrade your Vibe system.

Consult the following online sources for instructions for setting up Tomcat and Apache as aload
balancer for your Novell Vibe site:

+ The Apache Software Foundation (http://httpd.apache.org/docs/2.2/mod/
mod_proxy_balancer.html)

+ The Apache Software Foundation (http://tomcat.apache.org/tomcat-6.0-doc/bal ancer-
howto.html)

15.3.2 Configuring Linux Virtual Server as a Load Balancer

Consult the following online sources for instructions for setting up Linux Virtual Server as aload
balancer for your Novell Vibe site:

¢ TheLinux Virtua Server Project (http://www.linuxvirtual server.org)
¢ Linux Virtual Server (LVS) Project (http://www.austintek.com/LV S)
¢ Linux Virtual Server Tutorial (http://www.ultramonkey.org/papers/lvs_tutorial/html)

15.4 Configuring Internet Information Services to
Support Multiple Vibe Servers

You can configure Internet Information Services (11S) to support multiple Novell Vibe servers. For
more information, see Section 9.10.9, “Configuring I1S to Load Balance in a Clustered
Environment,” on page 102.
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Running Multiple Lucene Index
Servers

Your Novell Vibe OnPrem site depends on the Lucene Index Server for full functionality. Different
L ucene configurations provide different levels of scalability and reliability.

You can instal the Lucene Index Server on a different server from where Vibe is running so that
both programs have access to more server memory, disk space, and CPU resources. However, the
Vibe server and the Lucene Index Server must not have afirewall between them. The RMI protocol
used for the Lucene Index Server port works only within atrusted local area network (LAN).

+ A Basicinstallation of Vibe places the Lucene Index Server on the same server where the Vibe
software isinstalled.

+ To provide additional memory for the Lucene Index Server, you might aready have configured
it to runinits own memory space, as described in Section 9.5.3, “Running the Lucene | ndex
Server in Its Own JVM,” on page 86.

+ To provide additional disk space and memory for the Lucene Index Server, you might already
have moved it to a different server, as described in Chapter 14, “Installing the Lucene Index
Server on a Remote Server,” on page 123.

These configurations provide additional resources for the Lucene Index Server, but it isstill asingle
point of failure for your Vibe site. If the Lucene Index Server goes down, the Vibe site becomes
inaccessible until access to the Lucene Index Server is restored.

Running multiple Lucene Index Servers provides high availability functionality, so that if one
Lucene Index Server goes down, Vibe users can still access the Vibe site because other Lucene
Index Servers are still available.

+ Section 16.1, “Planning a High Availability Lucene Configuration,” on page 131

+ Section 16.2, “ Setting Up a High Availability Lucene Configuration,” on page 132

* Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 144

+ Section 16.4, “ Synchronizing a High Availability Lucene Configuration,” on page 146

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructionsin Part |1, “Basic Installation,”
on page 23 before attempting a more complex Vibe and Lucene configuration.

16.1 Planning a High Availability Lucene
Configuration

A high availability Lucene Index Server configuration must include at least two different servers
(either physical or virtual), referred to as “nodes’ in the Vibe installation program. Lucene nodes in
ahigh availability configuration can be set up on Linux servers, Windows servers, or both.

Each Lucene node must have its own independent directory structure for index files. The default
location for the index files for the Lucene Index Server varies by platform:
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Linux: /var/opt/novell/teaming/lucene

Windows: c¢:\Novell\Teaming\lucene

Asyou plan your high availability Lucene configuration, you can use the Advanced Vibe
Installation Summary Sheet to record the options you want to use.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the number of Lucene nodes that you want in your
high availability Lucene configuration.

Each Lucene node needs a unique name, a descriptive title, and a static | P address. The name and
title identify the nodein the Vibe administrative interface. Typically, the Lucene Index Server listens
on RMI port 1199 on its server, but you can configure it to use a different port number if the default
port number is already in use.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the hame, description, IP address, and RMI port
number for each Lucene node.

If you have already accumulated index data on your initial Vibe server, you can choose to copy the
index files to the Lucene nodes, or you can reindex the Vibe site after the new Lucene nodes are
running. Depending on the amount of accumulated index data, reindexing can be a time-consuming
process.

The Vibe server and the Lucene nodes must not have a firewall between them. The RMI protocol
used for the Lucene Index Server port works only within atrusted local area network (LAN).

16.2 Setting Up a High Availability Lucene
Configuration

¢ Section 16.2.1, “Changing from a Local Lucene Index Server,” on page 132
+ Section 16.2.2, “ Changing from a Single Remote Lucene Index Server,” on page 135
+ Section 16.2.3, “ Expanding an Existing High Availability Lucene Configuration,” on page 138

+ Section 16.2.4, “Changing Your Lucene Configuration without Vibe Site Down Time,” on
page 140

16.2.1 Changing from a Local Lucene Index Server
To change from alocal Lucene Index Server running on the Novell Vibe server, you must install the

Lucene Index Server on two or more remote servers, then reconfigure Vibe for a high availability
Lucene configuration.
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NOTE: Although it is possible to use the Lucene Index Server on the Vibe server as one of the
“remote” Lucene nodes, thisis not arecommended configuration. Consider it only if you are
restricted to two servers for your Vibe site.

1 Set up two or more Lucene nodes:

la Install the Lucene Index Server on each node, as described in Section 14.1, “Installing the
L ucene Software,” on page 123.

1b (Optional) Copy accumulated index data from the initial Lucene Index Server to each
additional Lucene node.

The default location for the index files varies by platform:

Linux: /var/opt/novell/teaming/lucene

Windows: c¢:\Novell\Teaming\lucene

1c Start the Lucene Index Server on each Lucene node, as described in Section 14.3,
“Managing a Remote Lucene Index Server,” on page 125.

2 Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 15,
“Running Vibe on Multiple Servers,” on page 127, stop Vibe on all servers, or follow the
instructionsin Section 16.2.4, “Changing Your Lucene Configuration without Vibe Site Down
Time,” on page 140.

3 Runthe Vibeinstallation program to configure the Vibe server for multiple L ucene nodes:
3a Onthe Installation Settings page, select Reconfigure Settings, then click Next.
3b Onthe Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d Onthe Lucene Configuration page, fill in the following fields:
L ucene configuration type: Select high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where
you have installed and started the Lucene Index Server.

Novell/Vibe 3 Installation Program

Lucene Configuration

Use the following fields to configure the Lucene index N

To run the Lucene index as a server, select Server from the drop-down list.
You can run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannot be used.

Max bocleans 10000
Merge factor |10
Lucene configuration type: high availability j

Number of high availability search nodes:

3e Click Next.
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3f On the Configure High Availability Search Nodes page, specify the configuration
information for each L ucene node from the Advanced Vibe Installation Summary Sheet
that you filled out in Section 16.1, “Planning a High Availability Lucene Configuration,”
on page 131, then click Next.

Novell Vibe 3 Installation Pregram

Contigure High Availablity Search Nodes

Configure the high availability search nodes spesified in the previous panel N

Use the following fields to configure each high availability search node.
To remove one of the high available search nodes, unselect its "Keep" check box.

Enter the high availability service name, host name and ediit the RMI Port if the default port cannot
be used.

~High Availability Search Node
™ Keep Service name |LuceneLinux

Service title |Lucene on Linux
Host [172.16.5.2
RMI port [1199

~High y Search Node

¥ Keep Service name |LuceneWindows
Service title |Lucene on Windows
Host [172.16.5.19

RMI port [1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

Help < Back Next > Cancel

3g Click Next until you reach the Ready to Install page, then click Install.
3h Onthe Installation Complete page, click Finish.
3i Start Vibe.
3j (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:
4a Login tothe Vibe site as the Vibe administrator.
4b Click the Administration icon E
4c Under Search Index, click Nodes.
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Lucene on Linux (LuceneLinux)

Host 172.16.5.18
Rl port: 1198

User Mode Access
® Read and Write
O wirite Only
O No Access

Enahle Defarred Update Log

Mo Deferred Update Log Record Exists

Lucene on Windows {LuceneWindows)

Host 172.16.514
Rl port: 1198

User Mode Access
O Read and Write
@ wirite Only
O Mo Access

Enahle Defarred Update Log

Mo Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updatesit as new content is added to the Vibe site. By default, subsequent nodesin the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot accessit. This setting is useful when you need to perform maintenance on
aLucene node, but it is not the setting you want when you set up a new Lucene node.

4d Inthe User Mode Access box, select Read and Write for all Lucene nodes, click Apply,
then click Close.
The new setting is put into effect immediately, so that usersimmediately have access to
the additional Lucene nodes.

5 Skipto Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 144.

16.2.2 Changing from a Single Remote Lucene Index Server

To change from a single remote L ucene Index Server to a high availability configuration, you must
install the Lucene Index Server on one or more additional remote servers, then reconfigure Novell

Vibe for additional Lucene nodes.

1 Bring down your Vibe site:

la Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 15,
“Running Vibe on Multiple Servers,” on page 127, stop Vibe on all servers, or follow the
instructionsin Section 16.2.4, “ Changing Your Lucene Configuration without Vibe Site

Down Time,” on page 140.
1b Make sure that the existing remote Lucene Index Server also stops.
2 Set up one or more additional Lucene nodes:

2a Install the Lucene Index Server on each additional remote server, as described in
Section 14.1, “Installing the L ucene Software,” on page 123.
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2b (Optional) Copy accumulated index data from the initial remote Lucene node to each
additional Lucene node.

The default location for the index files varies by platform:

Linux: /var/opt/novell/teaming/lucene

Windows: c¢:\Novell\Teaming\lucene

2¢ Start the Lucene Index Server on each Lucene node, as described in Section 14.3,
“Managing a Remote Lucene Index Server,” on page 125, but do not bring up your Vibe
site.

3 Runthe Vibeinstallation program to configure the Vibe server for multiple L ucene nodes:
3a OntheInstallation Settings page, select Reconfigure Settings, then click Next.
3b Onthe Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d Onthe Lucene Configuration page, fill in the following fields:
L ucene configuration type: Change server to high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where
you have installed the Lucene Index Server.

NovelllVibe 3 Installation Program

Lucene Configuration

Use the following fields to configure the Lucene index

To run the Lucene index as a server, select Server from the drop-down list.
You can run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannct be used.
Max booleans |10000

Merge factor [10

Lucene configuration type: high availability =

Number of high availability search nodes:

3e Click Next.

3f On the Configure High Availability Search Nodes page, specify the configuration
information for each L ucene node from the Advanced Vibe Installation Summary Sheet
that you filled out in Section 16.1, “Planning a High Availability Lucene Configuration,”
on page 131, then click Next.
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Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel

Use tha following fields to configure sach high availability search node.

To remove one of the high availabl

Enter the high availability ser
used

Iligh Availability Search Node 1

Service title [Lucene on Linux
Host [172.16.5.2

RMI port [1199

e, host name and ediit the RMI Port if the default port cannot

High earch Node

v Keep Sarvi

Serv ucene on Windows

Host [172.16.5.19

RMI port [1199

IT you need more than 2
to select "< Dack” an

bilily search nodes, you will nesd
se the speoified number of nodes.

Help < Back Next >

Cancel

3g Click Next until you reach the Ready to Install page, then click Install.
3h Onthe Installation Complete page, click Finish.

3i Start Vibe.

3j (Conditiona) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:
4a Loginto the Vibe site as the Vibe administrator.

4b Click the Administration icon E
4c Under Search Index, click Nodes.

Lucene on Linux {LuceneLinuxj

Host: 172.16.5.18
Rl port: 1199

User Mode Access
® Read and write
O wirite Only
O Mo Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows {LuceneWindows)

Host: 172.16.5.18
Rl port: 1199

User Mode Access
O Read and write
® wirite Only
O Mo Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updatesit as new content is added to the Vibe site. By default, subsequent nodesin the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot accessiit. This setting is useful when you need to perform maintenance on
aLucene node, but it is not the setting you want when you set up a new Lucene node.

4d Inthe User Mode Access box, select Read and Write for all Lucene nodes.
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4e Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have accessto
the additional Lucene nodes.

5 Skipto Section 16.3, “ Testing Your Lucene High Availability Configuration,” on page 144.

16.2.3 Expanding an Existing High Availability Lucene
Configuration

After you have set up an initial high availability L ucene configuration, you can add additional
Lucene nodes at any time.
1 Bring down your Vibe site:
la Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 15,
“Running Vibe on Multiple Servers,” on page 127, stop Vibe on all servers, or follow the
instructionsin Section 16.2.4, “Changing Your L ucene Configuration without Vibe Site
Down Time,” on page 140.

1b Stop al Lucene nodes, as described in Section 14.3, “Managing a Remote L ucene Index
Server,” on page 125.

2 Set up one or more additional Lucene nodes:

2a Install the Lucene Index Server on each additional remote server, as described in
Section 14.1, “Installing the Lucene Software,” on page 123.

2b (Optional) Copy accumulated index data from an existing L ucene node to each additional
Lucene node.

The default location for the index files varies by platform:

Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene

2c Start the Lucene Index Server on each Lucene node, as described in Section 14.3,
“Managing a Remote Lucene Index Server,” on page 125, but do not bring up your Vibe
site.

3 Runthe Vibeinstalation program to configure the Vibe server for the additional Lucene nodes:
3a OntheInstallation Settings page, select Reconfigure Settings, then click Next.

3b Onthe Choose Installation Type page, select Advanced, then click Next.

3c Click Next to proceed through the installation pages where no changes are needed.

3d On the Lucene Configuration page, increase the number of nodes in the Number of high
availability search nodesfield, then click Next.
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NovellVibe 3 Installation Program

Lucene Configuration

Use the following fields to configure the Lucene index. N

To run the Lucene index as a server, select Server from the drop-down list.
You can run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannot be used.

Max bocleans |10000
Merge factor |10
Lucene configuration type: high availability =

Number of high availability search nodes:

3e On the Configure High Availability Search Nodes page, specify the configuration
information for each additional Lucene node, then click Next.

Novell'Vibe 3 Installation Program

Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel. N

Use the fallowing fields to configure each high availability search node.
To remove one of the high available search nodes, unselect its "Keep" check box.

Enter the high availability service name, host name and ediit the RMI Port if the default port cannot
be used.

RMI port 1199 ‘ N

rHigh Availability Search Node 2
¥ Keep Service name‘LuceneWindaws

Service title ‘Lucana on Windows

Host 172.16.5.19

RMI port 1199

High Availability Search Node
Iv Keep Service name‘

Servicetills‘

Husl‘

RMI port 1199

If you need more than 3 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3f Click Next until you reach the Ready to Install page, then click Install.

3g OntheInstalation Complete page, click Finish.
3h Start Vibe.

3i (Conditiona) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.

4 Configure the Vibe site for the additional Lucene nodes:
4a Login tothe Vibe site as the Vibe administrator.
4b Click the Administration icon E
4c Under Search Index, click Nodes.
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Lucene on Linux {LuceneLinuxj

Host: 172.16.5.18
Rl port: 1199

User Mode Access
® Read and write
O wirite Only
O Mo Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows {LuceneWindows)

Host 172.16.518
RMI part: 1133

User Mode Access
O Read and write
@ write Only
O noAeess

Enahle Deferred Update Log

No Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updatesit as new content is added to the Vibe site. By default, subsequent nodesin the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot accessit. This setting is useful when you need to perform maintenance on
aLucene node, but it is not the setting you want when you set up a new Lucene node.

4d Inthe User Mode Access box, select Read and Write for all Lucene nodes.
4e Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have accessto
the additional Lucene nodes.

5 Skipto Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 144.

16.2.4 Changing Your Lucene Configuration without Vibe Site
Down Time

Vibe site down time can be avoided only if you have installed the Vibe software on multiple servers,
as described in Chapter 15, “Running Vibe on Multiple Servers,” on page 127.

To change to a high availability Lucene configuration in a multiple Vibe server configuration:

1 Set up two or more Lucene nodes:

la Install the Lucene Index Server on each node, as described in Section 14.1, “Installing the
L ucene Software,” on page 123

1b Start the Lucene Index Server on each Lucene node, as described in Section 14.3,
“Managing a Remote Lucene Index Server,” on page 125.

2 Stop Vibe on one server.

The other Vibe serversremain in service for users and continue to communicate with the
original Lucene Index Server.

3 Runthe Vibeinstallation program on the Vibe server that you stopped to configure it for
multiple Lucene Index Servers:

3a Onthe Installation Settings page, select Reconfigure Settings, then click Next.
3b Onthe Choose Installation Type page, select Advanced, then click Next.
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3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields.
L ucene configuration type: Select high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where
you have installed the Lucene Index Server.

NovellVibe 3 Installation Program

Lucene Configuration

Use the following fields to configure the Lucene index N

To run the Lucene index as a server, select Server from the drop-down list.
You can run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannct be used.
Max booleans |10000

Merge factor [10

Lucene configuration type: high availability =

Number of high availability search nodes:

3e Click Next.

3f On the Configure High Availability Search Nodes page, specify the configuration
information for each L ucene node from the Advanced Vibe Installation Summary Sheet
that you filled out in Section 16.1, “Planning a High Availability Lucene Configuration,”
on page 131, then click Next.

Novell Vibe 3l Installation Program

Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel N

Use Lhe lollowing lields Lo conligure sach high availabilily search node.
To remove one of the high available scarch nedes, unselect its "Keop” check box.

Enter tha high availability service name, host name and adit the BMI Port if the default port cannat
be used,

High
~ Keep Service

Host [172.16.5.2

BMI pert 1100

High Search Nede
" Keep Senvice name Lucene Wincows
Service title |Lucene on Windows
Host [172.16.5. 10

RMI port [1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specitied number of nodes.

Help < Back Next > Cancel

3g Click Next until you reach the Ready to Install page, then click Install.
3h Onthe Installation Complete page, click Finish.
4 Start the reconfigured Vibe server.
5 Access the reconfigured Vibe server and prevent access to the additional Lucene nodes:

IMPORTANT: All Vibe servers must be reconfigured before any of them accessthe additional
L ucene nodes.

5a Log into the reconfigured Vibe server as the Vibe administrator, using the server
hostname rather than your Vibe site URL.

5b Click the Administration icon .
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5¢ Under Search Index, click Nodes.

Lucene on Linux {LuceneLinux)

Host 172.16.518
RMI part: 1133

User Mode Access
@ Read and Write
O write Only
O noAeess

Enahle Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (LuceneWindows)

Host: 172.16.5.18
Rl port: 1199

User Mode Access
O Read and write
® wirite Only
O Mo Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Wite access, meaning that Vibe
updatesit as new content is added to the Vibe site. By default, subsequent nodesin the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. When you set up a high availability Lucene configuration

without Vibe site down time, you need to prevent write access during the reconfiguration
process.

5d Inthe User Mode Access box, change Write Only to No Access for the additional Lucene
nodes.

5e Click Apply, then click Close.

The new setting is put into effect immediately, so that the reconfigured Vibe server does
not communicate with the additional Lucene nodes.

6 Reconfiguretherest of the Vibe servers:
6a Stop each Vibe server.
6b Repeat Step 3 to configure each Vibe server for the additional Lucene nodes.
6c Start each reconfigured Vibe server.
7 Access the reconfigured Vibe site and allow write access to the additional Lucene nodes:
7a Log into the reconfigured Vibe as the Vibe administrator.
7b Click the Administration icon .
7c¢ Under Search Index, click Nodes.
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Lucene on Linux {LuceneLinux)

Host172.16.519
RMI port: 1199

User Mode Access
® Read and Yirite
O write Only
O No Access

[¥]Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (LuceneWindows)

Huost 137 65.67.222
RMI port: 1199

User Mode Access
© Read and irite
O write Only
© no Access

[¥]Enable Deferred Update Log

No Deferred Update Log Record Exists

7d Inthe User Mode Access box, change No Access to Write Only for the additional Lucene
nodes.

7e Click Apply, then click Close.

The new setting is put into effect immediately, so that the reconfigured Vibe servers can
now communicate with the additional Lucene nodes, although user accessis till
disallowed.

8 Reindex the Vibe site, so that the additional Lucene nodes are updated with the same index data
that the original Lucene Index Server has:

8a On the Administration page, under Management, click Search Index.

Manage Search Index | &

Select the Places to he Re-Indexed:
(Selecting a folder or waorkspace will automatically index all folders and workspaces within i)

O = [=lHome workspace

“lUsers and Groups

O
(] <{Global Workspaces

(] “IPersanal Workspaces

O = g Tesmworispaces

Select the Nodes to Apply the Re-Indexing to:

If re-indexing all or large part of the tree, it is strongly recommended to change the access mode of the node(s) to write-only befare starting
re-indexing so that all read requests can go to the other unselected node(s) while re-indexing is in progress. At least one node must allow

read-write at any given time. Once re-indexing is completed, change the access mode of the node(s) back to read-write 5o that search
requests can use them again.

[ Lucene an Linux flucenelinuy - Read and Write, Deferred Update Log Enabled, No Deferred Undate Log Recard Exists
[ Lucene onWindows ({lucenewindows) - Wirite Cnly, Deferred Update Log Enabled, Mo Deferred Update Log Record Exists

8b On the Manage Search Index tab, select Home Workspace, so that the entire Vibe siteis
reindexed.

8c Select the additional Lucene nodes, but do not select any previously existing nodes.
8d Click OK to start the indexing.
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Depending on the size of your Vibe site, reindexing can be a time-consuming process.
However, because one or more previously existing Lucene Index Servers are still
servicing the Vibe site, users are not affected by the reindexing process.

8e When the reindexing is completed, click Close.
9 Makethe additiona Lucene nodes available to Vibe users:
9a On the Administration page, expand Mange the Search Index, then click Nodes.

Lucene on Linux {LuceneLinuxj

Host: 172.16.5.18
Rl port: 1199

User Mode Access
® Read and write
O wirite Only
O Mo Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows {LuceneWindows)

Host 172.16.518
RMI part: 1133

User Mode Access
O Read and write
@ write Only
O noAeess

Enahle Deferred Update Log

No Deferred Update Log Record Exists

9b Inthe User Mode Access box, change Write Access to Read and Write for the additional
Lucene nodes.

9c Click Apply, then click Close.

The new setting is put into effect immediately, so that Vibe users have additional Lucene
Index Servers available asthey use the Vibe site.

16.3 Testing Your Lucene High Availability
Configuration

When you first set up your high availability Lucene configuration, you can configure Novell Vibeto
write Lucene node information to the Tomcat log file so that you can observe the behavior of the

L ucene nodes. Then you can take nodes down and bring them up again to see the effect on your Vibe
site. This process helps you prepare for the situation where a L ucene node goes down unexpectedly
or you need to take one down on purpose, perhaps for maintenance.

+ Section 16.3.1, “Configuring Vibe to Log Lucene Node Activity,” on page 145
+ Section 16.3.2, “ Observing Lucene Node Activity,” on page 145

NOTE: For background information about the Tomcat log file, see“Tomcat Log File” in “Site
Maintenance” in the Novell Vibe OnPrem 3 Administration Guide.
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16.3.1 Configuring Vibe to Log Lucene Node Activity

By default, Vibe writes an error to the Tomcat log file whenever it cannot communicate with a
Lucene node. For testing purposes, you can change the logging level so that the Tomcat log file
includes a message for each time Vibe contacts a Lucene Index Server.

After observing and understanding the behavior, you should return the logging to normal levels.

1 Openthelog4j.properties filein atext editor.
The location of the 1og4j . properties file varies by platform.

Linux: /opt/novell/teaming/apache-tomcat/webapps/ssf/WEB-INF

Windows: c¢:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB- INF

2 Search for the following line:
#log4j.category.com.novell.teaming. search=DEBUG

3 Remove the pound sign (#) from the beginning of the line to activate the DEBUG logging level
for the Lucene Index Server.

The DEBUG logging level adds a message for each time Vibe contacts a L ucene Index.
4 Savethelog4j.properties file, then exit the text editor.
5 Stop Vibe, then start Vibe to put the new logging level into effect.

16.3.2 Observing Lucene Node Activity

After changing the Vibe logging level to include L ucene node activity, you can monitor the Tomcat
log file to see which Lucene nodes Vibe is contacting.
1 Changeto the directory where the Tomcat log file is located.

For background information about the Tomcat log file, see “Tomcat Log File” in “Site
Maintenance” in the Novell Vibe OnPrem 3 Administration Guide.

2 OnLinux, usethe tail command to monitor the end of the Tomcat log file.
tail -f catalina.out
or

On Windows, download an equivalent command from the Internet in order to perform the
following steps.

For example, there is one available at SourceForge.net (http://sourceforge.net/projects/
tailforwin32).

3 Perform some activities on the Vibe site to create new content.

For example, you could create a blog entry. The Tomcat log file shows that Vibe is contacting
each available Lucene Index Server in turn asit submits the new information for indexing.
Nodes are considered available if they are marked Read and Write in the User Mode Access
box on the Lucene Nodes page.

4 Bring down one of the Lucene nodes.

For example, you might reboot the L ucene server, stop the Lucene Index Server on the node, or
otherwise prevent Vibe from contacting the L ucene node.
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5 Observe that the Tomcat log file displays an error when the Lucene node becomes unavailable.
6 Perform some additional activities on the Vibe site that create new content.

You might notice a pause as Vibe tries to connect with the L ucene node that is no longer
available.

7 Observe that the Tomcat log file shows when normal Vibe processing has resumed without
access to the unavailable Lucene node.

8 Make the unavailable Lucene node available again.

9 Observe that the Tomcat log file indicates that Vibe has created ajournal record on the Lucene
node that was temporarily unavailable.

The journal record contains the indexing operations that failed to take place while the Lucene
node was unavailable. Even though the L ucene node is back up, Vibe does not start accessing it
until it has been synchronized with the latest index information.

10 To synchronizethe out-of-date L ucene node, follow the stepsin Section 16.4, “ Synchronizing a
High Availability Lucene Configuration,” on page 146.

After the out-of-date L ucene node has been synchronized, Vibe starts accessing it again.
If asituation arises where no Lucene node is marked Read and Write in the User Mode Access box
on the Lucene Nodes page, Vibe temporarily accesses the first node in the list that is set to Write
Only. If no nodes are set to Write Only or Read and Write, Vibe temporarily access the first nodein

thelist, eventhoughiit is set to No Access. Thisfunctionality is required because you cannot log in to
the Vibe site without access to a Lucene Index Server.

16.4 Synchronizing a High Availability Lucene
Configuration

Whenever a Lucene node is down for arelatively short period of time (no more than one or two
days), you can synchronize it with other Lucene nodes whose index files are up-to-date.

1 Make sure that the out-of -date L ucene node is running reliably again.
2 Loginto the Novell Vibe site as the Vibe administrator.

3 Click the Administration icon E
4 Under Search Index, click Nodes.
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5 Torepair the out-of-date L ucene node, select Apply Deferred Update Log Records to the Index,
then click Apply.

The Deferred Update Log options disappear if the update is successful. If for some reason the
deferred update log records cannot be applied to the index, you can rebuild the index, as
described in “ Rebuilding the Lucene Index” in “ Site Maintenance” in the Novell Vibe OnPrem
3 Administration Guide.

6 Click Close.
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Running Multiple Database
Servers

Each of the three databases supported by Novell Vibe OnPrem (MySQL, Microsoft SQL, and
Oracle) hasits own approach to clustering the database server. I nformation about clustering database
serversis available on the Internet, for example:

+ MySQL Cluster (http://www.mysqgl.com/products/database/cluster)

+ SQL Server Clustering (http://www.sgl-server-performance.com/articles/clustering/
clustering_intro_pl.aspx)

+ Oracle Real Application Clusters (http://www.oracle.com/technol ogy/products/database/
clustering)

NOTE: We highly recommend that you follow the instructionsin Part |1, “Basic Installation,” on
page 23 before attempting a more complex Vibe configuration.
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Chapter 18, “What's New in Novell Vibe OnPrem 3,” on page 153

Chapter 19, “Updating from Novell Teaming 2.0 to Novell Vibe 3,” on page 155

Chapter 20, “Updating from Novell Teaming 2.1 to Novell Vibe 3,” on page 163

Chapter 21, “Migrating Existing Novell Vibe Datainto a New Vibe 3 System,” on page 171
Chapter 22, “Migrating from SiteScape Forum or Other Collaboration Software,” on page 179
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What’'s New in Novell Vibe OnPrem
3

Novell Vibe OnPrem 3 is the new name for the product formerly known as Novell Teaming. This
section describes new features that have been added to Novell Vibe since the previous version,
which was Novell Teaming 2.1.

+ Section 18.1, “Vibe 3 User Enhancements,” on page 153

+ Section 18.2, “Vibe 3 Installation Enhancements,” on page 153
+ Section 18.3, “Vibe 3 Administration Enhancements,” on page 153

18.1 Vibe 3 User Enhancements

For alist of Novell Vibe enhancements and instructions for use, see:

+ “What's New in Novell Vibe 3" in the Novell Vibe OnPrem 3 User Guide
+ “What's New in Vibe 3" in the Novell Vibe OnPrem 3 Advanced User Guide

18.2 Vibe 3 Installation Enhancements

+ Support for Windows Authentication: You can configure a single sign-on experience for
your users when you run Novell Vibe on a Windows server. For more information, see
Section 9.10, “Configuring Single Sign-On with Internet Information Services for Windows,”
on page 90.

18.3 Vibe 3 Administration Enhancements

+ Site-wide brand: You can create a site-wide brand and manage users' ability to create
individual brands on lower-level workspaces. For more information, see “Creating a Site-Wide
Brand” in the Novell Vibe OnPrem 3 Administration Guide.

+ Default home page: You can set adefault home page where all users arefirst taken when they
access the Novell Vibe site. You can create a separate default home page for visitors. For more
information, see “ Setting a Default Home Page” in the Novell Vibe OnPrem 3 Administration
Guide.

+ User and group management: When you move or rename users and groups that are being
synchronized via LDAP, Vibe now recognizes the change and maintains the association
between the user or group that was moved or renamed and the LDAP server. For more
information, see “LDAP Attribute to Identify a User” on page 42.

+ User Vigbility: You can hide one set of users from another set of users. For example, you
might want to do thisif your Vibe site has users from more than one company and you want
users to see only the users who belong to the same company. For more information, see
“Restricting Groups of Users from Seeing One Another” in the Novell Vibe OnPrem 3
Administration Guide.
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+ Integrationswith Novell M essenger: Vibe 3 provides tight integrations with Novell
Messenger, which allows Vibe users to see who is currently online. Presenceicons &2 are
located next to users' namesin folder entries.

Vibe administrators must configure Novell Messenger to work with Novell Vibe, as described
in “Integrating Messenger with Vibe" in the Novell Vibe OnPrem 3 Administration Guide.

+ Integrationswith Novell Conferencing: Vibe 3 provides tight integrations with Novell
Conferencing, which allows you to start an instant meeting with other Vibe users directly from
the Vibe interface.

Vibe administrators must configure Novell Messenger to work with Novell Conferencing, as
described in “ Integrating Conferencing with Vibe" in the Novell Vibe OnPrem 3
Administration Guide.

+ Expanded User Profile: The User Profile section in Vibe 3 has been expanded to rival other
professional knowledgebases such as Linkedln. Now users can include more information to
share with their colleagues, such as education, qualifications, and competencies. For more
information, see “Modifying Your Profile” in the Novell Vibe OnPrem 3 User Guide.

For information about how Vibe administrators can modify the information that is displayed in
the profile view, see “Resetting Your Profile View Definition” on page 169 .

If you have modified the User Profile definition for your Vibe site, these changes are not
displayed when you upgrade to Vibe 3. To display these changes, complete the stepsin “
Novell Vibe OnPrem 3 Administration Guide’ in the“ Novell Vibe OnPrem 3 Administration
Guide’.

+ Profile Quick View Dialog Box: The Profile Quick View dialog box is displayed when users
click auser’s Presenceicon & . It enables them to see information about that user, view the
user’s micro-blog or workspace, follow the user, and more.

For information about how Vibe administrators can modify the information that is displayed in
the Profile Quick View, see “Customizing the Default Profile Quick View” in the Novell Vibe
OnPrem 3 Administration Guide.

If you have modified the User Profile definition for your Vibe site, this dialog box is not
displayed when you upgrade to Vibe 3. To display these changes, complete the stepsin
“Resetting Your Profile View Definitions’ in the “Novell Vibe OnPrem 3 Readme”.

+ Ability to Send Vibe Mail M essages from a Custom Address: You can configure Vibe to
send e-mail messages and notifications from a zone-specific or site-wide address. In previous
versions of Vibe, when a user sends an e-mail message from Vibe, the message can be shown
only as being from that specific user.

For more information, see “Configuring Vibe to Send E-Mail Messages and Notifications from
a Custom Address’ in the Novell Vibe OnPrem 3 Administration Guide.
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Updating from Novell Teaming 2.0
to Novell Vibe 3

Novell Vibe OnPrem 3 is the new name for the product formerly known as Novell Teaming. This
section describes how to update to Novell Vibe 3 from Novell Teaming 2.0.
+ Section 19.1, “Understanding the Update Process,” on page 155
+ Section 19.2, “Updating a Single-Server System from Teaming 2.0 to Vibe 3,” on page 155
+ Section 19.3, “Updating a Multiple-Server System from Teaming 2.0 to Vibe 3,” on page 157
+ Section 19.4, “Performing Post-Update Tasks,” on page 159

19.1 Understanding the Update Process

When you upgrade to Novell Vibe 3, each user who has used a previous version of Vibe (previous
versions of Vibe are called Teaming) must clear his or her browser’s cache, regardless of which
browser he or sheis using. Not clearing the browser cache resultsin Vibe not displaying correctly.

Ensure that you communicate this to each Vibe user in your system.

During the update from Novell Teaming 2.0 to Vibe 3, the following aspects of your Vibe system are
modified:
+ The software is updated from Teaming 2.0 to Vibe 3.

+ The Vibe database is updated with a new database structure to support the new featuresin Vibe
3. All teams, groups, roles, workspaces, and folders are preserved throughout the update
process.

+ A backup copy of your existing Teaming 2.0 installation is created in the following directory:

Linux: /opt/novell /teaming/teaming-backup

Windows: C:\Program Files\Novell\Teaming\teaming-backup

19.2 Updating a Single-Server System from
Teaming 2.0 to Vibe 3

When you update asingle-server Novell Vibe installation from Teaming 2.0 to Vibe 3, the Vibe
Installation program can perform the entire update in a single process, unless the Vibe system uses
an Oracle database.

1 Make sure you have acurrent backup of your Teaming 2.0 system.

2 Stop Teaming.

3 (Conditional) If your Teaming 2.0 system uses an Oracle database, update the database as
described in Section 20.2.1, “Updating an Oracle Database from 2.1 to 3,” on page 164 before
running the Vibe 3 Installation program.
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4 Copy the installer.xml filefrom the directory where the Teaming 2.0 Installation program
is located to the directory where you have extracted the Vibe 3 software.

You must obtain anew license-key.xml file when upgrading to Vibe 3.

The installer.xml file provides default values when you run the Vibe 3 Installation
program.

5 Start the Vibe 3 installation program.

If you need assistance with this task, see the detailed installation instructions for the platform
where you are updating Vibe:

+ Section 4.1.3, “Running the Linux Vibe Installation Program,” on page 51
+ Section 4.2.2, * Running the Windows Vibe Installation Program,” on page 58
6 Accept the License Agreement, then click Next.

Novell'Vibe 3 Installation Program

Installation Options

Select the action you want to perform N

" New installation
* Update software and settings
" Reconfigure settings

Because you provided your Teaming 2.0 installer.xml filein the directory with the Vibe 3
installation program, the Update software and settings installation option is selected by default.

7 Click Next to continue.
8 Click Yesto let the Installation program know that you have stopped Vibe.

9 Select the check box to let the installation program know that you have backed up al of your
data, then click Next.

10 Select Basic or Advanced, depending on the type of Vibe installation you are updating, then
click Next.

11 Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 3 system.

12 Click Install when you are ready to perform the update.

The Installation program might seem to pause at this point. It needs to update tables and
indexes in the Vibe database. If you have alarge database, this process can be time-consuming.

13 Click Finish when the update is completed.
14 Sart Vibe 3 in the same way that you have been starting Teaming 2.0.
When you start Vibe for thefirst time after the update, it takes longer to start than usual because

datain the Vibe database must be updated before the Vibe site is ready to use.
19.2.1 Updating an Oracle Database from 2.0to 3

The Vibe Installation program can update MySQL and Microsoft SQL databases as part of the Vibe
software update, but it cannot update an Oracle database. Therefore, if you are using Oracle, you
must manually run the database update script after you have stopped Vibe.

1 Changeto the directory where the Vibe 3 Installation program is located.
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2

Unzip the teaming-3.0.n-sql.zip fileto create the update-2.0.0-2.1.0 and update-
2.1.0-3.0.ndirectories.

Theupdate-2.0.0-2.1.0andupdate-2.1.0-3.0.n directoriescontain aupdate scriptsfor
each type of database (MySQL, Microsoft SQL, and Oracle).

Run the update-oracle.sql script in each directory to update the database structure.

sqglplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle;
SQL>quit;

Return to Step 4 in Section 20.2, “Updating a Single-Server System from Teaming 2.1 to Vibe
3, on page 163.

19.3 Updating a Multiple-Server System from
Teaming 2.0 to Vibe 3

If your Novell Teaming 2.0 system is distributed across multiple servers, the Vibe 3 installation
program can update Vibe components on the Vibe server, but you must manually update any Vibe
components that you have placed on remote servers.

*

*

Section 19.3.1, “Manual Vibe Database Update,” on page 157
Section 19.3.2, “Manual Lucene Index Server Update,” on page 158

19.3.1 Manual Vibe Database Update

In order to update a database from Novell Teaming 2.0 to Novell Vibe 3 when the Vibe installation
program cannot do it for you, you must run the Vibe 3 database update script.

1
2
3

Stop Vibe.
Change to the directory where the Vibe 3 installation program is located.
Unzip the teaming-3.0.n-sql.zip fileto create the update-2.0.0-3. 0. n directory

Theupdate-2.0.0-3.0.n directory contains an update script for each type of database
(MySQL, Microsoft SQL, and Oracle).

Copy the script for your database type to the server where the Vibe database is |ocated.
Use the database client utility for your database type to run the script:

MySQL: mysgl -uusername -ppassword < /path/update-mysgl.sgl

Microsoft osgl -Uusername -Ppassword -i update-sglserver.sqgl

SQL:
You can also use the script with the SQL Server Express Utility (http://
www.microsoft.com/downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.

Oracle: sglplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;

After you have updated the database from Teaming 2.0 to Vibe 3:
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If your Lucene Index Server is aso on aremote server, continue with Section 20.3.2, “Manual
Lucene Index Server Update,” on page 166.

or

If al remaining components that need to be updated from Teaming 2.0 to Vibe 3 are on the
Vibe server, follow the instructionsin Section 20.2, “Updating a Single-Server System from
Teaming 2.1 to Vibe 3,” on page 163.

19.3.2 Manual Lucene Index Server Update

In order to update your index from Novell Teaming 2.0 to Novell Vibe 3 when the Vibe installation
program cannot do it for you, you need to run the Remote Lucene Server installation program.

1 Stop Vibe.

2 Stop the Lucene Index Server.

3 Copy the Vibe 3 Remote Lucene Server Installation program from the directory where the Vibe
3 Installation program islocated to a convenient directory on the server where the remote
Lucene Index Server is located.

The name of the Remote Lucene Server Installation program varies by platform:

Linux: lucene-installer.linux

Windows: lucene-installer.exe

Start the Vibe 3 Remote Lucene Server installation program.
Accept the License Agreement, then click Next.

Select Update software and settings.

Click Next to continue.

Click Next to accept the installation location.

Click Next to accept the Java JDK location.

10 Inthe Host field, specify the hostname where you are installing the remote L ucene Index
Server.

11 Change Lucene configuration settings as needed, then click Next.
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For information about L ucene configuration settings, see Section 9.5.2, “ Changing Lucene
Configuration Settings,” on page 86.

12 Click Install to install the updated L ucene Index Server software.
13 Click Finish when the update is completed.
14 Start the Lucene Index Server.

15 Now that all remote Vibe components have been updated, follow the instructionsin
Section 20.2, “Updating a Single-Server System from Teaming 2.1 to Vibe 3,” on page 163.
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19.4 Performing Post-Update Tasks

After you start Novell Vibe 3, you can access your Vibe site as usual. However, you need to reset
some aspects of the interface before you allow users to access the updated site. The interface reset
affects only those definitions and templates that are included with the Vibe product. If you have
created custom definitions and templates, they are unaffected by the interface reset.

¢ Section 19.4.1, “Resetting Your Definitions,” on page 159
+ Section 19.4.2, " Resetting the Standard Templates,” on page 161

19.4.1 Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced in Vibe 3. Some of these
enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitionsin order to see the Vibe 3
enhancements, as described in this section.

WARNING: The following procedures delete any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes
you have made. To make it easier to reconstruct the definition after you reset it.

Following isalist of Vibe definitions that you need to reset in order to see the Vibe 3 enhancements:

+ “Resetting Your Entry Definitions’ on page 159

+ “Resetting Your Folder Definitions’ on page 160

+ “Resetting Your User Workspace Definition” on page 160
+ “Resetting Your Profile View Definition” on page 161

Resetting Your Entry Definitions

Entry views have been redesigned and enhanced in Vibe 3. Now users can view an entry’s history,
create notes aboult files associated with the entry, delete previous file versions, and more. For more
information, see “Working With Folder Entries’ in the Novell Vibe OnPrem 3 User Guide.

If you have modified any of the factory-supplied definitions, you won’'t see the new entry definitions
when you upgrade to Vibe 3. In order to see the new entry definitions, you need to reset your current
definitions.

1 Logintothe Vibe site as the Vibe administrator.

2 Click the Administration icon E in the upper right corner of the page.

3 Inthe System section, click Form/View Designers to display the Form and View Designers
page.
4 Click Reset.

The Reset Definitions page is displayed.
5 Expand Entry Definitions, then select each entry definition that is available.
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6 Click OK.

You can now see the entry enhancements. For more information about entriesin Vibe, see
“Working With Folder Entries’ in the Novell Vibe OnPrem 3 User Guide.

Resetting Your Folder Definitions

The look and feel of various Vibe folders has been improved in Vibe 3.

If you have modified any of the factory-supplied folder definitions, you won't see the new folders
when you upgrade to Vibe 3. In order to see the new folders, you need to reset your current
definitions.

1 Logintothe Vibe site as the Vibe administrator.
2 Click the Administration icon E in the upper right corner of the page.

3 Inthe System section, click Form/View Designers to display the Form and View Designers
page.
4 Click Reset.

The Reset Definitions page is displayed.
5 Expand Folder Views, then select the following views to reset the definitions:

*

*

*

*

*

Blog

Calendar

Discussion - Movable Columns
Discussion - Sandard View
Files

Guestbook

urveys

Tasks

Wki

6 Click OK.

Resetting Your User Workspace Definition

The look and feel of the user workspace has been improved in Vibe 3.

If you have modified the factory-supplied user workspace definition, you won’t see the new user
workspace when you upgrade to Vibe 3. In order to see the new user workspace, you heed to reset
your current definitions.

1 Logintothe Vibe site as the Vibe administrator.
2 Click the Administration icon E in the upper right corner of the page.

3 Inthe System section, click Form/View Designers to display the Form and View Designers
page.
4 Click Reset.

The Reset Definitions page is displayed.
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5 Expand User Workspace View, then select User Workspace.

6 Click OK.

Resetting Your Profile View Definition

User profilesin Vibe 3 have been expanded to rival other professiona knowledgebases such as
LinkedIn. Now users can include moreinformation to share with their colleagues, such as education,
qualifications, and competencies. For more information, see “Modifying Your Profile”’ in the Novell

Vibe OnPrem 3 User Guide.

If you have modified any of the factory-supplied definitions, you won't see the new user profile
when you upgrade to Vibe 3. In order to see the new user profile, you need to reset your profile user

definition.

1 Logintothe Vibe site asthe Vibe administrator.

2 Click the Administration icon E in the upper right corner of the page.
3 Inthe System section, click Form/View Designers to display the Form and View Designers

page.
4 Click Reset.

The Reset Definitions page is displayed.

5 Expand Profile View, then select User.
6 Click OK.

You can now see the new user profile, as described in “Modifying Your Profile” in the Novell

Vibe OnPrem 3 User Guide.

19.4.2 Resetting the Standard Templates

IMPORTANT: If you have manually customized any templates that are included with the Vibe
product, back up the files you have modified before performing the interface reset.

1 Logintothe Vibe site as the Vibe administrator.

2 Click the Administration icon E in the upper right corner of the page.
3 Inthe Management section, click Workspace and Folder Templates.

Standard Templmes

4 Click Reset.
5 Click OK to confirm, then click Close.
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Your Vibe 3 siteis now ready for use.

IMPORTANT: If Vibe users encounter problems displaying any pages on the Vibe site after the
update, smply have them clear the browser cache.
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Updating from Novell Teaming 2.1
to Novell Vibe 3

Novell Vibe OnPrem 3 is the new name for the product formerly known as Novell Teaming. This
section describes how to update to Novell Vibe 3 from the previous version, which was Novell
Teaming 2.1.

*

Section 20.1, “Understanding the Update Process,” on page 163

Section 20.2, “Updating a Single-Server System from Teaming 2.1 to Vibe 3,” on page 163
Section 20.3, “Updating a M ultiple-Server System from Teaming 2.1 to Vibe 3,” on page 165
Section 20.4, “ Performing Post-Update Tasks,” on page 167

*

*

*

20.1 Understanding the Update Process

When you upgrade to Novell Vibe 3, each user who has used a previous version of Vibe (previous
versions of Vibe are called Teaming) must clear his or her browser’s cache, regardless of which
browser he or sheis using. Not clearing the browser cache resultsin Vibe not displaying correctly.

Ensure that you communicate this to each Vibe user in your system.

During the update from Novell Teaming 2.1 to Vibe 3, the following aspects of your Vibe system are
modified:
+ The softwareis updated from Teaming 2.1 to Vibe 3.

+ The Vibe database is updated with a new database structure to support the new featuresin Vibe
3. All teams, groups, roles, workspaces, and folders are preserved throughout the update
process.

+ A backup copy of your existing Teaming 2.1 installation is created in the following directory:

Linux: /opt/novell /teaming/teaming-backup

Windows: C:\Program Files\Novell\Teaming\teaming-backup

20.2 Updating a Single-Server System from
Teaming 2.1 to Vibe 3

When you update a single-server Novell Vibe installation from Teaming 2.1 to Vibe 3, the Vibe
Installation program can perform the entire update in a single process, unless the Vibe system uses
an Oracle database.

1 Make sure you have acurrent backup of your Teaming 2.1 system.

2 Stop Teaming.

3 (Conditiond) If your Teaming 2.1 system uses an Oracle database, update the database as
described in Section 20.2.1, “Updating an Oracle Database from 2.1 to 3,” on page 164 before
running the Vibe 3 Installation program.
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4 Copy the installer.xml filefrom the directory where the Teaming 2.1 Installation program
is located to the directory where you have extracted the Vibe 3 software.

You must obtain anew license-key.xml file when upgrading to Vibe 3.

The installer.xml file provides default values when you run the Vibe 3 Installation
program.

5 Start the Vibe 3 installation program.

If you need assistance with this task, see the detailed installation instructions for the platform
where you are updating Vibe:

+ Section 4.1.3, “Running the Linux Vibe Installation Program,” on page 51
+ Section 4.2.2, * Running the Windows Vibe Installation Program,” on page 58
6 Accept the License Agreement, then click Next.

Novell'Vibe 3 Installation Program

Installation Options

Select the action you want to perform N

" New installation
* Update software and settings
" Reconfigure settings

Because you provided your Teaming 2.1 installer.xml filein the directory with the Vibe 3
installation program, the Update software and settings installation option is selected by default.

7 Click Next to continue.
8 Click Yesto let the Installation program know that you have stopped Vibe.

9 Select the check box to let the installation program know that you have backed up al of your
data, then click Next.

10 Select Basic or Advanced, depending on the type of Vibe installation you are updating, then
click Next.

11 Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 3 system.

12 Click Install when you are ready to perform the update.

The Installation program might seem to pause at this point. It needs to update tables and
indexes in the Vibe database. If you have alarge database, this process can be time-consuming.

13 Click Finish when the update is completed.
14 Start Vibe 3 in the same way that you have been starting Teaming 2.1.
When you start Vibe for thefirst time after the update, it takes longer to start than usual because

datain the Vibe database must be updated before the Vibe site is ready to use.
20.2.1 Updating an Oracle Database from 2.1to 3

The Vibe Installation program can update MySQL and Microsoft SQL databases as part of the Vibe
software update, but it cannot update an Oracle database. Therefore, if you are using Oracle, you
must manually run the database update script after you have stopped Vibe.

1 Changeto the directory where the Vibe 3 Installation program is located.
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2 Unzipthe teaming-3.0.n-sql.zip fileto create the update-2.1.0-3.0.n directory

Theupdate-2.1.0-3.0.n directory contains an update script for each type of database
(MySQL, Microsoft SQL, and Oracle).

3 Runtheupdate-oracle.sqgl script to update the database structure.

sqglplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle;
SQL>quit;

4 Return to Step 4 in Section 20.2, “Updating a Single-Server System from Teaming 2.1 to Vibe
3, on page 163.

20.3 Updating a Multiple-Server System from
Teaming 2.1 to Vibe 3

If your Novell Teaming 2.1 system is distributed across multiple servers, the Vibe 3 installation
program can update Vibe components on the Vibe server, but you must manually update any Vibe
components that you have placed on remote servers.

+ Section 20.3.1, “Manual Vibe Database Update,” on page 165

¢ Section 20.3.2, “Manual Lucene Index Server Update,” on page 166

20.3.1 Manual Vibe Database Update

In order to update a database from Novell Teaming 2.1 to Novell Vibe 3 when the Vibe installation
program cannot do it for you, you must run the Vibe 3 database update script.

1 Stop Vibe.

2 Changeto the directory where the Vibe 3 installation program is located.

3 Unzip the teaming-3.0.n-sql.zip fileto createthe update-2.1.0-3.0.n directory

Theupdate-2.1.0-3.0.n directory contains an update script for each type of database
(MySQL, Microsoft SQL, and Oracle).

4 Copy the script for your database type to the server where the Vibe database is |ocated.
5 Use the database client utility for your database type to run the script:

MySQL: mysgl -uusername -ppassword < /path/update-mysgl.sgl

Microsoft osqgl -Uusername -Ppassword -i update-sglserver.sqgl

SQL:
You can also use the script with the SQL Server Express Utility (http://
www.microsoft.com/downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.

Oracle: sglplus "/ as sysdba"

SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;

6 After you have updated the database from Teaming 2.1 to Vibe 3:
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If your Lucene Index Server is aso on aremote server, continue with Section 20.3.2, “Manual
Lucene Index Server Update,” on page 166.

or

If al remaining components that need to be updated from Teaming 2.1 to Vibe 3 are on the
Vibe server, follow the instructionsin Section 20.2, “Updating a Single-Server System from
Teaming 2.1 to Vibe 3,” on page 163.

20.3.2 Manual Lucene Index Server Update

In order to update your index from Novell Teaming 2.1 to Novell Vibe 3 when the Vibe installation
program cannot do it for you, you need to run the Remote Lucene Server installation program.

1 Stop Vibe.

2 Stop the Lucene Index Server.

3 Copy the Vibe 3 Remote Lucene Server Installation program from the directory where the Vibe
3 Installation program islocated to a convenient directory on the server where the remote
Lucene Index Server is located.

The name of the Remote Lucene Server Installation program varies by platform:

Linux: lucene-installer.linux

Windows: lucene-installer.exe

Start the Vibe 3 Remote Lucene Server installation program.
Accept the License Agreement, then click Next.

Select Update software and settings.

Click Next to continue.

Click Next to accept the installation location.

Click Next to accept the Java JDK location.

10 Inthe Host field, specify the hostname where you are installing the remote L ucene Index
Server.

11 Change Lucene configuration settings as needed, then click Next.
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For information about L ucene configuration settings, see Section 9.5.2, “ Changing Lucene
Configuration Settings,” on page 86.

12 Click Install to install the updated L ucene Index Server software.
13 Click Finish when the update is completed.
14 Start the Lucene Index Server.

15 Now that all remote Vibe components have been updated, follow the instructionsin
Section 20.2, “Updating a Single-Server System from Teaming 2.1 to Vibe 3,” on page 163.
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20.4 Performing Post-Update Tasks

After you start Novell Vibe 3, you can access your Vibe site as usual. However, you need to reset
some aspects of the interface before you allow users to access the updated site. The interface reset
affects only those definitions and templates that are included with the Vibe product. If you have
created custom definitions and templates, they are unaffected by the interface reset.

* Section 20.4.1, “Resetting Your Definitions,” on page 167
+ Section 20.4.2, " Resetting the Standard Templates,” on page 169

20.4.1 Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced in Vibe 3. Some of these
enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitionsin order to see the Vibe 3
enhancements, as described in this section.

WARNING: The following procedures delete any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes
you have made to make it easier to reconstruct the definition after you reset it.

Following isalist of Vibe definitions that you need to reset in order to see the Vibe 3 enhancements:

+ “Resetting Your Entry Definitions’ on page 167

+ “Resetting Your Folder Definitions’ on page 168

+ “Resetting Your User Workspace Definition” on page 168
+ “Resetting Your Profile View Definition” on page 169

Resetting Your Entry Definitions

Entry views have been redesigned and enhanced in Vibe 3. Now users can view an entry’s history,
create notes aboult files associated with the entry, delete previous file versions, and more. For more
information, see “Working With Folder Entries’ in the Novell Vibe OnPrem 3 User Guide.

If you have modified any of the factory-supplied definitions, you won’'t see the new entry definitions
when you upgrade to Vibe 3. In order to see the new entry definitions, you need to reset your current
definitions.

1 Logintothe Vibe site as the Vibe administrator.

2 Click the Administration icon E in the upper right corner of the page.

3 Inthe System section, click Form/View Designers to display the Form and View Designers
page.
4 Click Reset.

The Reset Definitions page is displayed.
5 Expand Entry Definitions, then select each entry definition that is available.
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6 Click OK.

You can now see the entry enhancements. For more information about entriesin Vibe, see
“Working With Folder Entries’ in the Novell Vibe OnPrem 3 User Guide.

Resetting Your Folder Definitions

The look and feel of various Vibe folders has been improved in Vibe 3.

If you have modified any of the factory-supplied folder definitions, you won't see the new folders
when you upgrade to Vibe 3. In order to see the new folders, you need to reset your current
definitions.

1 Logintothe Vibe site as the Vibe administrator.
2 Click the Administration icon E in the upper right corner of the page.

3 Inthe System section, click Form/View Designers to display the Form and View Designers
page.
4 Click Reset.

The Reset Definitions page is displayed.
5 Expand Folder Views, then select the following views to reset the definitions:

*

*

*

*

*

Blog

Calendar

Discussion - Movable Columns
Discussion - Sandard View
Files

Guestbook

urveys

Tasks

Wki

6 Click OK.

Resetting Your User Workspace Definition

The look and feel of the user workspace has been improved in Vibe 3.

If you have modified the factory-supplied user workspace definition, you won’t see the new user
workspace when you upgrade to Vibe 3. In order to see the new user workspace, you heed to reset
your current definitions.

1 Logintothe Vibe site as the Vibe administrator.
2 Click the Administration icon E in the upper right corner of the page.

3 Inthe System section, click Form/View Designers to display the Form and View Designers
page.
4 Click Reset.

The Reset Definitions page is displayed.
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5 Expand User Workspace View, then select User Workspace.

6 Click OK.

Resetting Your Profile View Definition

User profilesin Vibe 3 have been expanded to rival other professiona knowledgebases such as
LinkedIn. Now users can include moreinformation to share with their colleagues, such as education,
qualifications, and competencies. For more information, see “Modifying Your Profile”’ in the Novell

Vibe OnPrem 3 User Guide.

If you have modified any of the factory-supplied definitions, you won't see the new user profile
when you upgrade to Vibe 3. In order to see the new user profile, you need to reset your profile user

definition.

1 Logintothe Vibe site asthe Vibe administrator.

2 Click the Administration icon E in the upper right corner of the page.
3 Inthe System section, click Form/View Designers to display the Form and View Designers

page.
4 Click Reset.

The Reset Definitions page is displayed.

5 Expand Profile View, then select User.
6 Click OK.

You can now see the new user profile, as described in “Modifying Your Profile” in the Novell

Vibe OnPrem 3 User Guide.

20.4.2 Resetting the Standard Templates

IMPORTANT: If you have manually customized any templates that are included with the Vibe
product, back up the files you have modified before performing the interface reset.

1 Logintothe Vibe site as the Vibe administrator.

2 Click the Administration icon E in the upper right corner of the page.
3 Inthe Management section, click Workspace and Folder Templates.

Standard Templmes

4 Click Reset.
5 Click OK to confirm, then click Close.
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Your Vibe 3 siteis now ready for use.

IMPORTANT: If Vibe users encounter problems displaying any pages on the Vibe site after the
update, smply have them clear the browser cache.
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Migrating Existing Novell Vibe
Data into a New Vibe 3 System

If your existing Novell Vibe system has outgrown the server where you originally set it up, or you
want to move to adifferent operating system, you can install Vibe 3 on a new server, then migrate
your existing Vibe data from a previous version to your new Vibe 3 system. Thisis especially
helpful if you created your Vibe system by using the Virtual Eval version of the Novell Vibe Starter
Pack (http://download.novell.com/Download?buildid=Y 7J2HFucjfw~).

You might also want to migrate an existing Teaming 2.1 system to a Vibe 3 system on another
server.

+ Section 21.1, “Linux Migration with aMySQL Database,” on page 171
+ Section 21.2, “Windows Migration with an MS SQL Database,” on page 174

NOTE: Intheseinstructions, “target server” refersto the server where you install the Vibe 3
software, and “ source server” refersto the existing server from which you are migrating Vibe data.

Theinstructions in this section are based on asingle-server Vibe configuration. If you have amulti-
server Vibe configuration, the single-server instructions can serve as a foundation to get you started
with your more complex migration process.

This section does not include instructions for migrating an Oracle database. Use the instructions for
your Vibe platform as a guideline for the tasks that are involved in migrating Vibe data, then apply
these guidelines to your Oracle database migration.

21.1 Linux Migration with a MySQL Database

* Section 21.1.1, “Preparing the Target Linux Server,” on page 171

+ Section 21.1.2, “ Preparing the Source Linux Server,” on page 173

+ Section 21.1.3, “Transferring Data from the Source Server to the Target Server,” on page 173
+ Section 21.1.4, “Importing the Vibe Database to the Target Server,” on page 173

+ Section 21.1.5, “Updating the Vibe Database on the Target Server,” on page 174

+ Section 21.1.6, “Finalizing Your New Vibe 3 Site,” on page 174

21.1.1 Preparing the Target Linux Server

On the target server:
1 Install the Vibe 3 software on the target server, as described in Part 11, “Basic Installation,” on
page 23, paying special attention to these important details:

+ Set up the same Linux user to run the Vibe software that has been used to run the Vibe
software in the past.

+ Select the same encryption algorithm for the Vibe database.
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IMPORTANT: If the database encryption algorithms do not match between the source
and target Vibe systems, you cannot log in to the new Vibe 3 site.

Start Vibe on the target server.
Verify that the new Vibe site is working as expected.
Stop Vibe on the target server.

a b~ W N

Rename the teaming directory to teaming backup. Thisisbecausein afuture step you will
copy the teaming directory from the source server to the target server.

The location of the teaming directory varies by platform:

Linux: /var/opt/novell/teaming

Windows: c¢:\novell\teaming

6 (Conditional) If you are migrating a Teaming 2.1 system to a Vibe 3 system, you need to
manually change the encryption algorithm in the ssf-ext .properties file:

6a On the Vibe server that you are migrating from, change to the directory wherethe ssf -
ext .properties fileislocated

The default location of thisfile varies by platform:

Linux: /opt/novell/teaming/apache-tomcat/webapps/
ssf/WEB-INF/classes/
config

Windows: c¢:\Program Files\Novell\Teaming\apache-tomcat\webapps\
ssf\WEB-
INF\classes\config

6b Openthessf-ext.properties filein atext editor, then locate and copy the appropriate
property setting for your encryption algorithm. The encryption algorithm for your Vibe
server is represented by one of the following lines:

user.password.encryption.algorithm=SHA
user.password.encryption.algorithm=SHA-256
user.password.encryption.algorithm=MD5

6¢c On the Vibe server that you are migrating to, change to the directory where the ssf -
ext .properties fileislocated

The default location of thisfile varies by platform:

Linux: /opt/novell/teaming/apache-tomcat/webapps/
ssf/WEB-INF/classes/
config

Windows: c¢:\Program Files\Novell\Teaming\apache-tomcat\webapps\
ssf\WEB-
INF\classes\config
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6d Openthessf-ext.properties fileinatext editor, then paste the line that you copied in
Step 6b.

6e Saveandclosethe ssf-ext.properties file.
7 Continue with Section 21.1.2, “ Preparing the Source Linux Server,” on page 173.

21.1.2 Preparing the Source Linux Server

On the source server:

1 Stop Vibe.
2 Back up your existing database:
mysgldump -uusername -ppassword sitescape > sitescape.sql

This creates afile named sitescape. sql in the directory where you executed the mysql dump
command.

3 Make sure that you have arecent backup of your entire Vibe system.

4 Continue with Section 21.1.3, “ Transferring Data from the Source Server to the Target Server,”
on page 173.

21.1.3 Transferring Data from the Source Server to the Target
Server

On the source server:
1 Mount the target server to the source server so that data can be copied from one server to the
other.
2 Inatermina window on the source server, become the Linux user that runs the Vibe software.

3 Copy the database backup of your existing Vibe database (sitescape. sql file) that you
created in Step 2 in Section 21.1.2, “Preparing the Source Linux Server,” on page 173to a
convenient temporary location on the target server.

4 Copy the entire data areafrom /var/opt/novell/teaming On the source server to the same
location on the target server.

5 Continue with Section 21.1.4, “Importing the Vibe Database to the Target Server,” on
page 173.

21.1.4 Importing the Vibe Database to the Target Server

On the target server:

1 Remove the empty Vibe database that was created when you installed the Vibe 3 software:
mysgl>drop database sitescape;

2 Changeto the directory where you copied the sitescape.sql filein Step 3in Section 21.1.3,
“Transferring Data from the Source Server to the Target Server,” on page 173.

3 Create an empty database called sitescape:

mysgl -uusername -ppassword -e "create database sitescape"

4 Manualy re-create the Vibe database with the data that you copied from the source server:
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mysqgl -uusername -ppassword sitescape < sitescape.sql

5 Continue with Section 21.1.5, “Updating the Vibe Database on the Target Server,” on page 174.

21.1.5 Updating the Vibe Database on the Target Server

This section applies only when you are migrating a Teaming 2.1 server to a Vibe 3 server.
On the target server:

1 Unzipthe teaming-3.0.n.zip file, changeto the resulting update-2.1.0-3.0.n directory,
then run the update script to update the database from Teaming 2.1 to Vibe 3:
mysql -uusername -ppassword < update-mysqgl.sqgl

For more compl ete database update instructions, refer to Section 20.3.1, “Manual Vibe
Database Update,” on page 165.

2 Continue with Section 21.1.6, “Finalizing Your New Vibe 3 Site,” on page 174.

21.1.6 Finalizing Your New Vibe 3 Site

1 Start Vibe 3, asdescribed in Section 4.1.6, “ Starting Vibe on Linux,” on page 56.

2 Reindex the Vibe site, as described in “ Rebuilding the Lucene Index” in “ Site Maintenance” in
the Novell Vibe OnPrem 3 Administration Guide.

Your Vibe site should now function just asit did on the original source server.

21.2 Windows Migration with an MS SQL
Database

¢ Section 21.2.1, “Preparing the Target Windows Server,” on page 174

Section 21.2.2, “ Preparing the Source Windows Server,” on page 175

Section 21.2.3, “ Transferring Data from the Source Server to the Target Server,” on page 176
Section 21.2.4, “Importing the Database to the Target Server,” on page 176

Section 21.2.5, “Updating the Vibe Database on the Target Server,” on page 177

Section 21.2.6, “Finalizing Your New Vibe 3 Site,” on page 177

*

*

*

*

*

21.2.1 Preparing the Target Windows Server

On the target server:

1 Install the Vibe 3 software, as described in Part |1, “Basic Installation,” on page 23.

IMPORTANT: Select the same encryption agorithm for the Vibe database. If the database
encryption algorithms do not match between the source and target systems, you cannot loginto
the new Vibe 3 site.

2 Start Vibe on the target server.
3 Verify that the new Vibe site is working as expected.
4 Stop Vibe on the target server.
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5 Renamethe teaming directory to teaming backup. Thisisbecause in afuture step you will
copy the teaming directory from the source server to the target server.

The location of the teaming directory varies by platform:

Linux: /var/opt/novell/teaming

Windows: c¢:\Program Files\Novell\Teaming\apache-tomcat\webapps\
ssf\WEB-INF\classes\config

6 (Conditiona) If you are migrating a Teaming 2.1 system to a Vibe 3 system, you need to
manually change the encryption algorithm in the ssf-ext .properties file

6a On the Vibe server that you are migrating from, change to the directory wherethe ssf -
ext .properties fileislocated

The default location of thisfile varies by platform:

Linux: /opt/novell/teaming/apache-tomcat/webapps/
ssf /WEB-INF/classes/
config

Windows: c¢:\Program Files\Novell\Teaming\apache-tomcat\webapps\
ssf\WEB-
INF\classes\config

6b Openthessf-ext.properties filein atext editor, then locate and copy the appropriate
property setting for your encryption algorithm. The encryption algorithm for your Vibe
server is represented by one of the following lines:

user.password.encryption.algorithm=SHA
user.password.encryption.algorithm=SHA-256
user.password.encryption.algorithm=MD5

6¢c On the Vibe server that you are migrating to, change to the directory where the ssf-
ext .properties fileislocated.

The default location of thisfile varies by platform:

Linux: /opt/novell/teaming/apache-tomcat/webapps/
ssf/WEB-INF/classes/
config

Windows: c¢:\novell\teaming

6d Openthessf-ext.properties filein atext editor, then paste the line that you copied in
Step 6b.

6e Saveandclosethe ssf-ext.properties file.
7 Continue with Section 21.2.2, “Preparing the Source Windows Server,” on page 175.
21.2.2 Preparing the Source Windows Server

On the source server:

1 Stop Vibe.
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2 Back up your existing database:

2a In Microsoft SQL Server Management Studio, browse to and right-click the existing
database (named sitescape), then click Tasks > Back Up.

2b For Backup type, select Full.
2c Set other backup options as desired, then click OK.
This creates afile named sitescape.bak in the following directory:
c:\Program Files\Microsoft SQL Server\MSSQL\Backup
3 Make surethat you have arecent backup of your entire system.

4 Continue with Section 21.2.3, “ Transferring Data from the Source Server to the Target Server,”
on page 176.

21.2.3 Transferring Data from the Source Server to the Target
Server

On the source server:

1 Map adrivefrom the destination server to the source server so that data can be copied from one
server to the other.

2 Copy your existing software extensions to the target server:

From: c:\home\icecoredata\extensions

To: c:\novell\teaming\extensions

In Vibe 3, the extensions directory now contains kablink and 1iferay.com directories.
3 Delete the empty kablink directory.

4 Delete or rename the following directories to make room for the corresponding directories that
you are copying from the source server:

c:\novell\teaming
c¢:\novell\teaming\lucene
c:\novell\teaming\extensions

5 Copy the entire data area from c: \novell\teaming on the source server to the same location
on the target server.

6 Continue with Section 21.2.4, “Importing the Database to the Target Server,” on page 176.

21.2.4 Importing the Database to the Target Server

On the target server:

1 InMicrosoft SQL Server Management Studio, browse to and right-click the existing Vibe
database (named sitescape) that was created when you installed the Vibe 3 software, then
click Delete.

2 To import the data from your source database, browse to and right-click Databases, then click
Tasks > Restore.

3 Inthe To database field, specify sitescape.
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4 Inthe Fromdevice field, browse to and select the sitescape . bak file that you transferred to
the target server.

5 Set other restore options as desired, then click OK.
This creates the sitescape database in the following directory on the target server:
c:\Program Files\Microsoft SQL Server\MSSQL

Backed-up data from the source database isimported into the database for your new Vibe 3
system.

6 Continue with Section 21.2.5, “Updating the Vibe Database on the Target Server,” on page 177.

21.2.5 Updating the Vibe Database on the Target Server

This section applies only when migrating a Teaming 2.1 server to a Vibe 3 server.
On the target server:

1 Unzipthe teaming-3.0.n-sql.zip file, changeto the resulting update-2.1.0-3.0.n
directory, then run the update script to update the database from Teaming 2.1 to Vibe 3:
osql -Uusername -Ppassword -i update-sglserver.sql

For more complete database update instructions, refer to Section 20.3.1, “Manual Vibe
Database Update,” on page 165.

2 Continue with Section 21.2.6, “Finalizing Your New Vibe 3 Site,” on page 177.

21.2.6 Finalizing Your New Vibe 3 Site

1 Start Vibe 3, as described in Section 4.1.6, “ Starting Vibe on Linux,” on page 56.

2 Reindex the Vibe site, as described in * Rebuilding the Lucene Index” in “ Site Maintenance” in
the Novell Vibe OnPrem 3 Administration Guide.

Your Vibe site should now function just asit did on the origina source server.
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Migrating from SiteScape Forum
or Other Collaboration Software

Moving legacy corporate datainto a new collaboration system can look like along, challenging
process. To make the job easier, see the Novell Teaming Migration Services Flyer. (http://
www.novell.com/rc/docrepository/public/14/basedocument.2009-04-23.2174214965/

Novell_Teaming_Migration_Flyer_en.pdf)
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Appendixes

+ Appendix A, “Vibe System Requirements Assistance,” on page 183
+ Appendix B, “Third-Party Materials,” on page 189
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Vibe System Requirements
Assistance

The system requirements for Novell Vibe OnPrem include supporting components that might or
might not be aready installed on your Vibe server. This section helps you meet the Vibe system
requirementsif you are not familiar with how to install these supporting components.

*

*

Section A.1, “Java Development Kit,” on page 183
Section A.2, “MySQL Database Server,” on page 185

A.l Java Development Kit

The Novell Vibe software runs inside a Java Virtual Machine (JVM). At present, Vibe requires a
Java Development Kit (JDK), not a Java Runtime Environment (JRE), in order to run properly. You
can use either the Sun JDK or the IBM JDK. Follow the instructions in the section below for your
operating system and JDK preference:

If you want to use an SSL connection between your Novell Vibe site and a WebDAV server, and if
the WebDAV server has a self-signed certificate rather than a certificate provided by a certificate
authority, you must use the Sun JDK. The existing Vibe functionality for handling self-signed
certificates is not compatible with the way the IBM JDK handles self-signed certificates.

*

*

*

Section A.1.1, “Sun JDK on Linux,” on page 183
Section A.1.2, “IBM JDK on Linux,” on page 184
Section A.1.3, “Sun JDK on Windows,” on page 185

A.1.1 Sun JDK on Linux

1

a b~ W N

Go to the following URL:

Java SE Downloads (http://java.sun.com/javase/downl oads/index.jsp)

The update you need is listed as “JDK 6 Update nn.”

Click Download JDK next to this update.

In the Platformfield, select Linux or Linux x64 depending on the processor in your Vibe server.
Click Continue, thenlog in, or click Skip this Sep.

Click the jdk-6unn-1inux-version-rpm.bin file, then save the file to an empty temporary
directory on your Linux server.

Asthe root user, change to that temporary directory, then use the following command to make
sure that the download arrived safely:

1s -1

You should see afile named jdk-6unn-1inux-version-rpm.bin.
Change the permissions on the file to include execute permissions:
chmod +x jdk-6unn-linux-version-rpm.bin

Run the self-extracting file:
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./jdk-6unn-linux-version-rpm.bin

This creates afile named jdk-6unn-1inux-version. rpm, and a directory named /usr/
java/jdk.1.6.0 nnwiththe Sun JDK softwarein it.

The Sun JDK is now installed on your Linux server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you
install the JDK. The Vibe installation program prompts you for this location.

A.1.2 IBM JDK on Linux

+ “Installing the IBM JDK on SUSE Linux Enterprise Server 11” on page 184

+ “Installing the IBM JDK on Open Enterprise Server 2 and SUSE Linux Enterprise Server 10"
on page 184

Installing the IBM JDK on SUSE Linux Enterprise Server 11

The IBM JDK 6.0 isavailable with SUSE Linux Enterprise Server (SLES) 11, which is used for
Open Enterprise Server (OES) 2. You caninstall it by using YaST.
1 InYaST, click Software > Software Management.
In the Search field, type ibm, then click Search.
Select Java 5 SDK, Sandard Edition (java-1_5 0-ibm-devel), then click Accept.

Click Continue to accept the suggested dependencies, then click No because you don't need
any more packages.
5 Exit YaST.

This creates adirectory named /usr/1ib/jvm/java-1 5 0-ibm-1.5.0 sr3 with the IBM
JDK softwareinit.

A WDN

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you
install the JDK. The Vibe installation program prompts you for this location.

Installing the IBM JDK on Open Enterprise Server 2 and SUSE Linux Enterprise
Server 10

The IBM JDK 6.0 is not included with SUSE Linux Enterprise Server (SLES) 10.
To download the IBM JDK 6.0:

1 Gotothefollowing URL:
Java SE Downloads (http://www.ibm.com/devel operworks/javaljdk/linux/download.html)

2 Inthe Java SE Version 6 table, in the Download column, click the appropriate link for your
operating system.

3 Signinusing your IBM account. If you don’'t have an account, create one.
4 Agreeto IBM’slicense agreement, then continue.

184 Novell Vibe OnPrem 3 Installation Guide


http://www.ibm.com/developerworks/java/jdk/linux/download.html

5 Downloadthe ibm-java-i386-sdk-6.0-n.n.1386.rpmfileto an empty temporary directory
on your Linux server.

6 Changeto that directory, then run the downloaded file.
This creates a directory named opt \ ibm with the IBM JDK init.
The IBM JDK isnow installed on your Linux server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you
install the JDK. The Vibe installation program prompts you for this location.

A.1.3 Sun JDK on Windows

1 Gotothefollowing URL:
Java SE Downloads (http://java.sun.com/javase/downl oads/index.jsp)
The update you need is listed as “JDK 6 Update nn.”

2 Click Download JDK next to this update.

3 Inthe Platformfield, select Windows or Windows x64 depending on the processor in your Vibe
serve.

4 Select | agree, then click Continue to accept Sun’s License Agreement.

5 Click the jdk-6unn-windows-version.exe file, then save the file to an empty temporary
directory on your Windows server.

6 Change to that temporary directory, then run the downloaded executable.

This creates adirectory named c: \Program Files\Java\jdkeunn with the Sun JDK
softwareinit.

The Sun JDK is now installed on your Windows server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you
install the JDK. The Vibe installation program prompts you for this location.

A.2 MySQL Database Server

+ Section A.2.1, “MySQL on Linux,” on page 185
+ Section A.2.2, “MySQL on Windows,” on page 187

A.2.1 MySQL on Linux

Depending on the options you select when installing Open Enterprise Server 2 and SUSE Linux
Enterprise Server (SLES), the MySQL database server might be installed along with the operating
system. Check for the following directory:

/usr/bin/mysqgl
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If the /usr/bin/mysql directory does not exist, you need to install the MySQL database server. If
MySQL isdready installed, you still need to configure it for use with Vibe.

+ “Instaling MySQL” on page 186

* “Configuring MySQL” on page 186

+ “Learning More about MySQL” on page 187

Installing MySQL

1 Make sure you have access to your operating system installation media.
In YaST, click Software > Software Management.

In the Search field, type mysq1, then click Search.

Select mysql, then click Accept.

Click Continue to resolve dependencies.

o 01~ WD

Click Continue to acknowledge package support status.
MySQL isthen installed from the SLES media.
7 Continue with “Configuring MySQL” on page 186.

Configuring MySQL

When MySQL isinitialy installed, it is not configured with an administrator password, nor isit
configured to start automatically. Follow the steps below to set up the MySQL database server for
use with Vibe:
1 InYaST, click System > System Services.
Scroll to and select the MySQL service, then click Enable.
Click Continueto install dependencies, then click OK to close the status box.
Click OK > Yesto finish the installation, then exit YaST.
In atermina window, become the root user.
To verify that the MySQL database server has started, use the following command:

o oA WDN

ps -eaf | grep mysqgl
You should see MySQL processes running.

7 Set the administrator password for the MySQL database server:
mysgladmin -u root password new password

This command changes the password for the MySQL root user, which is the default
administrator username for the MySQL database server. This command is part of the MySQL
client package.

IMPORTANT: The MySQL root username is not the same as the Linux root user. The
Linux root user has a password established for it when you install Linux. In aparallel fashion,
the MySQL root user needs to have a password established for it when you install MySQL.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Vibe Installation Summary Sheet, specify the MySQL
administrator password. The Vibe installation program prompts you for this information.
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Learning More about MySQL

The following table includes some basic and useful MySQL commands:

Action Command
Stop MySQL /etc/initd/mysql stop
Start MySQL /etc/initd/mysgl start

Show MySQL status mysgladmin -u root -p extended-status

If you want to administer MySQL through a GUI interface, you can download tools from:
MySQL GUI Tools Downloads (http://dev.mysqgl.com/downl oads/gui-tool s/5.0.html)
For more information about MySQL, see:

MySQL Documentation (http://dev.mysgl.com/doc)

A.2.2 MySQL on Windows

1 Inyour Web browser, go to the following URL.:
MySQL 5.1 Downloads (http://dev.mysgl.com/downloads/mysqgl/5.1.html)

2 Scroll down if necessary, then click the type of Windows operating system you are using (32-
bit or 64-bit).

On the Windows Essential s line, click Download.

Click Save File, browse to and select a convenient temporary directory, then click Save.
In Windows Explorer, browse to the directory where you saved the MySQL . exe file.
Double-click the MySQL . exe fileto start the MySQL Setup Wizard.

Follow the online instructions to install the MySQL software on the Windows server, then
continue with Step 8 to configure the server.

N o o~ W

8 Unlessyou are aready familiar with configuring MySQL on aWindows server, select Sandard
Configuration, then click Next.

9 Select Include Bin Directory in Windows PATH, then click Next.
10 Setthe MySQL root user password, then click Next.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Vibe Installation Summary Sheet, specify the MySQL
administrator password. The Vibe installation program prompts you for this information.

11 Click Executeto configure the MySQL database server, then click Finish.
Some messages report the status of your MySQL installation.

12 To monitor the MySQL database server, click Sart > All Programs, then click MySQL >
MySQL Server 5.1 > MySQL Command Line Client.
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Third-Party Materials

+ SectionB.1, “ANTLR 3 License,” on page 189

+ Section B.2, “Colt License Agreement,” on page 190

+ Section B.3, “Domdj License,” on page 190

+ Section B.4, “iCal4j License,” on page 191

+ Section B.5, “1CU4J license (ICU4J 1.3.1 and later),” on page 191
+ Section B.6, “JAXEN License,” on page 192

+ Section B.7, “Jung,” on page 193

+ Section B.8, “ASM,” on page 193

+ Section B.9, “Firebug Lite,” on page 194

B.1 ANTLR 3 License

Copyright (c) 2003-2008, Terence Parr
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met

+ Redistributions of source code must retain the above copyright naotice, this list of conditions
and the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, thislist of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

+ Neither the name of the author nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE ISPROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
“ASIS’ AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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B.2 Colt License Agreement

Packages cern.colt*, cern.jet*, cern.clhep
Copyright (c) 1999 CERN - European Organization for Nuclear Research.

Permission to use, copy, modify, distribute and sell this software and its documentation for any
purposeis hereby granted without fee, provided that the above copyright notice appear in al
copies and that both that copyright notice and this permission notice appear in supporting
documentation. CERN makes no representations about the suitability of this software for any
purpose. It is provided “asis’ without expressed or implied warranty.

Packages hep.aida.*

Written by Pavel Binko, Dino Ferrero Merlino, Wolfgang Hoschek, Tony Johnson, Andreas
Pfeiffer, and others. Check the FreeHEP home page for more info. Permission to use and/or
redistribute this work is granted under the terms of the LGPL License, with the exception that
any usage related to military applications is expressly forbidden. The software and
documentation made available under the terms of this license are provided with no warranty.

B.3 Dom4j License
Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

Redistribution and use of this software and associated documentation (“ Software”), with or without
modification, are permitted provided that the following conditions are met:

1. 1.Redistributions of source code must retain copyright statements and notices. Redistributions
must also contain a copy of this document.

2. Redistributionsin binary form must reproduce the above copyright notice, thislist of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. The name“DOM4J" must not be used to endorse or promote products derived from this
Software without prior written permission of MetaStuff, Ltd. For written permission, please
contact domd4j-info@metastuff.com.

4. The name“DOM4J" must not be used to endorse or promote products derived from this
Software without prior written permission of MetaStuff, Ltd. For written permission, please
contact domd4j-info@metastuff.com.

5. Products derived from this Software may not be called “DOM4J’ nor may “DOMA4J’ appear in
their names without prior written permission of MetaStuff, Ltd. DOM4J is aregistered
trademark of MetaStuff, Ltd.

6. Due credit should be given to the DOM4J Project (http://www.dom4j.org).

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS “ASIS™
AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESSFOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR
ITSCONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
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OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

B.4 iCal4j License

Copyright (c) 2008, Ben Fortuna
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, thislist of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

+ Neither the name of Ben Fortuna nor the names of any other contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE ISPROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
“ASIS’ AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESSFOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

B.5 ICU4J license (ICU4J 1.3.1 and later)
COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1995-2001 International Business Machines Corporation and others
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the " Software™), to deal in the Software without restriction,
including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, provided
that the above copyright notice(s) and this permission notice appear in al copies of the Software and
that both the above copyright notice(s) and this permission notice appear in supporting
documentation.
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THE SOFTWARE ISPROVIDED "ASIS', WITHOUT WARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT
HOLDER OR HOLDERSINCLUDED IN THISNOTICE BE LIABLE FOR ANY CLAIM, OR
ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN
ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or
otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.

B.6 JAXEN License

Copyright (C) 2000-2002 Bob McWhirter & James Strachan.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, thislist of conditions,
and the following disclaimer.

2. Redistributionsin binary form must reproduce the above copyright  notice, thislist of
conditions, and the disclaimer that follows these conditions in the documentation and/or other
materials provided with the distribution.

3. The name “Jaxen” must not be used to endorse or promote products  derived from this
software without prior written permission. For written permission, please contact
license@jaxen.org.

4. Productsderived from this software may not be called “ Jaxen,” nor may “ Jaxen” appear in their
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).

In addition, we request (but do not require) that you include in the end-user documentation provided
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:

“This product includes software developed by the Jaxen Project (http://www.jaxen.org).”

Alternatively, the acknowledgment may be graphical using the logos available at http://
WWW.jaxen.org.

THIS SOFTWARE ISPROVIDED “AS1S” AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE Jaxen AUTHORS OR THE PROJECT CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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This software consists of voluntary contributions made by many individuals on behalf of the Jaxen
Project and was originally created by bob mcwhirter (bob@werken.com) and James Strachan
(jstrachan@apache.org). For more information on the Jaxen Project, please see http://
WWW.jaxen.org.

B.7 Jung

THE JUNG LICENSE
Copyright (c) 2003-2004, Regents of the University of California and the JUNG Project
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, thislist of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

+ Neither the name of the University of California nor the names of its contributors may be used
to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE ISPROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
“AS1S” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

B.8 ASM

Copyright (c) 2000-2005, INRIA, France Telecom
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, thislist of conditions
and the following disclaimer.
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+ Redistributions in binary form must reproduce the above copyright notice, thislist of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

+ Neither the name of the copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE ISPROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
“ASIS’ AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

B.9 Firebug Lite

Copyright (c) 2006-2007, Joe Hewitt
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright naotice, this list of conditions
and the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, thislist of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

+ Neither the name of the copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE ISPROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
“ASIS’ AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

194 Novell Vibe OnPrem 3 Installation Guide



	Novell Vibe OnPrem 3 Installation Guide
	About This Guide
	I Product Overview
	1 What Is Novell Vibe OnPrem?
	1.1 Vibe Capabilities
	1.1.1 Content Consumers
	1.1.2 Content Providers
	1.1.3 Administrators

	1.2 Vibe Components
	1.2.1 Vibe Software
	1.2.2 Vibe Database
	1.2.3 Vibe File Repository
	1.2.4 Lucene Index

	1.3 Vibe Configurations

	2 Vibe OnPrem System Requirements
	2.1 Vibe Server Requirements
	2.2 Vibe User Requirements
	2.3 Mobile Device Requirements
	2.3.1 Supported Mobile Devices
	2.3.2 Device Browser Requirements

	2.4 Supported Environments
	2.4.1 File Viewer Support
	2.4.2 IPV6 Support
	2.4.3 Clustering Support
	2.4.4 Xen Virtualization Support
	2.4.5 VMware Support
	2.4.6 Single Sign-On Support
	2.4.7 Linux File System Support

	2.5 Recommended Hardware Configurations


	II Basic Installation
	3 Planning a Basic Vibe Installation
	3.1 What Is a Basic Vibe Installation?
	3.2 Selecting the Operating Environment for Your Vibe Server
	3.2.1 Vibe Server Platform
	3.2.2 Vibe Server Architecture
	3.2.3 Vibe Server Memory
	3.2.4 Vibe Installation Locations
	3.2.5 TrueType Font Location (Linux Only)

	3.3 Selecting a Java Development Kit
	3.4 Gathering Network Information for Your Vibe Site
	3.4.1 Host Identification
	3.4.2 Port Numbers

	3.5 Planning the WebDAV Authentication Method
	3.5.1 Understanding WebDAV
	3.5.2 Choosing the WebDAV Authentication Method

	3.6 Planning the Vibe Database
	3.6.1 Database Type
	3.6.2 Database Setup Method
	3.6.3 Database Location
	3.6.4 Database Credentials
	3.6.5 Database Encryption Algorithm

	3.7 Gathering Outbound E-Mail Information
	3.7.1 Outbound E-Mail Protocol
	3.7.2 Outbound E-Mail Host
	3.7.3 Outbound E-Mail Authentication
	3.7.4 Outbound E-Mail Send Restriction

	3.8 Enabling Inbound E-Mail
	3.8.1 Internal Mail Host for Inbound E-Mail
	3.8.2 Inbound E-Mail Port Number
	3.8.3 Inbound E-Mail IP Address
	3.8.4 Inbound E-Mail Security

	3.9 Planning Site Security
	3.9.1 Vibe Site Administrator Password
	3.9.2 Linux User ID for Vibe

	3.10 Gathering Directory Services Information
	3.10.1 LDAP Directory Service
	3.10.2 LDAP Connections
	3.10.3 LDAP Synchronization Options

	3.11 Accommodating Multiple Languages

	4 Installing and Setting Up a Basic Vibe Site
	4.1 Linux: Installing and Setting Up a Basic Vibe Site
	4.1.1 Installing Missing Libraries
	4.1.2 Performing Pre-Installation Tasks on Linux
	4.1.3 Running the Linux Vibe Installation Program
	4.1.4 Configuring Vibe to Start Automatically on Reboot
	4.1.5 Setting Up Port Forwarding
	4.1.6 Starting Vibe on Linux
	4.1.7 Checking the Status of the Vibe Server
	4.1.8 Restarting Vibe
	4.1.9 Stopping Vibe
	4.1.10 Uninstalling Vibe

	4.2 Windows: Installing and Setting Up a Basic Vibe Site
	4.2.1 Performing Pre-Installation Tasks on Windows
	4.2.2 Running the Windows Vibe Installation Program
	4.2.3 Running Vibe as a Windows Service
	4.2.4 Running Vibe as a Windows Application
	4.2.5 Uninstalling Vibe


	5 Adding Users to Your Vibe Site
	5.1 Accessing Your Basic Vibe Site as the Site Administrator
	5.2 Creating a User
	5.3 Adding Vibe Users from Your LDAP Directory

	6 Updating Your Vibe License
	7 What’s Next
	8 Basic Vibe Installation Summary Sheet

	III Advanced Installation and Reconfiguration
	9 Planning an Advanced Vibe Installation
	9.1 What Is an Advanced Installation?
	9.2 Distributing Different Data Types to Different Locations
	9.3 Using Advanced Network Information Settings
	9.3.1 Changing the Vibe Session Timeout
	9.3.2 Providing a Secure Keystore File

	9.4 Configuring Web Services
	9.5 Changing Your Lucene Index Server Configuration
	9.5.1 Understanding Indexing
	9.5.2 Changing Lucene Configuration Settings
	9.5.3 Running the Lucene Index Server in Its Own JVM
	9.5.4 Running the Lucene Index Server on a Remote Server
	9.5.5 Running Multiple Lucene Index Servers

	9.6 Managing RSS Feeds
	9.6.1 Configuring RSS Feeds
	9.6.2 Disabling RSS Feeds

	9.7 Configuring Presence
	9.8 Configuring Conferencing
	9.9 Configuring Single Sign-On with Novell Access Manager
	9.10 Configuring Single Sign-On with Internet Information Services for Windows
	9.10.1 System Requirements
	9.10.2 Planning Your IIS Installation and Configuration
	9.10.3 Configuring the Vibe Server to Support Windows Authentication
	9.10.4 Running the Vibe Installation Program
	9.10.5 Configuring Your Browser to Allow Access to the Vibe Site
	9.10.6 Bypassing Windows Authentication to Configure LDAP and Perform Other Tasks
	9.10.7 Logging In to the Vibe Site through Windows Authentication
	9.10.8 Editing Files through WebDAV with Windows Authentication
	9.10.9 Configuring IIS to Load Balance in a Clustered Environment

	9.11 Configuring Mirrored Folder Resource Drivers
	9.11.1 File System Type
	9.11.2 File System Directory
	9.11.3 File System Access
	9.11.4 Mirrored Folder Setup

	9.12 Installing the Vibe Software in a Clustered Environment

	10 Performing an Advanced Vibe Installation
	11 Setting Configuration Options after Installation
	12 Advanced Vibe Installation Summary Sheet

	IV Multi-Server Configurations and Clustering
	13 Creating the Vibe Database on a Remote Server
	13.1 Preparing to Manually Create a Database
	13.2 Creating a MySQL Database
	13.3 Creating a Microsoft SQL Database
	13.4 Creating an Oracle Database
	13.5 Installing Vibe with a Remote Database

	14 Installing the Lucene Index Server on a Remote Server
	14.1 Installing the Lucene Software
	14.2 Updating Your Vibe Site
	14.3 Managing a Remote Lucene Index Server
	14.3.1 Linux: Managing a Remote Lucene Index Server
	14.3.2 Windows: Managing a Remote Lucene Index Server


	15 Running Vibe on Multiple Servers
	15.1 Planning a Multi-Server Vibe Configuration
	15.1.1 Lucene Index Server Considerations
	15.1.2 Vibe File Repository Considerations

	15.2 Installing the Vibe Software on Multiple Servers
	15.3 Configuring a Web Application to Provide High Availability Functionality for Your Vibe Site
	15.3.1 Configuring Tomcat and Apache as a Load Balancer
	15.3.2 Configuring Linux Virtual Server as a Load Balancer

	15.4 Configuring Internet Information Services to Support Multiple Vibe Servers

	16 Running Multiple Lucene Index Servers
	16.1 Planning a High Availability Lucene Configuration
	16.2 Setting Up a High Availability Lucene Configuration
	16.2.1 Changing from a Local Lucene Index Server
	16.2.2 Changing from a Single Remote Lucene Index Server
	16.2.3 Expanding an Existing High Availability Lucene Configuration
	16.2.4 Changing Your Lucene Configuration without Vibe Site Down Time

	16.3 Testing Your Lucene High Availability Configuration
	16.3.1 Configuring Vibe to Log Lucene Node Activity
	16.3.2 Observing Lucene Node Activity

	16.4 Synchronizing a High Availability Lucene Configuration

	17 Running Multiple Database Servers

	V Update
	18 What’s New in Novell Vibe OnPrem 3
	18.1 Vibe 3 User Enhancements
	18.2 Vibe 3 Installation Enhancements
	18.3 Vibe 3 Administration Enhancements

	19 Updating from Novell Teaming 2.0 to Novell Vibe 3
	19.1 Understanding the Update Process
	19.2 Updating a Single-Server System from Teaming 2.0 to Vibe 3
	19.2.1 Updating an Oracle Database from 2.0 to 3

	19.3 Updating a Multiple-Server System from Teaming 2.0 to Vibe 3
	19.3.1 Manual Vibe Database Update
	19.3.2 Manual Lucene Index Server Update

	19.4 Performing Post-Update Tasks
	19.4.1 Resetting Your Definitions
	19.4.2 Resetting the Standard Templates


	20 Updating from Novell Teaming 2.1 to Novell Vibe 3
	20.1 Understanding the Update Process
	20.2 Updating a Single-Server System from Teaming 2.1 to Vibe 3
	20.2.1 Updating an Oracle Database from 2.1 to 3

	20.3 Updating a Multiple-Server System from Teaming 2.1 to Vibe 3
	20.3.1 Manual Vibe Database Update
	20.3.2 Manual Lucene Index Server Update

	20.4 Performing Post-Update Tasks
	20.4.1 Resetting Your Definitions
	20.4.2 Resetting the Standard Templates


	21 Migrating Existing Novell Vibe Data into a New Vibe 3 System
	21.1 Linux Migration with a MySQL Database
	21.1.1 Preparing the Target Linux Server
	21.1.2 Preparing the Source Linux Server
	21.1.3 Transferring Data from the Source Server to the Target Server
	21.1.4 Importing the Vibe Database to the Target Server
	21.1.5 Updating the Vibe Database on the Target Server
	21.1.6 Finalizing Your New Vibe 3 Site

	21.2 Windows Migration with an MS SQL Database
	21.2.1 Preparing the Target Windows Server
	21.2.2 Preparing the Source Windows Server
	21.2.3 Transferring Data from the Source Server to the Target Server
	21.2.4 Importing the Database to the Target Server
	21.2.5 Updating the Vibe Database on the Target Server
	21.2.6 Finalizing Your New Vibe 3 Site


	22 Migrating from SiteScape Forum or Other Collaboration Software

	VI Appendixes
	A Vibe System Requirements Assistance
	A.1 Java Development Kit
	A.1.1 Sun JDK on Linux
	A.1.2 IBM JDK on Linux
	A.1.3 Sun JDK on Windows

	A.2 MySQL Database Server
	A.2.1 MySQL on Linux
	A.2.2 MySQL on Windows


	B Third-Party Materials
	B.1 ANTLR 3 License
	B.2 Colt License Agreement
	B.3 Dom4j License
	B.4 iCal4j License
	B.5 ICU4J license (ICU4J 1.3.1 and later)
	B.6 JAXEN License
	B.7 Jung
	B.8 ASM
	B.9 Firebug Lite



